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Award-winning Stuffit Deluxe effectively doubles your disk space, 
Saves you time and money when sending files over network and 
modem lines, and enables you to backup infrequently used files. 

Add “Small” to any file or folder name ; 

and it instantly takes up less space. Small Presentation Presentation 

022K 
aul Report 

If a file hasn't been modified lately, 

it automatically takes up less space. Annual Report 

107K 
Monthly Sales.sit 

DAT3K> - 

Monthly Sales 
Add “sit” to the filename and it becomes 

a genuine Stuffit Deluxe archive. 

Unstuff one or more files/folders 

from an archive. Presentation sit Chart Notes 

rogram ine can mn UnStutt 
individual files fiat an existing archive, 
segment files into disk-sized pieces, and 
manage files (delete, rename, and more) 
inside archives. 

4 Aladdin 
iS ystems 

qui i's: Any Macintosh family computer Power Macintosh compatible 
o °2 2 Mespet of RAM required (4 Megabytes recommended) System 6.0.4 or higher 

System 7 savvy ® Not copy protected 

Aladdin Systems, Inc., 165 Westridge Drive, Watsonville, CA 95076-4159 USA (408) 761-6200 telephone, (408) 761-6206 fax. Copyright © 1989-1994 
Aladdin Systems, Inc., and Raymond Lau. Portions copyright © 1993-1994 Aladdin Systems, Inc. All rights reserved. Stufflt, Stufflt Deluxe and 

UnStuffit are trademarks of Aladdin Systems, Inc., and Raymond Lau. Stufflt SpaceSaver, Idle Time Compression, the Aladdin logo and Stuffit logo 

are trademarks of Aladdin Systems, Inc. All other brands and product names are the trademarks of their respective holders. Our lawyers are happy. 

~ StuffIt Deluxe includes Stuffit SpaceSaver! 
SpaceSaver transparently compresses tiles 
and folders to save disk space. 

¢ Compress files and folders on demand. 
Instantly compress any file or folder you want an average 
of 50% (one-half its original size). Simply indicate which file — 
or folder you want small. 

Automatically compress inactive files. 

Save disk space at all times—even while the computer is idle! 
Idle Time Compression automatically compresses any file that 
hasn't been modified for a specified length of time. 

Use compressed files normally. 

When you open a compressed file, SpaceSaver transparently 
expands the file. When you close the file, it automatically 
recompresses, | 

© Create genuine Stufilt archives easily. 
Add “.sit” or “.sea” to any file or folder name and it instantly 
becomes a genuine Stuffit or self-extracting Stuffit archive. 

Stufflt Deluxe gives you unparalleled 
control over your archives. 

© Unstuff individual items from existing archives. 

» Add new files and folders to existing archives. 

>» Open and manipulate multiple archives simultaneously. 

Handles archives much like the Finder handles files. 
You can rename and delete compressed files, move files 
between archives, create new folders within archives and more. _§j 

ee 

» Back up large files onto floppies by segmenting them into“ 
disk-sized pieces. Rejoin the segments at any time. 

- Stuff files based on specific criteria such as last date modified. 

Keep sensitive files from prying eyes with your own passwords. 

¢ Obtain detailed information about archives and their contents. 

» Automate compression tasks with AppleScript and UserLand 
Frontier (sold separately). One way to script is just like a tape 
recorder; you can easily record and playback all of your Stuffit 
Deluxe actions. 

Expand compressed files created on PC-compatibles (.zip 
and .arc) and Unix (tar, .Z, and .uu) to Macintosh format. 
Automate file transfers of Stuffit archives using popular 
E-mail and telecommunications programs, including 

QuickMail,“ Microsoft Mail“ SlTcomm;* and MicroPhone “Tl, 

Stuff and UnStuff at any time from the Finder, QuicKeys,* 
HyperCard," and MPW." Convert your old archives to smaller 
and faster Stuffit Deluxe archives. 

- View and print the contents of compressed Text and PICT files 
from within the StuffIt Deluxe application. 
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All of us at Aladdin Systems thank you for purchasing Stufflt Deluxe” We think you'll find Stuffit 
Deluxe to be the complete compression solution. Because we want you to get started right away, we’ve 
put together important information on these cards. With them, you'll be using StuffIt Deluxe to save 

_ disk space, to archive files, and to transfer your files over network and modem lines in no time. 

What is Stuffit Deluxe? 
The Stufflt Deluxe package includes the following: 

e Stuffit Deluxe application 

e Stuffit SpaceSaver™ 
e Magic Menu™ 

e Stuffit Expander” 

e DropStuff with Expander Enhancer™ 

e DropCompress™ 

e Various extensions to the StuffIt Deluxe application 

The two main programs, Stufflt Deluxe and StuffIt SpaceSaver, sound similar, but have distinctly sepa- 

rate uses. The archiving compression product, Stufflt Deluxe (this program and the package have the 

same name), emphasizes maximum compression for files and folders. StuffIt Deluxe combines files and 

folders into one file, called an archive (this process is called “Stuffing”). This type of compression is the 

one to use when files are leaving your machine, such as over a network or modem, or onto removable 

media such as cartridges or floppy disks. 

The second main component, StuffIt SpaceSaver, is a hard disk space-saving product. SpaceSaver keeps 

the files on your hard disk compressed until you use them, thus saving valuable disk space 3 

(SpaceSaver’s process of making files smaller is called “Compressing”). Your SpaceSaver-compressed 

files look and act completely normal. SpaceSaver automatically expands the files when they are opened, 

and recompresses them after they are closed. SpaceSaver is Se in its own manual, which ees 

find inside the Stuffit Deluxe package. 

— One of the most popular programs in the package, Magic Menu, is a Control Panel that makes a new — 

menu appear in the Finder. This menu integrates many of the features of both Stufflt Deluxe and 

SpaceSaver. Magic Menu can “Stull” files, “SpaceSaver Compress” files, and more, all with point and 

click simplicity. 

The other tools in the package combine to make Stufflt Deluxe one of the most powerful integrated 

packages available for the Macintosh. 

Stuffit Deluxe 9/94 
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Quick Start PreroGue 
Stuffit Deluxe is very easy to use. Don’t be fooled by the size of the User’s Guide. The User’s Guide 

has “walk-through” tutorials and explains every feature in detail. Chances are, you may never even refer 

to the guide. This card contains what you need to know to get started quickly. Please refer to the User's 

Guide or Online Documentation for additional information about these or any other features. 

TO SPACESAVER-COMPRESS A FILE OR FOLDER 
Using Magic Menu Using Drag & Drop 

System 7 only 

7 . 

: Folder File | | fe F 
walang ess 

sU 

Stuff 3€§ 

Make Self-Extracting 

Preferences... 

SpaceSaver Compress [' 

There are no extra steps to take to use files or folders you have compressed with SpaceSaver. 

Nothing is different about these files; they just take up less space on your hard disk. 

POCO HHOTH OOO SEHOEOOTETOO HOO OOOH DLOOTOOEO OOOO OST OS OOOO OSE OOOSHO ODO SHO DOSOHFO ESOS OOOO OHO SOTO OOOO OS ETOLOOEO OHS OEO SOOO HOHE TOOT ESO DTOS OTTO OOD TOS HOSED SOOO OSLO SEDO OO DODO OO SHH DOO LOSO SEDO LOO OOS SH OSH O SOE EH ODED OOD OOEELOOE 

TO STUPF A FILE OR FOLDER 
Using Magic Menu Using Drag & Drop 

System 7 only 

iB : : 
os | /— = | Expand 38U ok | —- 
Folder = File Stuff ES [' cue = re 

- Selecting multiple items and Stuffing them will create a single StuffIt archive. 

Use this compression method for backups, and modem or network transfers. 

You must UnStuff (“expand”) the archive to access the files within it. 
POSH OTSOOROTEHSOCOH SOOO OOESO OTOH OOOO OEOTOOSEOO OOOO HOSE HSHD OOS SFOS OH SOOO TOSSES HOSS OSHS HOO SOOO SSOSO SOO FOS SEOT STO ESOS OO SOOOSEESOOSSOESOSSOO SOOTHE OSL OEH OSTEO OOOO OSS O OSE OSO OOOOH OOO DOS OE OSES OHO OOOO OSE DEED ESSE EEEESODE® 

TO UNSTURF A STUFFIT ARCHIVE 
Using Magic Menu Using Drag & Drop — 

System 7 only 

Archive.sit ° Archive.sit 

Stufflt Deluxe 9/94 



Arcuive Winow 
Archive name Date last UnStuffed Stuffed Percentage 

Sort headings and pop-up menu modified _ size size saved 

= CG A Archive Vindw.s( SSS 

“An Archive Window.sit” is 194 2,720K free on 
Status Area Bien sanniuaaiwansaestMPataascieasdincceanvavincsvunsunsheQuatious onec¥Siaacaescce eae Was aa subse sega vas cesirows suedsVeasass csdnbunnssenaNsapaad eauaanaghuscey ope si¥eaks Mlctseasscenvegantvacned 

(2 Folder 0 items 8/1/92 -—s zeroK under 1K O08 

Floppy alias alias 8/1/92 1K under 1K S6% 

© HD alias alias 8/1/92 1K under 1K 56% 

&l Server alias alias 8/1/92 1K under 1K 56% 

fl Trash alias alias 3 8/1/92 - 1K under 1K 56% 
< Application application progr... 8/1/92 441K 221K 50% 

& Exposed desk accessory desk accessory 8/1/92 36K 25K 31% 

Suitcase desk accessory s... 8/1/92 _ 36K 25K 31% 

[-) Document document 8/1/92 21K 6K 71% 

&[E) Encrypted document document. 8/1/92. 31K 8K 74% 

stationery stationery pad = =—s_—- 8/1/92 21K 6K 71% 

Order icon 

Item icons 

Encryption 
key 

[1] self-extracting $9 Comments... [i] 590K 268K 55% 

Self-Extracting Comments icon Digital Signature Column totals 
checkbox icon 

Kind of item 

Arcuive Ment/PALerTe Ger Leo DisLoc 
File Encryption Viewer File 
icon key icon 

Archive Kind of file 

Stuff... 
TeachText document 

UnStuffed size 
- Expanded: 857 bytes (1K) 

UnStuff... 3U Stuffed size Stuffed: 608 bytes (1K) 

New Folder oer Percentage saved Saved: 249 bytes (29% saved) 

Delete $#D Disk and archive Where: HD :Sample Archive sit: 

Get Info... 36 | pala 
F Date/time of 

View aL creation Created: Tue, Jun 23, 1992, 10:30 PM 

Launch 3T Modified: Tue, Jun 23, 1992, 10:30 PM 
: Date/time last 

Move/Copy... 38M modified Label: [_None 

; "Finder Label Type: [] Locked 
Make Seilf-Extracting : 

pop-up Creator : [_] Stationery 
Edit Comment... 

Attach Signature... 
File Type 
File Creator _ File locked checkbox 

Stationery checkbox 



Srurvin Danie Recismanion CARD =| wen ppae 
Registration entitles you to technical support, upgrade notices, and much more. 

(ee 

Please write legibly and complete entire card. - Registration Number 

Name Occupation/Title 

Organization 

Address Ze 3 , 

City : State Zip/Postal Code Country 

Daytime telephone 7 Fax | 

Where can we reach you online? 

Macintosh owned | se Hard disk size RAM memory 

Place purchased __ Date purchased / / 

What finally made you decide to purchase StuffIt Deluxe? (check all that apply) 

(Price XO Features Ci Needed more disk space (2 Packaging (J Ad in 

~ Recommendation by: Pacad (J User Group (J Magazine review in 

| : (J Consultant ©) Other 

Where did you hear about Stuffit Deluxe? (check all that apply ) 

J Friend. LJ Dealer ‘(Adin 

2 Mail Order Ci User Group CO Trade show C) Other 

StuffIt Deluxe 9/94 

Wk WELCOME YOUR INPUT 
If you have any comments or suggestions, please contact us by sending in this card. 

What do you like about Stuffit Deluxe? 

What don’t you like about Stuffit Deluxe? 

What are the most eapurtont features of this software? 

What are the least important features of this ae 

What would you like to see in the future? 

StuffIt Deluxe 9/94 
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* 

ALADDIN ASSISTANCE® 

Aladdin Systems is committed to providing the best customer support 
in the business. 
We're willing to back up those words with a range of services that go beyond most 

other manufacturers. Our registered users can take advantage of technical support, 

~ reasonable upgrades, training, advance product announcements, and bulletins. 

In addition, Aladdin Systems sponsors Academic, User Group, and Corporate Programs. 

30-Day, Money-Back Guarantee 

We are confident that you will like every Aladdin Sesterts product. However, if you are 

dissatisfied with this product, you may return it for a full refund. Write or call us for. 

- more information. | 

Registration Card 

By registering you are entitled to free technical cart and upgrade notices. 

Please take a few moments to complete and mail this postage-paid card. 

Technical Support 
If you have any problems using this product, we recommend the following: 

Review the manual — it answers most questions and problems. If you still have a question, 

you may contact us by any of the methods below. If you choose to call, please have your 

manual and original program disk(s) on hand. Also, being seated at your computer with 

the program running will help us serve you better. 

; Technical 

Mailing Address Support Hotline Online 
Aladdin Systems, Inc. (408) 761-6200 - AppleLink, America Online: ALADDIN 

165 Westridge Drive (408) 761-6206 fax eWorld, GEnie: ALADDINSYS 

- Watsonville, CA 95076 = Monday — Thursday CompuServe: 75300,1666 

. 9 am-—5pm Pacific Time Internet: aladdin@well.com 

Friday 9 am — 8 pm : 3 

Your Comments | 
If you have any comments or suggestions, please feel free to contact us by any of the above 

methods. We welcome your input. Also, please take a moment to let us know what you think 

about StuffIt Deluxe. By completing the attached questionnaire and returning it to us, you 

will be providing us with valuable information we can use to produce even better products in 

the future. We value your comments just as we value your business. 



( COMMAND KEY EQUIVALENTS 
Stufflt Deluxe application: 
Command-N 

Command-O 

Command-W 

~ Command-Y 

Command-P 

Command-Q 

Command-Z 

Command-X 

Command-C 

~ Command-V 

Command-A 

Command-S 

Command-U 

Command-F 

Command-D 

Command-I 

Command-L 

~ Command-T 

Command-M 

Command-E 

Command-R 

Command-] 

Command-[ 

~Command-1— 8 

Magic Menu: 
Command-U 

Command-S 

— New... 

— Open... 

— Close 

— Verify 

— Print... 

— Quit 

— Undo 

— Cut 

— Copy 

— Paste 

— Select All 

— Stuff... 

— UnStuff... 

— New Folder 

— Delete 

— Get Info... 

— View 

— Launch 

— Move/Copy... 

— Execute Script... 

— Record Script... 

— Next Window 

— Last Window 

= Bring Window to front 

— Expand 

— Stuff 

(File menu) 

(File menu) 

(File menu) 

(File menu) 

(File menu) 

(Edit menu) 

(Edit menu) 

(Edit menu) 

(Edit menu) 

(Edit menu) 

(Edit menu) 

(Archive menu/palette) 

(Archive menu/palette) 

(Archive menu/palette) 

(Archive menu/palette) 

(Archive menu/palette) 

(Archive menu/palette) 

(Archive menu/palette) 2 

(Scripts menu) 

(Archive menu/palette) 

_ (Scripts menu) : 

(Window menu) 

(Window menu ) 

(Magic Menu) 

(Magic Menu) 

(Window menu) 



YET ANOTHER C000 ALADDVIN PRODUCTI 

“CP SIT COMM 
Simply Intuitive Telecommunications ~ 

GET MORE MILEAGE OUT OF YOUR MODEM 
Equipped with a modem and SITcomm;” you can communicate across town or around the globe. SITcomm is 

the very first program designed specifically to make telecommunications easier and less expensive. SITcomm’s 

useful time-saving features — like built-in file compression — will save you online and telephone charges. 

Experienced telecom users will appreciate SITcomm’s unique power enhancements. Order today, and see for — 

yourself how SITcomm simplifies telecommunications, making it easier, cheaper, and more enjoyable. : 

Instant Connections with the Address Book: 
Point and click to connect to online services like CompuServe, Dow 

Jones, the Internet, MCI Mail, and local bulletin boards (BBSs). 

. $ITcomm already knows how to connect to most online services, so Dow Jones. 
: ee nad! | GEnie 

you can aw started right ae And, NO scripting required! Mc ! al : _— 

Automatic Compression: SITcomm can automatically expand The WELL = 

compressed files you receive, including files compressed with Stuffit | 

- (sit) and other popular compression formats. SITcomm can also — Paes 4 sa ate coments Dt 

compress files and folders into a Stuffit archive before sending, H = Automatically open connection Transfer %/‘YMODEM 

saving you considerable connection time and telephone charges, 

es es Foreign File Translators: srrcomm 
Bi Notepad Turn On Capturing || 

SEND }} RECY 

can expand compressed files from other 

3 7 computer platforms, such as PC- 
A handy toolbar gives you quick and easy access compatibles (.zip and .arc), Unix (.tar, .Z, 

to all of SITcomm’s most useful features. ga, and .uu), and the Internet: (.h ax). 

: On the Road: SITcomm includes features designed expressly for the traveler. Dialing long distance? SITcomm 

can automatically use your calling card number. On PowerBooks, SITcomm goes out of its way to conserve 

battery life. : 

Scripting: Users of AppleScript and UserLand Frontier can automate compression tasks. One way to script is 

just like a tape recorder; you can easily record and playback all of your SITcomm activities. 

Call us today at 408/761-6200 and order SiTcomm: 
the easiest way to link your Mac to the world! =~ 

* SITcomm is not part of the StuffIt Deluxe package. It is a separate product available from Aladdin Systems. 

As an owner of StuffIt Deluxe, you can purchase SITcomm at a significant discount directly from Aladdin. 

Just call us at 408/761-6200 to place an order, inquire about pricing, or if you would like to receive more information. 
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Aladdin License Agreement 

This is a legal agreement between you, the end user, and Aladdin Systems, Inc. Be sure to read the following agreement before using the software. BY OPENING THIS ENVELOPE AND USING THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY RETURN THE ENTIRE PACKAGE (with all accompanying items) TO THE PLACE YOU OBTAINED THEM FOR A FULL REFUND. 

DIN SOFTWARE LICENSE 

1. GRANT OF LICENSE. Aladdin Systems grants to you the right to use one copy of the enclosed software Program (the “SOFTWARE”) on a single computer (i.e. with a single CPU). You may not network the SOFTWARE or otherwise use it on more than one computer at the same time. 
2. COPYRIGHT. The SOFTWARE is owned by Aladdin Systems and is protected by United States copyright laws and international treaty provisions. Therefore, you must treat the SOFTWARE like any other copyrighted material (e.g. a book or musical recording) except that you may either (a) make one copy of the SOFTWARE solely for backup or archival purposes, or (b) transfer the SOFTWARE to a single hard disk provided you keep the original solely for backup or archival Purposes. You may not copy the written materials accompanying the software. 
3. OTHER RESTRICTIONS. You may not rent or lease the SOFTWARE, but you may transfer the SOFTWARE and accompanying written materials on a permanent basis provided you retain no copies and the recipient agrees to the terms of this agreement. You may not electronically transfer the SOFTWARE from one computer to another. You may not modify, adapt, translate, reverse engineer, decompile, or disassemble the SOFTWARE. 
4. MISCELLANEOUS. This entire agreement and warranty are governed by the laws of the State of California. 

DISCLAIMER OF WARRANTY AND LIMITED WARRANTY 
THE SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS (INCLUDING INSTRUCTIONS FOR USE) ARE PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND. FURTHER ALADDIN SYSTEMS DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. IF THE SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE YOU, AND NOT ALADDIN SYSTEMS OR ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. . 
Aladdin Systems warrants that the disks on which the SOFTWARE is recorded is free from defects in materials and workmanship under normal use. You may obtain a replacement disk by returning the original disk to: 
Aladdin Systems, Inc., 165 Westridge Drive, Watsonville, California 95073, United States of America. 

Aladdin Systems entire liability and your exclusive remedy as to the disk shall be, at Aladdin Systems option, either (a) return of the purchase price or (b) replacement of the disk that does not meet Aladdin Systems’ Limited Warranty and which is returned to Aladdin Systems with a copy of the purchase receipt. 
THE ABOVE ARE THE ONLY WARRANTIES OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE THAT ARE MADE BY ALADDIN SYSTEMS ON THIS ALADDIN SYSTEMS PRODUCT. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY ALADDIN SYSTEMS, ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON SUCH INFORMATION OR ADVICE. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE TO STATE. 
NEITHER ALADDIN SYSTEMS NOR ANYONE ELSE WHO HAS BEEN INVOLVED WITH THE CREATION, PRODUCTION, OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE INABILITY TO USE SUCH PRODUCT EVEN IF ALADDIN SYSTEMS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES OR THE LIMITATIONS OF DURATION OF IMPLIED WARRANTY, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. 

U.S. GOVERNMENT RESTRICTED RIGHTS 
The SOFTWARE and documentation is provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subdivision (b)(3)(ii) of The Rights in Technical Data and Computer Software clause at 252.227-7013. Manufacturer is Aladdin Systems, Inc., 165 Westridge Drive, Watsonville, California 95073, United States of America. 

Our lawyers are happy. 
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“APPLE COMPUTER, INC. (“APPLE”) MAKES NO WARRANTIES, EXPRESSED OR 

IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE 

APPLE SOFTWARE. APPLE DOES NOT WARRANT, GUARANTEE OR MAKE ANY 

REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE 

APPLE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, 

CURRENTNESS OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND 

PERFORMANCE OF THE APPLE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF 

IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE EXCLUSION MAY 

NOT APPLY TO YOU” 

“IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE 

LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR SPECIAL DAMAGES 

(INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, 

LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR 

INABILITY TO USE THE APPLE SOFTWARE EVEN IF APPLE HAS BEEN ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE 

EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL 

DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. Apple’s liability to you 

for actual damages from any cause whatsoever, and regardless of the form of the action 

(whether in contract, tort (including negligence), product liability or otherwise), will be 

limited to $50.” 

Colophon 

The type used is ITC Century and Zapf Dingbats. Text and graphics were 

generated using FrameMaker and pages were proofed using an Apple 

LaserWriter IIf. Final pages were generated on a Linotronic 200P. 
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Part One: 

Stuffit Deluxe 





Chapter |: Introduction 
Welcome to StuffIt Deluxe ™ , the complete compression solution for the 

Macintosh. StuffIt Deluxe offers new features such as accelerated operation 

for the Power Macintosh, PowerTalk support, and True Finder Integration™ . 

The Stufflt Deluxe package includes the following: 

eStufflt Deluxe application 

eStufflt SpaceSaver ™ 

eMagic Menu ™ 

eStufflt Expander ™ 

eDropStuff with Expander Enhancer ™ 

eDropConvert ™ , DropCompress ™ 

eVarious extensions to the Stufflt Deluxe application 

The two main programs, StuffIt Deluxe and Stufflt SpaceSaver, sound similar, 

but have distinctly separate uses. The archiving compression product, Stuffit 

Deluxe (this program and the package have the same name), emphasizes 

maximum compression for files and folders. StuffIt Deluxe combines multiple 

files and folders into one file, called an archive. This type of compression is 

the one to use when files are leaving your machine, such as over a network or 

modem, or onto removable media such as cartridges or floppy disks. It’s also 

a way to back up your older or little-used files and folders. 

The second main component, StuffIt SpaceSaver, is a hard disk space-saving 

product. SpaceSaver keeps the files on your hard disk compressed until you 

use them, thus saving valuable disk space. Your SpaceSaver-compressed files 

look and act completely normal. SpaceSaver automatically expands the files 

when they are opened (accessed), and recompresses them after they are 

closed. SpaceSaver is explained in its own manual, which you’ll find inside 

the StuffIt Deluxe package. 

One of the most popular programs in the package, Magic Menu, is a Control 

Panel that makes a new menu appear in the Finder. This menu integrates 

many of the features of both Stufflt Deluxe and SpaceSaver. Magic Menu 
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archives files, compresses and expands files, and sends electronic mail, all 

with point and click simplicity. 

The other tools in the package combine to make StuffIt Deluxe one of the 

most powerful integrated packages available for the Macintosh. 

This manual is divided into the following parts: 

Part One: StuffIt Deluxe. This part explains how to install Stufflt Deluxe and 

how to use the various features. We start with the easiest tasks, and work up 

to the most advanced features, so you can determine the level of complexity 

you want to use. 

Part Two: True Finder Integration. This part explains how the individual 

modules of extensions and tools are used with the Finder and the open 

architecture of Stufflt Deluxe. 

Part Three: Reference. This part contains the technical details of 

compression (for those who want to know!), a scripting command summary, 

a troubleshooting section, and the index. 

This manual assumes that you know how to operate the Macintosh and are 

familiar with basic Macintosh terminology such as point, click, drag, and the 

Finder. If you aren’t familiar with these terms, you should refer to the 

Macintosh User’s Guide to learn the basic operations of using the Macintosh. 

In addition, several conventions are used throughout this User’s Guide: 

e Numbered items are steps to complete a procedure. 

e Alternate methods for completing a procedure are marked with a square. 

e When referring to scripts, all commands areinatypewriter font. 

Note: Text that appears between lines like this contains additional 

information. 



Chapter 2: Installation 
This chapter describes how to install the StuffIt Deluxe package. You can 

choose to install everything, or just the components you want. 

Requirements StuffIt Deluxe operates on any Macintosh computer provided you have at 

least four megabytes of memory, and a hard drive. 

Though Stufflt Deluxe is compatible with System 6.0.5 or later, we recom- 

mend that you use the latest System and Finder available from Apple Com- 

puter, Inc., provided by your local dealer. 

Note: Stufflt Deluxe works with both System 6 and System 7. There are 

certain features, however, that cannot work with System 6 because they are 

specific to System 7 only. These include Balloon Help, aliases, Apple events, 

PowerTalk, and drag and drop. We focus on System 7 in this manual; however, 

whenever functionality is different under System 6, notes appear describing 

System 6 usage. 

Standard Before you install Stuffit Deluxe, you should make a copy of your Stuffit 

Installation 
Deluxe disks, store the originals in a safe place, and use the copy to install 

StuffIt Deluxe on your hard disk. We also suggest that you take a few moments 

now to complete the registration card and send it to Aladdin Systems (it’s 

postage paid). If you register, we can notify you of upgrades and new 

products. 

Note: Please read the Read Me file for last-minute information on registering. 

1. Insert StuffIt Deluxe Disk One into your Macintosh. 

Chapter 2: Installation 5 



2. Double-click the Installer icon on the disk. 

ECE Stuffit Deluxe™ Disk 1 2EZ 

7ESK in disk 2K 

= Mh 

5 s 
Stufflt Deluxe™ 3.5 Installer 

Se a es (o 

3. A “splash screen” appears. Click Continue. 

A Welcome dialog box appears. This dialog contains last-minute changes 

and other important information. 

4. Click Continue when you have finished reading the 

information. 

You can save or print this information by clicking the appropriate button. 

The Standard Install dialog box appears. 

@ | Stufflt Deluxe™ Standard Install 

Click "Install" to install the complete 

Stuffit Deluxe™ and Stuffit 

SpaceSaver™ products. For more 

options, select "Custom". 

Installation requires : 2579K 

5. Click “Install” to continue. 

If you want to install specific parts of the StuffIt Deluxe package, click 

“Custom” and see the “Custom Installation” section following. 

If you click “Install,” a dialog box appears informing you that you must 

restart your Macintosh after installation for the software to take effect. If 

your machine is not in a situation where this is OK, click Cancel to halt the 

installation process. 

6. Click “Yes” to continue installation. 
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A dialog box appears that lets you choose where to install the software. 

<— Macintosh HD ¥ © Macintosh HD 

f_)Cool stuff Kieet 

{Games Folder = 

(7 Miscellaneous a Desktop 
(7 Original MS mail 

(7) Personal 

Install software into folder: 

Stuffit Deluxke™ Folder 

7. Click “Install” if the default folder “StuffIt Deluxe Folder” 

and hard disk are acceptable. 

Otherwise, you can create a new folder, navigate to another volume to 

install onto, or quit the installation process. 

The progress dialog box appears. 

Installing... 

File: 1 of 61 items. 

Installing: Stuffit Deluxe™ 

8. When the installation is finished, a dialog box appears 

asking you to register this copy of StuffIt Deluxe and all its 

components. 

Enter your name, company name (skip if not applicable), and the 

registration number. The registration number can be found on the 

registration card. 

@ 3 Name: | Margie Foster 

Organization: | Aladdin Systems, Inc. 

By entering a registration number, you agree to the terms of the license. 

9. Click Register when you have finished entering the 

information. 
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The following dialog box appears. 

Installation was successful. In order to 

is take advantage of the new software, your 

Macintosh needs to be restarted. 

10.Click the “Restart” button to complete the installation 

process. 

As your Macintosh restarts, the Magic Menu and SpaceSaver icons should 

appear along the bottom of your screen. If they do not, check the Control 

Panels folder to see if they are there. If not, run the Install program again. 

[=o | 

Magic Menu icon SpacesSaver icon 

Note: If you are using an Extensions manager such as Startup Manager ™ 

(from Now Software, Inc.), you may need to configure it to include 

SpaceSaver and Magic Menu. If you are not familiar with the process, consult 

its manual for how this is done. 

One immediate difference you'll find is that the Magic Menu appears 

immediately after the Special menu in the Finder’s menu bar. 

Note: If are running System 6 on a Macintosh that is not capable of displaying 

color, the word “Magic” appears in the Finder’s menu bar, instead of the 

Magic Menu icon shown in this manual. 

11.You have now finished the installation process. Go to 

Chapter 3 to learn how to Stuff and UnStuff files. 

Custom Installation lf you want to select specific items to install, follow the steps below. If you 

haven’t done so already, you should make a copy of your StuffIt Deluxe Disk 

One and Two, store the originals in a safe place, and use the copies to install 

Stufflt Deluxe onto your hard disk. 

1. Follow steps 1 through 4 in the Standard Installation 

section. 
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Full Stuffit Deluxe Install 

Stuffit Deluxe Application 

Stuffit SpaceSaver control 
panel 

Magic Menu control panel 

Drag and Drop Applications 

Viewer Extensions 

Translator Extensions 

2. Click the “Custom” button to begin selection for a Custom 

Install. 

The custom installation dialog box appears, with a list showing the groups 

of files available for installation. 

Install the following: 

Full Stuffit Deluxe™ Install 

Stufflt Deluxe™ Application 

Stufflt SpaceSaver™ control panel 

Magic Menu™ Control Panel 

y This package installs the complete Stuffit Deluxe™ and Stuffit 

| SpaceSaver products, along with the Drag & Drop applications, 

viewers, translators, scripting tools and "Read Me" files. 

Installation requires : 2550K 

Standard 

This installs the entire Stufflt Deluxe package. It is the same as choosing 

Standard Install. 

This installs the Stufflt Deluxe application, and its Preference file. These are 

the minimal files you’ll need to use the application. 

This option installs the Stufflt SpaceSaver control panel and the Stufflt 

Engine onto your hard disk. Installing these items allows you to SpaceSaver- 

compress items on your hard disk. The basics of using SpaceSaver is covered 

in the SpaceSaver manual, included in the Stufflt Deluxe package. 

This option installs the Magic Menu control panel, compression and mail 

extensions, and the Stufflt Engine onto your hard disk. Installing these items 

allows you to do archiving and expanding of items right in the Finder. 

This option installs StuffIt Expander, DropStuff, DropCompress, and 

DropConvert, and places an alias of each on your desktop. It also installs the 

Dragging Enabler and Macintosh Drag and Drop extension if it determines 

you are running the appropriate version of the Finder (7.1.2 or later) that 

supports these extensions. The “Drop” applications work with System 7 only. 

This option installs the Text and PICT extensions needed to let you view the 

contents of Text or PICT documents in StuffIt archives. It also installs the 

StuffIt XTND for use with XTND-aware applications. 

These include extensions that let you decompress, expand, and translate 

many file formats such as Compact Pro and Applelink packages, and foreign 

file formats such as .zip and tar. 
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Scripting Tools 

Read Us First! 

Tutorial Files 

Where is Stuffit 
Deluxe Installed? 

The StuffIt Deluxe Folder 

The System Folder 

The Desktop 

10 Chapter 2: Installation 

This option installs scripts and tools which allow you to automate many of 

Stufflt’s common tasks using Stufflt’s built-in scripting language or other 

macro/scripting products such as AppleScript, Userland’s Frontier, CE 

Software’s QuicKeys 2, Claris’ Hypercard, and Apple Computer’s MPW. 

This option installs the last-minute text files that contain important 

information. Please install and read these files. 

This installs Tutorial files onto your hard disk. The Tutorial Files are used in 

many of the examples in this manual. 

3. scroll through the list of items and Shift-click the ones you 

want to install. 

As you select items, their names appear at the lower-left portion of the 

dialog box. If you select only a single item, details about it appear. 

4. Follow steps 6 through 11 in the Standard Installation 

section. 

The Stuffit Installer places files and folders in three locations: The Stuffit 

Deluxe Folder, the System Folder, and the Desktop. 

Within the Extensions folder in your System Folder, a newly created 

“Aladdin” folder contains Stufflt Deluxe’s plug-in modules. 

The Stufflt Deluxe Folder is a new folder created on your hard disk when you 

install the software. It contains the Stufflt Deluxe applications and folders 

containing other tools and documents that you’ll find useful. 

The System Folder gets the Extensions, Control Panels, Preferences and 

Aladdin Folder, automatically placed in the appropriate locations. 

Note: If you are using System 6, the control panels are placed inside your 

System Folder and not in the Control Panels folder. 

The installation process places four aliases on your Desktop: DropStuff, 

DropConvert, DropCompress, and StuffIt Expander. (Aliases work under 

System 7 only.) 

For complete details, see the file “What was installed (and where)” in the 

Read Us First! folder inside the StuffIt Deluxe folder. 



Introduction 

Chapter 3: Easy Stuffing 
and UnStuffing 

If you’re not familiar with Stufflt Deluxe, you should go through the examples 

given here to learn the easiest way to Stuff and UnStuff. If you’re already 

familiar with StuffIt Deluxe, you may want to skim this chapter for new 

information. 

What is compression? 

Stuffit Deluxe is a compression program. Compression is the process by 

which a file or a folder is made smaller. Though there are many uses for 

compression technologies, the three primary purposes are to save disk 

space, to speed modem and network transfers, and to save space when doing 

a backup. 

What is an archive? 

An archive is a special document that can contain multiple files or folders. 

Archiving is the process by which one or more files and folders are combined 

into a single document and often compressed during the process. StuffIt 

archives are those archives created by any member of the StuffIt family of 

products. A Stufflt archive usually has a “.sit” extension. 

Satple Archive sit- 

With this software, you can also create a special type of archive called a self- 

extracting archive.” A self-extracting archive is an archive that can be 

decompressed by anyone—even if the recipient doesn’t own Stufflt Deluxe. 

A self-extracting archive usually has a “.sea” extension. 

This chapter describes the three easiest ways to Stuff a file or folder, in the 

order of ease of use, and how to make a self-extracting archive. Then we 

explain how to UnStuff the archives you have made. 

Chapter 3: Easy Stuffing and UnStuffing 11 



Method One: This method explains how to use Magic Menu to create an archive. (See 
U si n g M a gi C M enu to “What is an archive” at the beginning of this chapter if you don’t know what 

an archive is. ) 

Stuff 
Creating a new archive and placing files into it is very simple. For the 

purposes of this tutorial, we’ve provided a small sample document called 

“A Document.” 

1. Select the file “A Document” in the Tutorial folder by 

clicking it once. 

Tutorial Files 

Magic Menu Stuffs the file and saves it to disk as a StuffIt archive. The 

newly-created archive then appears in the Tutorial folder. 

Tutorial Files 

19.7 MB in disk 2.2 MB availabl 

A, Document Sample Archive.sit 

A, Dacumerttsit 
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Method Two: 
Using DropStuff 

Method Three: 
Drag and Drop 

The second way to Stuff a file or folder in the Finder is to use DropStuff, a 

“Drop Box” which works with System 7 only. A Drop Box is a very small 

application that is able to perform tasks by “dragging and dropping” items 

onto them. Since only System 7 supports “drag and drop” features, Drop 

Boxes cannot work for System 6 users. 

1. From the Finder, select the file(s) or folder(s) you want to 

Stuff and drag them on top of the DropStuff icon on the 

desktop. When the DropStuff icon is highlighted, release 

the mouse button. 
PP 
. 

. 

. 
” aaeneseese 

a 

— 
a itm aS ee fF 

A, Docu rerit 

DropStuff Stuffs the file(s) in the same folder (or on the Desktop) as the 

original, leaving a copy of the original UnStuffed file. 

Tutorial Files 

i 15,7 MB in disk 2.2 MB availabl 

A, Document Sample Archivesit 

Ol. 
4, Documerntsit 

The third way to Stuff files and folders in the Finder is to use the drag and 

drop functionality of newer versions of System 7. (See Appendix A for details 

on how drag and drop is implemented in different versions of System 

software. ) 

1. Double-click the Tutorial Files folder inside the Stuffit 

Deluxe folder. 

2. Double-click the file “Sample archive.sit.” 

The archive opens, and since it contains a “Read Me” document, the 

contents of the Read Me file automatically appear. Close the window. The 

“Read Me” auto-open feature is discussed in Chapter 5: StuffIt Deluxe 

Reference. 
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3. Return to the Finder by clicking outside the archive 

window, or by choosing “Finder” from the iconic menu in 

the top-right corner of your screen. 

Hide Finder 
Hide Others 

¥ () Finder 
-? Stuffit Deluxe™ 

You might have to choose “Show All” from the same menu if your Stufflt 

Deluxe archive window “hides” when you're in the Finder. 

4. Open the hard disk or folder that contains the items you 

want to Stuff. 

5. Position the window so you can easily see both it and the 

inactive StuffIt archive window. 

Date Expanded 

Read Me SinpleText docurrent 8/15/94 

TH Lighthouse Adobe Photostop™ 2... 8/17/94 

3K 54% 

Add Alias to Apple Menu Close Finder ‘windows Create Alias Folder 

© © 
Hide/Show Folder Sizes Monitor 1 bit (B&W) Monitor 8 bit (256 colors) Monitor maximum depth 

4 o © > 
New Item Watcher Share a Drop Folder Sound Maximum Sound Off Start File Sharing 

6. Shift-click the files you want to Stuff, and then drag the 

files to the Stuffit archive window. 

A border appears around the inside edge of the archive window to indicate 

it is ready to accept the files. 

7. Release the mouse button. 
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Stufflt Deluxe immediately begins to Stuff the selected files. When it has 

finished, the windows should now appear like this: 

G Sample Archive.sit 

16 items "Sample Archive.sit ” is 7OK 33 ,448K free on “PowerPC Mac ” 

Date Expanded 

€> Eject all iat 6/19/94 

G% Find Original cath 6/19/94 

oy Hide ‘Show Folder Sizes oath 6/19/94 

€> Monitor 1 bit (B&W) icati 6/19/94 

¢> Monitor 8 bit (256 colors) icati 6/19/94 

gs New Item ‘watcher cat 6/19/94 

GS Share a Drop Folder cath 6/19/94 

€> Sound Maximum rats 6/19/94 

¢5> Sound off cath 6/19/94 

1? items 121.5 MB in disk 32.6 MB available 

oy 

Add Alias pple Menu Close Finder Windows Create Alias Folder Eject All Find Original 

Hide /Show Folder Sizes Monitor 1 bit (B&W) Monitor 8 bit (256 colérsy ~ “Monitor maximum depth 

You can continue to add other files and folders to the archive window, if 

you want. You can also drag items out of the archive window to the trash 

to delete them. 

Self-Extracting __ This section explains how to make an archive that anyone can double-click to 

Archives extract files, even if they do not have a StuffIt product. 

1. In the Finder, select the files you want to Stuff. 

2. Choose “Make Self-Extracting” from the Magic Menu. 

Make Self-Extracting;. 

Magic Menu Stuffs the files and attaches the suffix “.sea” to the name. 

Chapter 3: Easy Stuffing and UnStuffing 15 



Easy UnStuffing 

Method One: 
Using Magic Menu to 
UnStuff 

Method Two: 
UnStuffing with 
Stuffit Expander 

Note: If you are Stuffing one file or folder, the resulting self-extracting 

archive has the same name as that item, with a “.sea” extension added. For 

example, if you Stuff a folder called “Book Folder,” it becomes “Book 

Folder.sea” after Stuffing. However, if you Stuff multiple files, the default 

name is “Archive.sea.” 

The icon in the Finder looks like this: 

Book Folder sea 

Anybody can now expand the file by simply double-clicking it. 

This section describes how to UnStuff archives and other compressed-file 

formats in the Finder. To learn how to UnStuff using the Stufflt Deluxe 

application, see Chapter 4: Basic Stufflt Deluxe. 

This section explains how to use Magic Menu to UnStuff an archive. 

The “Expand” command (Command-U) lets you decompress, expand, or 

translate files in the Finder. This command works with SpaceSaver- 

compressed files, StuffIt archives (.sit or .sea), and other formats, such as .Z, 

.zip, and .hqx (which are discussed in Chapter 7: Magic Menu). 

1. To expand an archive, select it in the Finder. 

2. Choose “Expand” (Command-U) from the Magic Menu. 

Magic Menu expands the archive and saves the file to disk using the name 

of the archive, minus the “.sit” suffix. 

This method explains how to use Stufflt Expander to UnStuff an archive. For 

more details on Stufflt Expander, see Chapter 8: Drag and Drop Applications. 

1. Select the StuffIt archive (with a .sit extension) and drag 

its icon onto the StuffIt Expander alias icon on your 

desktop. 
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Method Three: 
UnStuffing with Drag 
and Drop 

Where To Go 
From Here 

Stufflt Expander UnStuffs the archive and places the UnStuffed items in 

the same folder as the original archive. 

e If the archive contains multiple items, a new folder (with the name of 

the archive) is created and everything is UnStuffed into the new folder. 

System 6 users: You can also use StuffIt Expander to expand files. Just 

double-click the Stufflt Expander icon in the Finder, then choose “Expand” 

from the File menu. 

The third way to UnStuff files and folders in the Finder is to use drag and 

drop, available in newer versions of System 7. 

The Stufflt Deluxe install application places the Macintosh Drag and Drop 

and Dragging Enabler extensions into your Extensions folder when it 

determines that the correct version of the Finder (7.1.2 and later) is running. 

Older versions of the Finder cannot support the drag and drop functionality. 

See Appendix A for more information on the drag and drop capabilities of 

different System versions. 

1. Double-click the .sit archive you want to UnStuff. 

The archive opens in the Stufflt Deluxe application. 

2. Select the items within the archive you want to UnStuff. 

3. Drag the selected items out of the archive window to the 

desktop, or to a Finder window. 

4. Release the mouse button. 

Stuffit Deluxe immediately begins to UnStuff the selected files. If you are 

UnStuffing multiple folders, each folder is UnStuffed to its original name. 

Now that you know the easy ways to Stuff and UnStuff files with Magic Menu, 

DropStuff, and Drag and Drop, you might want to explore the next chapter 

that explains how to use the StuffIt Deluxe application. StuffIt Deluxe not 

only Stuffs files, but also UnStuffs them, makes multiple archives that can be 

joined together, and uses Translators to expand foreign file formats. 
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Introduction 

Stuffing 

Chapter 4: The StuffIt 
Deluxe Application 

This chapter describes how to use the basic elements of the StuffIt Deluxe 

application. These main elements are: 

e Stuffing (including making a self-extracting archive) 

e Encrypting 

e UnStuffing 

e Segmenting 

e Joining 

e Translating 

Each of these elements is explained in step-by-step procedures in this 

chapter. If you are only interested in what each does, or the other features of 

Stuffit Deluxe, see Chapter 5: StuffIt Deluxe Reference, for descriptions. 

This section explains how to use the StuffIt Deluxe application to create an 

archive. Creating a new archive and placing files into it is very simple. For the 

purposes of this tutorial, we’ve provided a small sample document called 

“A Document.” 

1. Double-click the StuffIt Deluxe icon to launch the program. 

Stufflt Deluxe opens and a floating window called the Archive Palette 

(shown here) appears on your desktop with all of the buttons dimmed. 
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When the buttons are active, clicking them is equivalent to choosing their 

commands from the Archive menu. For now, leave the Archive Palette 

where it is. 

2. Choose “New...” (Command-N) from the File menu. 

Stuffit Deluxe requires you to name an archive before you can work with 

it. Any time you choose “New...,” a dialog box appears with the default 

name “Archive.sit” and the prefix “Archive” selected. 

(—) Clarisimpact Folder 

(7) Framemaker 3.01 

isi Freeland Prefereaces 

Create new archive as: 

archive 
[] Create 1.5.1 Archive 

It’s always a good idea to rename the initial “Archive” prefix to something 

more descriptive of an archive’s contents. 

3. Type “Tutorial” for the name of this archive. 

4. Click the “New” button. StuffIt Deluxe creates an empty 

archive named “Tutorial.sit.” 

A new archive window appears above the Archive Palette. 

G Tutorial.sit 

Date Expanded 

zero K zeroK 0% El 

Notice how the Archive Palette has two active icons now: the “Stuff” icon 

for Stuffing files and folders into the archive, and the “New” folder icon, 

for creating new folders inside the archive. 

All you have done to this point is create an empty archive. Now it is time 

to put something in it. 
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5. Click the “Stuff” icon in the Archive Palette or choose 

“Stuff...” (Command-S) from the Archive menu. 

A dialog box appears with a directory listing on the left side containing a 

list of files and folders you can select from. This left part works like the 

“Open” dialog box in most applications. 

Note: See Chapter 5: StuffIt Deluxe Reference for a detailed explanation of 

the Stuffit “Open” dialog box. 

6. Open the “Stuffit Deluxe” folder, select a file, and click the 

“Add” button. 

Items to Stuff: 
add mailer 
Archive.sit a 

(Drag & Drop Applicat... f 
(7 DropConvert 
[} Icon 

fa preferences dialog 

(1) Read Us First! 

(Scripting Tools Hdd Maich.. 
Stuffit Deluxe Prefe... 

J Stuffit Deluxe™ 

[] Delete item when finished [] Encrypt with password 

stuffs 

The file moves to the “Items to Stuff” list on the right and the “Stuff” 

button (Command-S) becomes active. 

Tip: If you press the Option key when an item on the left side of the dialog 

box is highlighted, the “Add” button changes to “Add All” which places all 

the items listed on the left side into the right side of the dialog box to be 

Stuffed. (Conversely, press the Option key when an item on the right side 

is highlighted, and the “Remove” button changes to “Remove All,” which 

places all the items to be Stuffed back into the left side of the dialog box.) 

If you press the Command key when a folder is highlighted, the default 

active button changes to “Add’ instead of “Open.” 

7. Click the “Stuff” (Command-S) button. 
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A progress dialog box appears showing Stufflt’s progress as it Stuffs the 

file. If you want to cancel the operation, you can click the “Stop” button 

(or type Command-period at any time). 

items remaining to Stuff: 13 

Stuffing: Stuff 

That’s it. You’ve just created your first archive and Stuffed some files into it. 

Self-Extracting Archives _ This section explains how to use the StuffIt Deluxe application to make an 
archive that can be opened on any Macintosh, even if there is not a Stuffit 

product available. 

1. In StuffIt Deluxe, choose “New...” (Command-N ) from the 

File menu. 

2. Stuff a file or files into the new archive, as described in the 

previous example. 

3. Click the “Self-Extracting” check box in the lower left 

corner of the archive window. 

Stufflt Deluxe renames your archive, changing the “.sit” suffix to “.sea.” 

With the “.sea” suffix, you can instantly tell that the archive is a self- 

extracting file. 

(_] Drag & Drop Applications 5 items 7/20/94 188K 

(-—] Read Us First! 5 items 7/6/94 SOK 

4} Self-Extracting £2 Comments... 237K 163K 31% iy 

4. Close the archive. 

You can now send the self-extracting archive to another person. The icon in 

the Finder looks like this: 

Tutorial.sea 
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Anybody can now expand the file by simply double-clicking it. 

Encrypting an Archive This section explains how to use the encryption feature of StuffIt Deluxe to 
protect sensitive data in an archive. 

WARNING: If you forget an archive’s password, there is no way to recover the 

information or to modify the contents of the archive. Aladdin Systems cannot 

decrypt archives. Be sure to remember your passwords or write them down 

and put them in a safe place. 

1. Create an archive as described in the previous example. 

J Stuffit Deluxe™ Fol... ¥ items to Stuff: 

(Drag & Drop Applicat... |G] — PowerPC... |C Read Us First! 
[] Icon Gtjet) © Scripting Tools 

Stuffit Deluxe Prefe... 
<F Stuffit Deluxe™ Desktop 
(| Tutorial Files 

@ Tutorial.sea 

Add Match... 

[x] Delete item when finished >] Encrypt with password 

Stuffs 

The “Delete item when finished” option erases the files you Stuff, 

regardless if you choose to encrypt them or not. 

2. Select the file(s) you want to Stuff, and click the “Add” 

button. 

3. Click the “Encrypt with password” check box below the 

“Items to Stuff” list on the right. 

Note: If you plan on encrypting items time and again, you can set an 

preference option to always have “Encrypt with password” checked. See 

Chapter 5: StuffIt Deluxe Reference for information. 

4. Click the “Stuff” button. 
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A dialog box appears asking you to enter a password. 

Enter a password: 

Generate Random | 

Anything that can be typed from your keyboard is acceptable in the 

password, including international characters. A good password is 

alphanumeric, easy for you (but not someone else) to remember, and long. 

Since passwords are case-sensitive, you can make your password more 

difficult to break by adding capital letters in places. If you can’t think of a 

password, StuffIt Deluxe can generate a random one for you. A random 

password will probably not be easy for you to remember, so use the 

“Generate Random” button with discretion. 

Note: The minimum length of the password is three characters. 

5. Enter a password in the text box and click OK. 

StuffIt Deluxe prompts you to re-enter your password to verify that you 

typed what you wanted to type. 

Please re-enter your new password: 

Se RIESE: Ss ee ES 

6. Enter your password a second time and click OK. 

When you’ve entered the correct password, Stufflt Deluxe Stuffs the files 

or folders into the archive and a “key” icon appears in the archive next to 

the document icons. 

G Tutorial.sit 

2 items “Tutorial sit ” is 166K 52,592K free on “Bit-by-Bit ” 
eee Posten SOR ESV in SENOS CAR TOOMBS SEE ETALT GL Suen Bae? AHA : po See ee 

3 RS Drag & Drop Applications 5 items 7/20/94 188K 145K 23% rn 

Ef_] Read Us First! 5 items 7/6/94 SOK 18K 63% 

CO Self-Extracting £0 Comments... 237K 164K 31% | 

This indicates that the file is secured with a password. Since you're 

already in the archive, you can now add more files to it without having to 

re-enter the password. When you open the archive in future sessions, 

however, and attempt to add, delete, modify, or UnStuff files or folders 

that contain encrypted files, StuffIt Deluxe asks you for a password. 
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UnStuffing 

At any time, you can choose to change the password of the archive. This is 

done using the “Change Password” command from the Translate menu. See 

Chapter 5: StuffIt Deluxe Reference for details. 

This section explains how to use the StuffIt Deluxe application to UnStuff 

archives. To learn how to UnStuff files in the Finder, see Chapter 3: Easy 

Stuffing and UnStuffing. 

1. Double-click the archive from which you want to UnStuff 

files. 

Stufflt Deluxe automatically launches and opens the archive window. 

2 Double-click the file icon you want to UnStuff, or select the 

icon and drag it onto the “UnStuff”’ icon in the Archive 

Palette. 

G Sample Aarchive.sit 

“Sample Archive.sit” is 1K 

3/1/94 

3/1 #94 

under 1K 

1K 72% 

under 1K 

3K 

TeachText docu... 

TeachText docu... 

preteen peeteeeeeeneeneneeeneeneenes 

CO Self-Esttracting 0 Comments... 3K 1K 63% | 

If you drag it onto the “UnStuff” icon in the Archive Palette, the “UnStuff” 

icon darkens when the arrow cursor is over the icon. When the icon 

darkens, release the mouse button. 
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Segmenting 

A dialog box appears letting you rename the file or UnStuff it to another 

disk or folder. 

© Tutorial Files ¥ 

iy & Becurmesnt 

it Sample fiix<hige.sit 

Save UnStuffed file as: 

The King 

3. Give the file a new name (if you want to change it) and click 

“UnStuff.” 

When you UnStuff, a progress dialog box appears indicating that the file 

you chose is being UnStuffed and saved to disk. You can exit Stufflt Deluxe 

when you're ready to use the UnStuffed file. 

In this section, you'll learn how to Stuff multiple files into an archive and back 

up your data by making multiple-disk self-extracting archives. You’ll then 

learn how to join segmented files to restore the data. 

This example assumes you are Stuffing an item that is too large to fit ona 

single floppy disk. 

1. Stuff the items you want to back up into a new archive, as 

described earlier. For purposes of this example, we’ll call 

the archive “Office accounts.sit.” 

Stuff enough items so that your archive size is larger than what would fit 

on a single, high-density floppy disk, which holds 1.3MB. 
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2. Choose “Segmenti 

Translate 

Change Password... 

Convert 1.5.1 Archive 

AppleSingle 

BinHex4 

btoa/atob 

CPT Extract... 

Defrc... 

MacBinary 

PKG Expand... 

Segmenting 

tar 

Text Convert 

Unix Compress 

UnPack... 

Unzip... 

UUCode 

3. Select the “Office 

that appears. 

ng > Segment” from the Translate menu. 

Segment... 

accounts.sit” archive in the dialog box 

<— PowerPC Mac ¥ 

{_] Framemaker 

[=] F 
# Install America Online 
CK 
(7) Margie screens 

@A NativeChecker 
(_) Network Trash Folder 

Office accounts.sit 

<>] <> PowerPC... 

i [ Desktop 

HE Cancel 

(1) Old PowerPC System a 

Cor Ma 

Size of Segments: | High Density Disk ¥ 

(_] Self-Extracting 

4. Select the size of the media to which you are saving the 

segments from the pop-up menu. 

5. Click “Segment.” 
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Multiple Disk Self- 
Extracting Archives 

Method One: Copying 
Directly to Floppy Disks 

6. Select the floppy disk. 

Transfer Disk 1 ¥ 

Save segment (1 of 2) as: 

Office accounts.sit.1 

Erase Floppy 

7. Click “Save.” 

8. Insert floppy disks as requested. 

When StuffIt Deluxe has copied all the segments to the media you 

selected, you can close the StuffIt Deluxe application. To join these 

segments together, see the “Joining” section later in this chapter. 

If you create very large archives on your hard disk, you’ll soon run out of hard 

disk space. How can you copy a large archive to removable media, such as a 

floppy disk or a cartridge, so you can free up some room? 

The easiest way is to segment your large archives into self-extracting archives 

that can be copied to multiple disks or cartridges. The following two methods 

explain how to do this. 

The main advantage of Method One is you do not need to have the room on 

your hard disk to store the segments as they are made. The main disadvantage 

is if one of the floppy disks you are segmenting to is bad, you must start the 

segmenting process over. 

Though we can’t supply a sample archive as large as we’d like, the following 

simulation of Segmenting can be easily reproduced for an actual archive. 

1. Open your large archive. 
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2. Choose “Save As” from the File menu. 

Ea Desktop ¥ 

<> HD 

"2 Frash 

Save archive as: 

L] Self-Extracting 

3. Click the “Self-Extracting” check box. 

Do not turn on the Self-Extracting feature anywhere else but in the Save 

As dialog box. This is very important. 

4. Insert a floppy disk, and select it as the destination. 

5. Click Save. 

A dialog box appears asking if you want to segment the file. 

“may1994.sit” in its entirety. Do you wish to 

} There is not enough space to save 

save it in segments? 

6. Click Yes. 

Continue to insert disks as prompted. You have an option to erase the 

contents of an inserted disk, if you want to. Otherwise, Stufflt Deluxe 

adjusts the size of the segment to fit on the remaining disk space. 

7. After all segments have been written to the floppy disks, 

you should check the contents of each disk to ensure data 

integrity. 

The more important your data is, the more you need to verify the data. You 

can do this in one of three ways: 

e Copy the segment from each floppy disk to a folder on your hard disk. 

The very process of copying a file successfully verifies the data. 
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e Use a third party utility, such as Norton Disk Doctor or MacTools, to 

verify each disk. 

e Reverse the process by double-clicking segment one on disk one. This 

extracts the data to its original, UnStuffed state. 

Method Two: Copying to We will use the same archive as in Method One, but this time, we will segment 

Your Hard Disk First the archive to your hard disk and copy each segment to floppy disks. 

The main advantage of Method Two is if a floppy disk is bad, all you have to 

do is copy its segment from the hard disk to another floppy disk. The main 

disadvantage is you must have plenty of room on your hard disk to store the 

original archive and the segments created. 

1. Run Stuffit Deluxe. 

2. Choose “Segmenting > Segment” from the Translate menu. 

A dialog box appears with some new options. 

<> PowerPC Mac ¥ 

(7) Framemaker <> PowerPC... 

j 

ee: oun > Install America Online 

(7 Margie screens — 

@A NativeChecker nea 
(7 Network Trash Folder 

Office accounts.sit 

(Old PowerPC System a 
CR ts 

Size of Segments: | High Density Disk v 

>] Self-Extracting 

3. Click the Self-Extracting check box. 

4. Select the archive you want to segment. 

5. Select the media size from the “Size of Segments” pop-up 

menu at the bottom of the dialog box. 

Choose the size of the segments that match the size of the media you will 

be copying the segments to after the segmenting process is done. 
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Note: The floppy disk options are fixed segment sizes: 400K for single-sided, 

800K for double sided, and 1.3MB for high density. However, System 7 may 

format a disk at less capacity because it can block out bad sectors on the 

floppy disk. This means if you insert a System 7-formatted floppy disk that has 

only 1.1MB available (and you have selected the High Density Disk option), 

StuffIt Deluxe rejects the floppy disk. To avoid this situation, choose the 

“Maximum Possible” or “Other...” options. 

6. Click the “Segment” button in the dialog box. Another 

dialog box appears to save the first segment. 

cy Stuffit Folder ¥ 

f Read Me fire? 

(1 Sample Read Me Files 

& Stuffit feluxe™ 
© Tutorial Files 

Save segment (1 of 5) as: 

Office accounts.sea 

Erase Fipppy 

StuffIt Deluxe automatically adds a suffix for the number of the segment 

(e.g., “.2”) after the name of the file you’re segmenting. It’s best to leave 

the name unchanged because it makes it easier to join the segments later. 

7. Go to the folder (on your hard disk) in which you want to 

save the first segment and click “Save.” 

When you segment a file to a hard disk, you can automatically create 

several segments by clicking the “Save All” button instead of the “Save” 

button in the Segment dialog box. StuffIt Deluxe automatically divides the 

file into as many segments as necessary to fit on the media you selected 

earlier. 

The segmented icons look like this: 

Office accounts. sea Office accounts .sea.2 Office accounts.sea.3 

8. Copy each segment to a floppy disk. 

The Macintosh normally verifies files as they are read from or written to 

disk. However, if you want to be extra sure your data is secure, use a third 

party utility, such as Norton Disk Doctor or MacTools, to verify each disk. 
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Restoring a Segmented 
Archive 

Joining 

Alternate Method 

Translating a File 

When you want to restore the data contained in a self-extracting segmented 

archive, simply double-click the first segment. You do not need to run Stuffit 

Deluxe at all. 

If you are restoring from floppy disks, insert each disk as prompted. Your data 

is automatically saved into whatever folder you want, wherever you want. 

If you segmented an archive without using the self-extracting option, you 

must use the “Join...” command to join files that were split using the 

“Segment...” command. 

1. Choose “Segmenting > Join” from the Translate menu. 

StuffIt Deluxe prompts you to locate the first segment of the file that you 

want to join. 

3. Insert the disk containing the first segment. 

If you segmented to a hard disk, go to the location of the segmented files. 

4. Select the segment with the “.1” suffix and click Open. 

A Save dialog box appears, prompting you where to save the joined file. 

5. Once you've picked the location for the joined file, click 

“Save.” 

A progress dialog box appears as StuffIt Deluxe assembles the segments of 

the file. After StuffIt Deluxe has assembled the first segment, it ejects the 

first disk and prompts you for the second segment. 

6. Insert the disk with the second segment. 

Stufflt Deluxe continues joining the file, prompting you for each disk in 

sequence until the joining process is completed. When StuffIt Deluxe has 

joined all the segments, it tells you it’s done. 

@ Use Stufflt Expander to join the segments together. See Chapter 8 for 

more information. 

In the real world of computers and telecommunications, you are more than 

likely to encounter files or documents that your Macintosh cannot read. When 

Macintosh computers are connected to each other over local area networks 

(LANs), they communicate using file servers and electronic mail. Under 

those conditions, you may get a file that was created by an application you 

don’t have. Furthermore, Macintosh computers can also communicate with 

32 Chapter 4: The Stuffit Deluxe Application 



Method One 

Intel-based machines running MS-DOS or Windows, UNIX machines, and 

other mainframe systems. In those circumstances, you can be sure you'll 

receive a file that was not only created by an application you don’t have; it was 

also created with a completely foreign disk and file structure. It may even be 

compressed using a foreign archive format. 

With these situations in mind, StuffIt Deluxe comes with “Translators.” These 

translators help you manage foreign file and foreign archive formats. 

This section shows you how to translate a “zipped” file from a PC computer 

into a normal Macintosh file. (All of the translators in StuffIt Deluxe have a 

similar interface, and each is described in Chapter 5: StuffIt Deluxe 

Reference. ) 

You can use the translators from the Translate menu. 

1. Run Stuffit Deluxe. 

2. Choose the appropriate translator from the Translate 

menu. 

In this example, we’ll use the “UnZip” translator. 

Translate 

SOPECEEECEC2 2724 S420432 3... 

3. Select the “.zip” file from the dialog box that appears. 

[ ") HELPFILE.21P <= Bit-by-Bit 

Desktop 

~] Show files ending in .zip and .gz only 

L] Show all file types ks Fe 

4. Click “Open.” 
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A dialog box appears that lists the contents of the “.zip” file. 

Select file(s) to UnZip from “HELPFILE.ZIP:” 

ADYVFE AT DOC 

CONTENTS. .DOC 
PREMEET .DOC 
MEET .DOC 
PTDREF .DOC 
REF .DOC 
PROPOS AL .DOC 

30417 bytes decompressed. 

11125 bytes deflated. 

5. Select the files you want and click UnZip. 

A dialog box appears prompting you for a destination for the unZipped 

files. 

Select destination folder: 

©] Internet files copy ¥ 

(1) HELPFILE Folder 

39550K free on this disk. 

] Convert CR/LFs 

UnZip into “HELPFILE Folder” 

6. Select the destination and click the large button at the 

button of the dialog box. 

The UnZip translator unZips the file. A dialog box displays the progress. 

UnZipping 

Items Remaining: 4 

UnZipping PREMEET.DOC 

© 1990-94 Aladdin Systems, Inc. & Raymond Lau. 
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Method Two You can use the “Open” command from the File menu in StuffIt Deluxe to 
expand various compressed file formats, such as Stuffed, zipped, and 

BinHexed files. 

1. Run Stuffit Deluxe. 

2. Choose “Open” from the File menu. 

3. Select the “.zip” file from the dialog box that appears. 

Be sure that the pop-up menu at the bottom of the dialog box displays 

“Show All Files.” 

[ ] AOL Aid 1.1.cpt 
[ ] compress.exe.2 

=]] compress.uue 

Fetch 2.1.2.sit.hqu 
|] HELPFILE.Z1P 

Show: All Files v 

4. Click “Expand.” 

The file is UnZipped into the same folder as the original .zip file. 

Where To Go Now that you know the basics of Stufflt Deluxe, you can skim the next chapter 

From Here 
for details on the specific features you like to use. Or you can read about using 

Stufflt Deluxe’s scripting capabilities or the new drag and drop applications. 

See the Index or the Table of Contents for these and other topics. 
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The Archive Palette 

Chapter 5: 
Stuffit Deluxe Reference 

This chapter describes the features, commands, and preferences in Stuffit 

Deluxe. The chapter is organized by what you initially see when you first run 

Stuffit Deluxe, and then each menu item is described. 

The Archive Palette is a very useful tool. It’s a good idea to know the full range 

of its capabilities as soon as you can. To get a better idea of how it works, you 

may want to launch StuffIt Deluxe and open an archive as we proceed with 

this explanation. 

When you launch Stuffit Deluxe, the first thing that comes on screen is the 

Archive Palette, a row of buttons that “floats” above archive windows. When 

no archive is open, all the buttons are dimmed: 

Each button in the Archive Palette has an equivalent menu command in the 

Archive menu (as well as command-key equivalents), and just like any menu 

item, when the button is unavailable it’s “dimmed.” The following illustration 

shows the Archive Menu, Command Keys, and their Archive Palette 

equivalents. 
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Archive 

Stuff... 

UnStuff... 36 U 

New Folder 36 F 

Delete 36D 

Get Info... 36 | 

View a6 L 

Launch a6 7 

Move/Copy... 

To use the Archive Palette, click the appropriate button to initiate the 

desired operation on the file or folder that you’re manipulating. You can also 

select an item in the Archive Window and drag it onto certain buttons to 

perform the same operation. This dragging operation works for “UnStuff,” 

“Delete,” “Info,” and “Move.” Files, but not folders, can be dragged onto the 

“View” (if the file is viewable), “Launch,” and “Move” buttons. The process 

looks like this: 

G Sample Archive.sit 

“Sample Archive sit” is 1K 

3/1/94 

3/1 #94 

under 1K 

1K 72% 

under 1K 

3K 

TeachText docu... 

TeachText docu... 

prteeen geeteeeeeeeneeeeeeneeeeeneees 

wand drag it to 

the Unshuff button 

C) Self-Ettracting £2 Comments... 3K 1K 63% |G) 

Unsta 

You can also manipulate the Archive Palette to make the best use of your 

screen real estate as you work with your archives. 

Move You can move the palette around on the screen by simply holding the mouse 

cursor down on the bar at the top of the palette and moving it to where you 

want it. 
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Retile 

The Archive Window 

You can click the Retile box located in the upper right corner of the palette 

to toggle the palette through the following four tiling views: 

Double Row 

Click Here 

To summarize, you have four main ways to execute a command in StuffIt 

Deluxe: 

e You can choose the appropriate command from the Archive Menu. 

e You can type the Command-key equivalent of the menu command. 

e When a file or folder is selected in an archive, the grayed-out icons become 

active and you can click the appropriate button in the Archive Palette. 

e You can drag the file or folder onto the appropriate button. 

When you create your first archive, you’ll notice that an empty archive 

window is created even before you put anything into it. That’s because 

whenever you create an archive, you're immediately saving its information to 

disk. 
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Sort headings and pop-up meni roodified siz siz saved 

SaaS 6 mn archive vinous t 

(3 Folder 0 items 8/1/94 under 1K 

Floppy alias alias 8/1/94 1K under 1K 56% 

@ Ab alias alias 8/1/94 1K under 1K 56% 

} Server alies alias 8/1/94 1K under 1K 56% 

fT Trash aliss alias 8/1/94 1K under 1K 56% 

<& Application application progr... 98/1/94 441K 221K 50% 

&> Exposed desk accessory desk accessory 8/1/94 36K 25K 31% 

Suitcase desk accessory 5... 8/1/94 36K 25K 31% 

Encryption LC) Document document 8/1/94 21K 6K 71% 

key £2) Encrypted document document 8/1/94 31K BK 74% 

stationery stationery pad 8/1/94 21K 6K 71% 

SSOP Peewee ey 
[E] Self-Extracting Comments... | | SOK 268K 555 | 

Self-Extracting Coraments icon Kind of itern Goluran totals 

chee kbox 

Every item Stuffed within a StuffIt Deluxe archive is listed with its own kind 

of icon that helps you identify what kind of file it is. A key to the left of an icon 

indicates that an item has been encrypted. 

A fundamental difference between windows in most Macintosh programs and 

a Stufflt Deluxe archive window appears only when you are in a folder within 

an archive. When you are inside a folder, the name of the folder appears in 

the title bar (in place of the archive name) and that folder name is an active 

pop-up menu similar to the one in Open and Save dialog boxes. 

Here is what you see when inside a folder. Notice how there is a down arrow 

next to the folder name. This means that this is a pop-up menu. 

&) A folder ~ 

tt tt Net 

Clicking on the folder name (or the down arrow) displays the pop-up menu. 

Choosing any item from the pop-up menu brings you to that folder. In this 

example, choosing “Sample Archive.sit” brings you to the root level of the 

= A folder 

Poin. VRS eas CV within atelger * 1 ,153K free on “HD” 
“= Name G Sample Archive.sit 

You can also type Command-‘up arrow’ to move out of a single folder. If a 

folder is selected, type Command-‘down arrow’ to enter into it. 

Status Area Appearing below the title bar is a Status area that tells you: 

e how many items are contained at the current level in the archive, 

e the name of the archive and its size, 

e the amount of free space on the disk where your archive resides, and 
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Self-Extracting Check Box 

Comments Icon 

Selecting Items in the 
Archive Window 

Dragging Items Within and 
Between Archives 

e the sorting order of the archive’s contents. 

Clicking the Order icon to the left of the Name label sorts the files by the 

order they were entered into the archive. Clicking the Name, Kind, Date, 

Expanded, Stuffed, or Saved heading above a list of files sorts the file list 

according to the view heading. 

At the bottom of the archive window, more options are available to you for 

modifying your archive. 

One of the options in the lower left corner of an archive window is the “Self- 

Extracting” check box. It creates an archive that can be opened on any 

Macintosh, even if there are no Stufflt Deluxe products present. 

Another option is the “Comments” icon. This icon lets you enter text about 

the archive. See “Editing Comments” later in this chapter for details. 

There are several ways in which you can select one or more items in an 

archive window. 

Select multiple items that are non-consecutive by pressing the Command key 

and clicking each item. Select consecutive items by pressing the Shift key and 

clicking each item. 

Another way to select multiple items is to drag the arrow cursor around a 

group of items. A dashed rectangle indicates the area covered as you drag and 

the selected items become highlighted. As an example, here is a selection of 

three items. Hold down the mouse button as you start the selection in the 

lower left corner. 

3 items 

fe Mame 

(7 Mike's Folder 

[=] & Document 

(=) Jane has a moment of farne 

C7 Mike's Folder 

[E) & Document 

[) Presentation to President 

(9 July 1992 Correspondence 

You can drag items within archives onto icons to perform commands. You are 

also able to drag items into folders, to rearrange their order within an 

archive, to copy items between archives, and to drag items out of archives to 

the Finder. 

Dragging a file or folder into an archive is simple; it’s done just as you do in 

the Finder. You can drag one or more items into any folder icon to move it into 
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Dragging Items Between 
Archives and the Finder 

The File Menu 

that folder. If you want to rearrange the order of items within an archive, you 

must have the Order icon view selected. Drag any file or folder that you want 

to reorder to its new location. Here we drag “July 1992 Correspondence” 

between “A Document” and “Jane has a moment of fame.” Notice the 

illustration on the right shows the new position of the “July 1992 

Correspondence” folder. 

3 items 

Name 

(7) Mike's Folder 

[=] 4 Docurnent 

(5 July 1992 Correspondence 

[) Presentation to President [2] Jane has a moment of fame 

|B uly 1992 Correspondence [] Presentation to President 

When multiple archive windows are open, you're able to drag one or more 

items between them. This is the same as using the “Copy” button when using 

the “Move/Copy” command. (The Move/Copy command is described later in 

this chapter.) A duplicate of the item(s) you drag are placed in the archive 

you want them in. Here we’re dragging a folder into the “1992.sit” archive. 

G May 1992.sit 

“May 1992.sit” is 1K 

Date Expanded 

5/11/92 

Date Expanded Stuffed Saved 

C] Self-Extracting £9 Comments... zero K zeroK O% a 

You can also drag items out of the archive window to the Finder, and vice 

versa. See Chapter 3 for step-by-step instructions on how to do this. 

The commands on this menu are very similar to those found on the File menu 

of any application. 

42 Chapter 5: Stufflt Deluxe Reference 



New 

Open 

The New... (Command-N) command displays the following dialog box. 

f= Desktop ¥ <— Bit-by-Bit 

— Bit-by-Bit 
Pg Hecument 

Mee Haitiashin i. i 

Create new archive as: 

Archive 
(_] Create 1.5.1 Archive 

The default name for a new archive is Archive.sit. However, “Archive” is 

highlighted to let you type in a better name. This dialog box also lets you 

create a new folder to store your new archive in, or create an archive in 1.5.1 

format (discussed later in this chapter). 

The Open... (Command-O) command displays the following dialog box. 

<] Tutorial Files ¥ 

is BR Borurreané 

CO Sample Aarchive.sit 

Show: ~All Archives " 

SpaceSaver Files 

All Files 

Choosing “All Archives” from the “Show” pop-up menu makes the Open dialog 

box display only regular archives (.sit) and self-extracting ones (.sea). 

Choosing “SpaceSaver Files” causes all files compressed with SpaceSaver to 

appear. Opening a SpaceSaver file automatically decompresses it in place. 

This option is provided for the time that you may have SpaceSaver off and 

need to access a compressed file. The third menu choice, “All Files,” makes 

every file on your disk appear in the dialog box. Use this with caution. StuffIt 

Deluxe always warns you if the file you’re opening cannot be used. 

The “UnStuff’ button in the Open dialog box can expand not only Macintosh- 

compressed files (such as those compressed with StuffIt, SpaceSaver, 

Compact Pro, and AppleLink), but non-Macintosh files with extensions such 

as .zip, .Z, .arc, and .hqx. See Chapter 4: Basic StuffIt Deluxe for step-by-step 

instructions. 

Chapter 5: StuffIt Deluxe Reference 43 



Close 

Save As 

Verify 

Page Setup 

Print 

Quit 

Note: The button name changes between “UnStuff” and “Expand,” depending 

on the selected file. 

The Close command closes the active archive window. 

StuffIt Deluxe does not have a “Save” command because it always saves your 

archive as you Stuff files into it. The “Save As...” command allows you to save 

an open archive in another location and optionally rename it at the same 

time. When you choose “Save As...” from the File menu, a “Save” dialog box 

appears. 

Ee Desktop ¥ 

c<—> HD 

! Frash 

Save archive as: 

Sample Archive.sit 

|] Self-Extracting 

This Save dialog box works like every Save dialog box. You can also click the 

“Self-Extracting” check box and save an archive as a self-extracting archive. 

You can use this command to save a self-extracting archive so that you can 

keep both the original archive and have a self-extracting version of it. 

This command ensures that a file is exactly the same in an archive as it is on 

the disk. Since the Macintosh normally verifies files as they are being read 

from or written to disk, this is an extra measure of security. 

Use this command when you’ve selected a new printer in the Chooser or when 

you want to use a different paper size or printing option. 

Use this command to print a listing of the current archive’s contents. You can 

choose to print the entire archive, or just the contents of the folder level you 

are viewing when you choose the Print command. 

In the printed report, a header appear that gives you the name of the file and 

the level from which the report was generated. This is followed by any 

comments that are stored in the Comments balloon. 

Use this command to exit from the Stufflt Deluxe application. 
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Mail Options (PowerTalk If you are currently using PowerTalk with a version of System 7 that supports 

only) 

Add Mailer... 

Send 

Reply 

Forward 

The Edit Menu 

Undo 

Cut 

it, you can send mail directly from StuffIt Deluxe using mail commands found 

on the File menu. Using these commands, you can add a standard mailer to a 

StuffIt Deluxe archive and send the archive to other PowerTalk users. You 

can add a mailer to a new or existing archive. 

The PowerTalk term for a document that contains a mailer is a “letter.” 

Before sending a letter, you must address it. See the PowerTalk 

documentation for detailed information on creating, addressing, and sending 

a letter. 

After you have opened an Archive window, the Add Mailer command becomes 

available. Choose Add Mailer from the File menu, and StuffIt Deluxe attaches 

a mail header to the top of the Archive window. (If you currently have a mailer 

window open, this command changes to Remove Mailer. ) 

You must enter a subject and address the mailer. You are now ready to send 

your letter. 

After you have attached a mailer and addressed it, the Send command 

becomes available. Choose Send from the File menu. You can send your letter 

as an AppleMail document, a graphic snapshot of the document, or as a 

StuffIt Deluxe archive. Choose an option, then click Send. 

Note: To add your digital signature, see “Attach Signature” later in this 

chapter. 

PowerTalk places your incoming letters in your In Tray on the desktop. Once 

you read a letter, the Reply command becomes available. With the letter 

open, choose Reply from the File menu. Type your reply, then choose Send 

from the File menu. 

With a letter open, choose Forward from the File menu. If necessary, expand 

the mailer by clicking the triangle in the upper left corner, and then click the 

Recipients button to add forwarding addresses. Once these have been added, 

choose Send from the File menu. 

The Edit menu contains the standard Macintosh editing commands, and one 

very important Stufflt Deluxe command that sets the way you want StuffIt 

Deluxe to look and work. 

Use this command to cancel the last action performed. This command is 

generally not enabled. 

Use this command to remove the selected item to the Clipboard from which 

you can paste it elsewhere. 
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Copy 

Paste 

Clear 

Select All 

Preferences 

The View Menu 

by Order 

by Name 

by Kind 

by Date 

by Expanded 

Use this command to copy the selected item to the Clipboard from which you 

can paste it elsewhere. 

Use this command to place the contents of the Clipboard at the location of 

the insertion point. 

Use this command to remove the selected item without placing it on the 

Clipboard. 

Use this command to select all items in the active window. 

This command sets a multitude of options that customize the way StuffIt 

Deluxe looks, feels, and behaves. Since there are so many options, we’ve 

placed them into their own section, “Setting Preferences,” at the end of this 

chapter. 

The View menu is very similar to the one in the Finder, and lets you sort the 

items in the archive window. 

Dieu 

“by Order 

by Name 

by Kind 

by Date 

by Expanded 

by Stuffed 

by Saved 

This displays the items in the archive window in the order in which they were 

placed into it. 

This displays the items in the archive window sorted alphabetically by name. 

This displays the items in the archive window sorted alphabetically by kind 

(such as TeachText documents, MacWrite documents, or Microsoft Excel 

documents). 

This displays the items in the archive window sorted by date, which is based 

on when the file was last modified by an application. 

This displays the items in the archive window sorted by the size of each file 

when it is UnStuffed. 
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by Stuffed 

by Saved 

The Label Menu 

The Archive Menu 

This displays the items in the archive window sorted by the Stuffed size of 

each item. 

This displays the items in the archive window sorted by the percentage of disk 

space each one is saving. 

The Label menu is identical to the one found in your System 7 Finder menu 

bar. You can use it to assist in prioritizing files and folders. The SpaceSaver 

part of this package lets you assign labels to items to compress or not to 

compress. See the SpaceSaver manual for information on this feature. 

Essential 

Hot 

In Progress 

Project 1 

Project 2 

Using the Label menu lets you assign labels to files or folders within archives. 

In System 6, these labels are color names. 

Note: System 7 users can change the color and/or the name of each label. 

This is done with the Labels control panel. See the Macintosh Owners Manual 

for instructions. 

Labels may be assigned to files before or after they are Stuffed into archives. 

Files may later be sorted by Label, using the “View” menu described above. 

Files sorted by Labels are prioritized from the top down. For example, files 

labeled with “Essential” are sorted by View at the top of a list of files within 

an archive and files labeled with “Project 2” are sorted second to the bottom. 

Files that do not have labels (“None”) are sorted at the bottom when the 

Label View is selected. 

The Archive menu lets you execute the main StuffIt Deluxe commands from 

the menu. You must have either the Archive menu or the Archive Palette 

active. The Archive menu and the Archive Palette may be active at the same 

time. 
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Stuff 

Name 

Archive 

Stuff... 

UnStuff... 

New Folder 36F 

Delete 36D 

Get Info... #1 

View 3€L 

Launch 36T 

Move/Copy... 

Make Self-Extracting 

Edit Comment... 
Attach Signature... 

Use this command to open a dialog box that lets you select items to Stuff. For 

step-by-step instructions on using the Stuff command, see Chapter 3. 

A very powerful tool for narrowing the criteria by which files are added to 

archives appears in the dialog box that lets you choose items to Stuff. It is the 

“Add Match” option that lets you include or exclude just about any kind of file 

in a given folder during your archival process, using the either/or options in 

the various check boxes and pop-up menus. 

Select a folder or disk icon in the “Stuff” dialog box to activate the “Add 

Match” button. Then click the “Add Match” button to display the following 

dialog box: 

Add items in “Stuffit Deluxe™ Folder” matching the following criteria: 

ee | ae 
=r a 
CZ Label 

C] Size 

C) Date Created 8/21/94 [~] 

C1 Date Modified s/2i/o4 [w] 

(Cancel | = 

Click the “Name” check box to choose files to Stuff by Name. The pop-up 

menu lets you choose whether any file that contains or does not contain; is or 

is not; begins with or does not begin with; ends with or does not end with, the 

name you type is added to the archive. 

¥ contains 

does not contain 

begins with 

does not begin with 

ends with 

does not end with 
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Comments 

Kind 

Kind...is Type/Creator 

Label 

Click the “Comments” check box to choose files you’d like to Stuff by the 

comments they have in the Comments field in the Finder. The pop-up menu 

is identical to that for the “Name” criteria. 

Click the “Kind” check box to archive those files which are of a certain 

application Kind. Most of the pop-up options (except the last two) are 

identical to the Comments pop-up menu, and when they’re selected, the pop- 

up menu on the right displays a generic listing for Stuffing files according to 

whether they’re an alias, application, document, extension, stationery, 

or suitcase. 

¥ contains 

does not contain 

is 

is not 

begins with 

application does not begin with 

ends with 

does not end with 

is type /creator 

is not type ‘creator 

document 

extension 

stationery 

suitcase 

When you select a file that is or is not of a certain type/creator, however, this 

activates two linked pop-up menus to the right of the Kind menu for picking 

the type or creator that you want. 

The “type” menu appears with a list of the more popular document types (the 

left menu shown here) and the “creator” menu (on the right) has a list of 

popular applications. If the one you want to use does not appear on the list, 

you can type it in the text box above each list. 

ALB4 PageMaker document 

APPL Application 

drw2 Canvas image 

EPSF Encapsulated Postscript 

FMPR FileMaker Pro database 

MORS More 3.0 outline 

MW20 Mac'write Il document 

PICT Picture document 

PNTG MacPaint painting 

SIT! Stufflt 1.5.1 archive 

SITD Stuffit Deluxe archive 

SPn3 SuperPaint 3.0 image 

STAK Hypercard stack 

TEXT Text document 

TIFF Tiff image 

WDBN ‘word 4.0 document 

WORD Mac'vrite document 

XLS Excel spreadsheet 

XLS3 Excel 3.0 spreadsheet 

ALD4 PageMaker 

ARTS Mlustrator 3.0 

ARTZ IMustrator 

DAD2 Canvas 

FMPR FileMaker Pro 

KAHL THINK C 

NACA Mac'write 

MOPL MacDraw Il 

MORW MacDraw 

NOR2 More 

MPNT MacPaint 

MPS) MPW 

MNSWD Microsoft Word 

MWI 1 MacWrite Il 

SIT! Stuffit 

SPNT SuperPaint 

ttxt TeachText 

WILD HyperCard 

XCEL Excel 

Click the “Label” check box to archive an item which is or is not labeled in a 

specific way. To choose files by label, you choose the linked pop-up menu to 
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Size 

Date Created 

Date Modified 

UnStuff 

New Folder 

the right of the Label menu. The labels are those which display in the Finder 

Label menu. 

Essential 

BBE Hot 

ieee In Progress 

Personal 

v is Hunn: Project 1 

is not Project 2 

Note: Under System 6, labels are colors only. System 6 doesn’t support labels 

as System 7 does. 

Click the “Size” check box to select a file in the folder that is or is not; is less 

than or greater than; is between or not between, the size you enter in the size 

field immediately to the right of the Size pop-up menu. 

¥ is 

is not 

is less than 

is greater than 

is between 

is not between 

Click the “Date Created” check box to select a file in the folder that has been 

created on, after, or before; is or is not; is between or not between, the date(s) 

chosen in the pop-up menu(s) to the right of the Date Created menu. When 

you select a range option (e.g. between), a second date pop-up menu 

identical to the menu below appears letting you set the limits for the range. 

v today 

yesterday 

this week 

¥ is on or after last week 

is on or before this month 

last month 

this year 

is between last year 

is not between last archive change 

Note that when you select the month, day, or year of the date, you can type a 

new number at that location, or you can use the up/down arrows to scroll 

through the number list. 

Click the “Date Modified” check box to select a file in the folder that has been 

modified according to the criteria in the pop-up menus for Date Modified. 

These menus are functionally identical to the Date Created menus, except 

that they specify ranges for the file’s modification date, not the date of its 

creation. 

Use this command to UnStuff the selected items in the archive window. 

Use this command to add an Untitled folder to the archive window. You can 

name the folder by typing a name, and then open the folder to Stuff files into 

it. 
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Delete 

Get Info 

View 

Launch 

Use this command to delete the selected items from the archive window. 

Use this command to get detailed information on the selected item in the 

archive window. 

EIJ= User's Gyide Add 
ey 8. 

Kind: SimpleText document 

Expanded: 17,288 bytes (17K) 
Stuffed: 6,480 bytes (6K) 

: 10,808 bytes (63% saved) 

Kind of fle 

Unsifted size 

Stuffed size 

Percentage saved 

Disk and archive 
loe ation 

Date Aime of 

creation 

: Bit-by-Bit: dix folder :Tutorial.sit :Read 

Us First!: 

reated: Tue, Sep 14, 1994, 10:13 PM 

Modified: Tue, Sep 14, 1994,11:18 PM 
Date Aime last 

modified Label: 
Finder Label Type: [_] Locked 

pop-up Creator - [_] Stationery 

File Type 

File Creator File locked checkbox 

Stationery cheek bow 

A great deal of information about the file in your archive is shown in the “Get 

Info” box. Additionally, the “Get Info” box lets you change the file’s name in 

the selection rectangle, or its Label (or Color under System 6) in the pop-up 

menu. Clicking the “Stationery” check box changes the file to a “stationery 

pad” and the “Kind of file” field and “File icon” changes accordingly. Clicking 

the “Locked” check box on an unlocked file protects the file from deletion or 

alteration. If the file is already encrypted (indicated by the password key in 

the upper left corner of the “Get Info” box), you'll be prompted for a password 

before you can lock the file. If you don’t know the password, you won’t be able 

to check the “Locked” check box. 

Note: If you perform a “Get Info” on a folder, a similar window appears. A 

folder Info window is the same as a file Info window except there is no Type, 

Creator, Locked, or Stationery item. 

Use this command to look at a text file or a PICT graphic that is contained in 

the archive window. See Chapter 9: Other StuffIt Tools. 

Use this command to UnStuff a selected file and then automatically open the 

file if the appropriate application is available. 
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Move/Copy 

Make Self-Extracting 

Edit Comments 

Use this command when you have more than one archive window open. If you 

select items in one archive window, then choose “Move/Copy,” the following 

dialog box appears, showing the contents of the current archive window: 

G A Document.sit w 

G ADocument.sit 

DeluxeTop 

(“tren ) 

Click the “DeluxeTop” button to display all the archives that are currently 

open. (The DeluxeTop button is the StuffIt equivalent of the “Desktop” button 

in anormal Open and Save dialog box. The “DeluxeTop” button shows you all 

currently open archives.) Click “Open” to select the archive to which you 

want to move or copy the selected item. 

<F DeluxeTop w 

G A Document.sit <H <F DeluxeTop 
G Archive.sit 

ieigHe ie 

The archive opens, and the Move and Copy buttons become active. The 

“Move” button moves the selected items from the original archive to the 

selected archive. The “Copy” button copies the selected items, leaving the 

original items in the original archive. 

Use this command to create an archive that can be opened on any Macintosh, 

even if there are no StuffIt products present. See Chapter 3 for step-by-step 

instructions. 

Choosing this command displays the Comments dialog box for the selected 

archive. A comment is text that you enter into an archive that always stays 

with an archive, regardless of the archive’s contents. It is different from a 

“Read Me?” file in that you can enter the text from within Stufflt Deluxe. You 

can print the comments of an archive with the “Print...” command. 
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Attach Signature... 

Comments can be entered into a moveable window in which you can drag text 

into and out of: 

Edit Comments 

Comments about “Sample Archive-sit ” - 

This is a comment window. You can move it around, and add up to 32,000 characters to it. 

If you have drag and drop capabilities on your Macintosh (depending on the Finder version you are 

running), you can drag text into the comment window and out of tt 

You can type up to 32,000 characters of information into this field. 

This is a PowerTalk-only feature which is available in versions of System 7 

that support it. It is a means of data authentication called the RSA Digital 

Signature ™ . A digital signature is a short segment of data that is stored with 

an electronic document. A digital signature positively identifies the signer of 

a document and verifies that the document has not changed since it was 

“signed.” 

Apple provides this authentication technique in the PowerTalk DigiSign ™ 

utility and your personal signer. For full details on how to obtain and use a 

digital signature, see the documentation that came with the PowerTalk 

software. 

When you choose the “Attach Signature” command, the following dialog box 

appears: 

“® Signing as “ Margie Foster ”. 
4 

DigiSign Identification Code: 

(ras) 

Enter your identification code, and click OK. Your digital signature is 

attached to the archive. A new icon appears at the bottom of the Archive 

window that lets you verify that the signature is valid (you can also choose 
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The Translate Menu 

Change Password 

“Verify Signature” from the Archive menu.) The following dialog box appears 

when you click the new icon or choose the “Verify Signature” command: 

“® The signature is valid. 

\ 

Signed on Tue, Jun 28, 1994 at 22:31. 

Signed by : 

Name: Margie Foster 
Address:165 Westridge Drive 
Locality : Watsonville 

State: California 
Zip Code: 95076 
Country: US 

Macintosh computers can communicate not only with each other, but with 

Intel-based machines running MS-DOS or Windows, UNIX machines, and 

other mainframe systems. In those circumstances, you can be sure you'll 

receive a file that was not only created by an application you don’t have; it was 

also created with a completely foreign disk and file structure. It may even be 

compressed using a foreign archive format. 

With these situations in mind, StuffIt Deluxe comes with “Translators.” These 

translators help you manage foreign file and foreign archive formats. The 

Translate menu lets you access the file translation extensions that come with 

the StuffIt Deluxe application. Depending upon which translators you’ve 

installed, their commands are listed in this menu. With the Translate menu, 

you have a range of functions available to you. 

Translate 

Change Password... 

Convert 1.5.1 Archive 

AppleSingle > 
BinHex4 > 
btoa/atob * 
CPT Extract... 

DefArc... 

MacBinary * 
PKG Expand... 

Segmenting » 
tar > 

> 

> 

Text Convert 

Unix Compress 

UnPack... 

UndZip... 

UUCode 

Use this command to change the password of a password-protected archive. 

You must enter the original password, and then the new one. Stuffit Deluxe 

prompts you to enter the new password a second time to verify it. After it has 

been verified, you’ll need to use the new password whenever you work with 

the encrypted items in the archive. 
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Convert 1.5.1 archive 

AppleSingle 

BinHex4 

btoa/atob 

Use this command to convert an archive made with earlier versions of StuffIt 

to optimize their use with the current version of StuffIt Deluxe. Converting an 

archive to 3.x format does not improve the compression of the Stuffed files, 

but changes the archive to a format where you can navigate between folders. 

(The older 1.5.1 format does not let you move among folders and requires you 

to work at the root level only.) Once you’ve converted files to the newer Stufflt 

archive format, you cannot reconvert them to the older 1.5.1 structure. 

This format allows files to maintain their attributes on foreign file systems 

that do not support the same attributes. In the AppleSingle format, a file’s 

contents and attributes are stored in a single file in the foreign file system. 

For example, the data fork, resource fork, and Finder information are all 

arranged in a single file with a simple structure. 

Translate 

Change Passimard... 

AppleSingle > 

BinHex4 > 

Encode... 

Decode... 

You can encode a file to AppleSingle format, or decode an AppleSingle file to 

a normal Macintosh file. An AppleSingle file has an “.as” extension. 

This format is a standard conversion algorithm used to convert Macintosh 

binary files to and from ASCII format. It is used primarily for transmission 

over networks that only support characters that can be typed from a 

keyboard, such as Internet mail/news. On the Internet, BinHex4 is most 

commonly used on files that have already been compressed. BinHexed files 

have a “.hqx” extension. 

Translate 

Change Pa¢sudid... 

TSE rh oth ae Aah ae a al 
BinHex4 a Encode... 

btoa/atob >| Decode... 

You can encode a file to BinHex4 format, or decode a “BinHexed” file to a 

normal Macintosh file. When encoding, you can choose to “Include LFs.” In 

some older computer system environments, a BinHexed file may not be 

usable unless linefeeds are included. 

This translator (Binary to ASCII/ASCII to Binary) is an external translator 

that provides compatibility with the UNIX programs “btoa” and “atob.” These 

UNIX programs convert 8-bit binary data to 7-bit ASCII data (and the reverse) 

for transmission across channels which only support 7-bit ASCII data. 
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CPT Extract 

DeAre 

MacBinary 

Translate 

CHG? Passipard... 

btoa/atob » 
ON NNN NNN NNN 

Binary to ASCII... 

CPT Extract... >| ASCII to Binary... 

If you are using the Binary to ASCII conversion, leave the “Make MacBinary” 

option on. This converts your file to MacBinary format before doing the btoa 

translation. Use this option only if you’re sure that the file is going to end up 

on a Macintosh computer. 

If you are using the ASCII to Binary conversion, leave the “Recognize 

MacBinary” option on. However, if you know that the file was not from a 

Macintosh source or was not MacBinary-encoded, then turn this option off. 

This external translator provides compatibility with the Compact Pro archive 

format. You can extract any Compact Pro archive (.cpt extension) using this 

translator except those that are encrypted or segmented. 

This translator lets you expand files that have an “.arc” suffix that were 

created with any of the numerous Arc programs. You might not be able to use 

the extracted files on the Macintosh because they were created on a foreign 

computer. You must have an application that can use these files. 

After you have selected the file to DeArc, this dialog box appears: 

Select file(s) to DeArc from 
“FILES.ARC:” 

LIST .COM 

LIST .DOC 

PATHEDIT DOC 

PATHEDIT.EXE 

SC AN.EXE 

SC AN76-C.DOC 

24361 bytes decompressed. 

21722 bytes crunched. 

f] Convert CR/LFs to CRs 

The “Convert CR/LFs to CRs” option is intelligent in that it determines the 

best way to handle carriage returns and linefeeds during the translation 

process. Leave this check box on. 

This is an external translator that lets you encode or decode a file in 

MacBinary format for use in sending and receiving files to and from foreign 

computers across foreign networks. The MacBinary translator’s main purpose 
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PKG Expand 

Segmenting 

tar 

is to combine the data and resource forks in these circumstances. MacBinary 

is sometimes referred to as BinHex5, and has a “.bin” suffix. 

Translate 

Change Passipard... 

ce tc At at i A LE 

PKG Expand... Decode... 

This translator expands AppleLink package files. These files have a “.pkg” 

suffix. 

This command lets you copy a large archive onto multiple media such as 

floppy disks by segmenting the archive into smaller pieces that fit on the 

media. See Chapter 4 for details. 

The tar translator lets you create and extract files for use with the UNIX tape 

archiver, tar. Many files available on UNIX systems are archived with tar and 

generally have a “.tar” suffix. 

Translate 

Change Passmard... 

SNP NNN 
tar 4a Create... 

Text Convert ®| «Extract... 

When you create a tar archive, a dialog box appears, similar to the Stuff dialog 

box. In this dialog box, you add files or folders from the directory list on the 

left to the list of items to place into a tar archive on the right. 

When you extract files from a tar archive, the following dialog box appears 

that displays everything contained in that archive: 

Select file(s) to extract from FilesForDavid.tar: 

6/25/94 FilesForDavid/ 

6/25/94 FilesForDavid/DavidFi le_23 
6/25/94 FilesForDavid/DavidFi le_24 

6/25/94 FilesForDavid/Read_Ne 

] Convert LFs to CRs when extracting 

In the listing, the first column displays a symbol, indicating that the item is a 

file, directory, or special file (block, link, etc.). The symbol used is the same 

as that used by the UNIX “Is-l” command. 
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The “Convert CR/LFs to CRs” option is intelligent in that it determines the 

best way to handle carriage returns and linefeeds during the translation 

process. This is true for both creating and extracting tar files. Leave this 

check box on. 

Text Convert This translator lets you convert a Macintosh text file for use on other types of 

computers. Text conversion is necessary because different computers use 

different characters to specify the end of a line. The Macintosh uses a 

carriage return; the PC uses both a linefeed and carriage return; and UNIX 

systems use a linefeed character. Choosing the Text Convert command 

displays a pop-up menu: 

Translate 

Change Passipdard... 

Text Convert ‘4 Convert for Macintosh... 

Unix Compress >| Convert for PC... 

Convert for Unix... 

Choose the system you want to convert the file for. Each conversion places 

the appropriate suffix to the file name: “.mac” for a Macintosh file, “.pc” for a 

PC file, and “.unix” for a UNIX file. 

UNIX compress This translator reduces the size of files using a modified Lempel-Ziv coding 

algorithm for use on UNIX systems. When encoding a file, a “.Z” suffix is 

added. 

Translate 

CREHGG Passiard... 

Unix Compress Encode... 

Decode... 

The “Convert CR/LFs to CRs” option in the UNIX compress encode dialog box 

is intelligent in that it determines the best way to handle carriage returns and 

linefeeds during the translation process. Leave this check box on. 

UnPack This external translator provides compatibility with the Packlt II and Packlt 

III compression utilities written by Harry Chesley. Packlt files generally have 

a“ pit” suffix. You can use this translator to expand any “.pit” file except those 

that are encrypted. 

UnZip This translator expands the two most common “Zip” formats: .zip and .gz. You 
might not be able to use the extracted files on the Macintosh because they 

were created on a foreign computer. You must have an application that can 
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UUCode 

The Script Menu 

use these files. When you choose a “.zip” file to unZip, the following dialog box 

appears: 

Select file(s) to UnZip from “HELPFILE.Z21P:” 

ADVFE AT.DOC 

30417 bytes decompressed. 

11125 bytes deflated. 

Once you have selected the files to unZip, a dialog box appears to select a 

destination for the unZipped files. The “Convert CR/LFs to CRs” option in this 

dialog box is intelligent in that it determines the best way to handle carriage 

returns and linefeeds during the translation process. Leave this check box on. 

This translator is another external translator that lets you “uuencode” and 

“uudecode” files for use over UNIX networks and computers. When 

uuencoding a file, a “.uu” suffix is added. 

Translate 

CHanGe Pas¢sipard... 

UUCode ia UUEncode... 

en: 

The “Include LFs” option in the “Encode” dialog box is intelligent in that it 

determines the best way to handle carriage returns and linefeeds during the 

translation process. Leave this check box on. 

Activating the Script menu lets you record scripts, execute them, and add 

scripts to the Script menu using the “Edit Script...” command (Command-E). 

(The Script menu is not visible on the menu bar by default. To turn it on, 

choose Preferences from the Edit menu, and click the Script menu check 

box.) The scripting commands found on this menu are for use with Stufflt 
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The Window Menu 

Stack Windows 

Tile Windows 

Next Window 

Last Window 

Deluxe’s built-in scripting language. See Chapter 6: Automating StuffIt 

Deluxe for a detailed explanation each command. 

Execute Script... dE 

Record Script... dh 

Edit Script Menu > 

Stufflt Deluxe also supports external scripting languages such as AppleScript 

and Frontier from UserLand. StuffIt Deluxe comes with some sample scripts 

for AppleScript and Frontier in the Scripting Tools folder inside the StuffIt 

Deluxe folder. 

Activating the Window menu lets you switch between multiple archives, 

viewer, or “info” windows that are open at the same time. Once you’re used to 

moving files between archives, having the Window menu active is a handy 

tool. (The Window menu is not visible on the menu bar by default. To turn it 

on, choose Preferences from the Edit menu, and click the Window menu 

check box. ) 

Window 

Stack Windows 

Tile Windows 

Next Window 

Last Window 

“Sample Archive.sit #1 

This command displays multiple archive windows on top of each other, 

stacking them first to last, with the last topmost, in the order in which they 

were opened. 

This command displays windows based on the size of your screen. Stuffit 

Deluxe automatically calculates the best tiling option for the number of 

windows you have open. 

Use this command to descend one window down in a group of stacked 

windows, bringing that window to the front. 

Use this command to move to the last window in a group of stacked windows, 

bringing that window to the front. 
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Setting Preferences 

General Preferences 

Stuff Originals Instead 
of Aliases 

Don’t Stuff Files That Are 
Already Compressed 

Verify Writes 

Stufflt Deluxe has a broad range of features, many of which can be set as 

default preferences. 

To open the Preferences dialog box, choose “Preferences” from the Edit 

menu. 

General: Default Stuffing Settings - 

[X] Stuff originals instead of aliases EJ Compression 

EX] Don’t stuff files that are already compressed|| ((] Encryption 
CJ Verify writes Views - 

ae 
= pos oe eee to 3.0 on open &] Show kind 

iew “Read Me” files on open (J Show label 
CI Detect viruses with: 

New folder suffix : 

EA Show date . Gee 
[EX] Show expanded 

[Bd Show stuffed 

[x] Show saved 

EX] Show archive info in header 

EX] Show directory popup without 3 key 

Palette (Cli 

# Fike £232 YWiew Label Archive Translate Script Window 

Ed View EA] archive 
[J Label [J] Translate 

Ed Script 
EA Window 

Note: StuffIt Deluxe saves all your preferences in a “Stufflt Deluxe 

Preferences” document that’s stored in the Preferences Folder within the 

System Folder. 

The “General” section of the Preferences dialog box lets you set 

miscellaneous features within Stufflt Deluxe. 

General: 

[x] Stuff originals instead of aliases 
EA Don’t stuff files that are already compressed 

C1 Verify writes 

CJ Convert 1.5.1 archives to 3.x on open 

EX] View “Read Me” files on open 
CJ Detect viruses with: 

New folder suffix: | RUBE 

When this option is on and an alias is selected to be added to an archive, the 

original file is Stuffed instead of the alias. This option is for users of System 7 

only because System 6 doesn’t support aliases. This option is on by default. 

When this option is on, files that have already been compressed (such as 

certain PostScript fonts, StuffIt Deluxe files, and files compressed with other 

programs) are not re-Stuffed. The default for this option is on. 

Note: Any time a file compressed with SpaceSaver is Stuffed into an archive, 

the file is transparently decompressed as it is being Stuffed into an archive. 

SpaceSaver treats Stufflt Deluxe no differently from any other application— 

when a file is opened for use, it is automatically decompressed. 

When the “Verify writes” preference is on, a verification procedure is run on 

files as they’re being Stuffed. StuffIt Deluxe reads back a file that was just 
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Convert 1.5.1 Archives 
to 3.x on Open 

View “Read Me” Files 
on Open 

Detect Viruses With... 

Stuffed into an archive and compares it to the original. This gives you extra 

safety when Stuffing files into archives. This option is off by default since a 

slight delay occurs during the verification process. 

Note: The Macintosh normally verifies files as they are being read or written 

on disk. This option is necessary only if you want an added level of protection. 

When this option is on, Stufflt Deluxe automatically converts any archives 

created with earlier versions of StuffIt Deluxe as it opens them. Converting 

an archive to 3.x format does not improve the compression of the Stuffed files, 

but changes the file to a format where you can navigate among folders. The 

older 1.5.1 format does not let you move among folders and requires you to 

work at the root level only. 

Stufflt Deluxe ships with this option off by default. 

Note: StuffIt Deluxe also provides a command for converting individual 

archives into the 3.x format. It is “Convert 1.5.1 Archive,” found on the 

Translate menu. 

Regardless if you use the explicit menu command or the preferences setting, 

once you've converted files to the 3.x format, you can’t change them back to 

the old 1.5.1 file structure. 

When this option is on, StuffIt Deluxe uses the appropriate viewer to open a 

“Read Me” file in an archive. The phrase “Read Me” must appear at the 

beginning or end of the document name. This feature also views files whose 

name begins with “About” or ends with “Doc” or “Docs”. A “Read Me” file must 

be in the top level of the archive. Stufflt Deluxe ships with “View ‘Read Me’ 

Files on Open” on. This feature does not work on password-secured “Read 

Me” files. If you don’t want StuffIt Deluxe to automatically open “Read Me” 

files, turn off this option. See Chapter 9: Other Stufflt Tools for details on 

using viewers. 

This option is one of StuffIt Deluxe’s “Apple event” features and only works 

with System 7 since System 6 doesn’t support Apple events. To use this 

feature, you must have virus detection software that supports Apple events. 

Contact the vendor of your virus detection software to see if the version you 

have supports Apple events. 

When this option is on and you’re UnStuffing a file, StuffIt Deluxe opens the 

specified virus software and has it check the UnStuffed file for viruses. If a file 

is corrupted with a virus, that product tells you the file is not to be used. 

Stufflt Deluxe ships with the “Virus Checking” option off. 

To establish a link between StuffIt Deluxe and an Apple event-aware virus 

product, click the “Select...” button. An “Open” dialog box appears asking 

you to locate the anti-virus software. 
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New Folder Suffix 

Palette and Menus 
Preferences 

The Archive Palette 

Colorizing Palette Buttons 

The “New Folder Suffix” option lets you define a suffix for a folder when you 

click the Folder icon in the Archive palette, or select New Folder from the 

Archive menu. StuffIt Deluxe ships with the word “folder” chosen for you. You 

can rename the suffix anything you’d like. Remove the suffix if you want to 

create new folder names without a predefined suffix. 

StuffIt Deluxe has a user-definable structure that lets both beginners and 

experts feel comfortable with it. By setting your “Palette” and “Menu” 

preferences, you're able to turn on or off the Palette, or various StuffIt Deluxe 

Menus, depending upon your preferred way of working. 

When you installed StuffIt Deluxe, the Archive Palette is on by default, as you 

already saw when you loaded StuffIt Deluxe for the first time. 

-olG] al] — UnStubf fo) ul Info View Launch 

We also pre-selected six active menus for you: 

* File Edit UWiew Label Archive’ Translate 

You can change these settings to customize the Palette and menu bar. 

Palette (Click to colorize): 

a fetool sles [abs 
The Archive Palette is on by default since many users find the Palette the 

easiest way to use StuffIt Deluxe. This palette may be turned off and you can 

execute all your commands from the menus or keyboard. If you turn off the 

palette, however, you must have the Archive menu turned on to access the 

main features of StuffIt Deluxe. 

If you're using a color monitor, you can colorize the buttons in the Archive 

Palette to your liking. 

To colorize a button in the Palette, click it in the Palette bar that appears in 

the Preferences dialog box. 
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Copying Button Colors 

The StuffIt Deluxe Menus 

The Apple Color Picker appears, letting you select a color for the button in 

the Archive Palette. 

Please select a color... 

Red 

Green 

You can also copy a color from one button to another without going through 

the color picker. To do this, hold down the Option key until the cursor 

becomes a dropper. Then move the dropper over a button, click, and while 

continuing to hold the Option key, move the dropper to the button you want 

to have that color, and click it. 

o 
This makes the dropper “release” the color it was holding onto the current 

button and completes the color transfer. 

Menus - 

 $ bier £2252 Wiew Label Archive Translate 

E) View 4) archive L] Script 
[<] Label J] Translate ] Window 

Default Settings shown above 

Menus - 

$3 £22: Wiew Label Archive Translate Script Window 

Ee) View Ee Archive CJ) Script 
[] Label ] Translate J] window 

All Menus shown above 

The “Menus” section of the Preferences dialog box lets you turn most of the 

menus within Stufflt Deluxe on or off. You'll notice first that the “File” and 

“Edit” are dimmed and not available for selection. These menus are always 

active in any Macintosh application. 

Two menus, “View” and “Label,” look and work the same as the “View” and 

“Label” menus found in the Finder. The remaining four menus are specific to 

Stufflt Deluxe. Turning them on activates the full range of StuffIt Deluxe’s 
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The Default Stuffing 
Settings 

Compression 

Encryption 

Activating Views 

Show Kind 

Show Label 

Show Date 

Show Expanded 

Show Stuffed 

capabilities. However, you may not require the use of StuffIt Deluxe’s 

translation (the “Translate” menu) or scripting (the “Script” menu) 

capabilities and may want to leave them off. 

You can choose whether you want compression and encryption on or off. 

Default Stuffing Settings - 

E] Compression 

LJ Encryption 

Clicking this check box automatically compresses files when they’re Stuffed. 

Turning this option off lets you Stuff files without compressing them. You 

might want to do this if you want files to be encrypted without being 

compressed. Stufflt Deluxe ships with this option on. 

Clicking this check box automatically encrypts files when Stuffing. When you 

turn this preference on, the “Encrypt With Password” option in the Stuff 

dialog box is always checked so you'll automatically be prompted for a 

password when Stuffing a file. Stufflt Deluxe ships with the “Encryption” 

check box off. 

This section of the Preferences dialog box lets you set the way you want things 

to appear in the Archive window. 

Views - 

><] Show kind 

L] Show label 

Ba Show date 6 ge cep 
E<] Show expanded =: Show sizes in: 
EJ Show stuffed : () kilobytes (K) 
[<] Show saved ¢ (2) bytes 

><] Show archive info in header 

4] Show directory popup without # key 

This option displays the kind of file it is that you’ve archived (such as 

TeachText, MacWrite, or MacDraw). 

This option displays any Finder Label you’ve assigned to the file (such as Hot 

or Cool). 

This option displays the date the file was last modified by an application. 

This option displays the Expanded (UnStuffed) size of the file. 

This option displays the Stuffed size of the file in the archive. 
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Show Saved 

Icon Size 

Show sizes in: 

Show Archive Info In Header 

Show Directory Pop-up 
Without Command Key 

Where To Go From 
Here 

This option displays the percentage of disk space you’ve saved by archiving 

the file. 

Clicking one of the icon radio buttons sets the size of the file icon that 

appears in the Archive window next to every file name within the archive. 

Clicking the first radio button shows archived file sizes in kilobytes format 

(e.g., 2K); clicking the second radio button shows them in bytes format (e.g., 

2000). In kilobytes format, file sizes are rounded correctly to the nearest 

kilobyte. 

This check box displays three things in the header area: the number of items 

in the archive, the archive’s size, and the available space on the disk where 

the archive resides. 

This check box automatically displays a pop-up menu arrow to the right of the 

archive’s directory name whenever you're within a folder within an archive. 

Unchecking it means that you must first press the Command key to display 

the directory pop-up in an archive. 

The next chapter explains how to use the built-in scripting language to 

automate certain tasks. Then, Part Two explains how to use drag and drop, 

Magic Menu, and other tools. If you’re interested in learning something 

specific, turn to the Table of Contents for your topic of interest. 
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Example: Scripting a 
Monthly Archive 

Chapter 6: 
Automating StuffIt 
Scripting refers to writing a series of instructions to do a task for you, such as 

Stuffing specific file types into an archive. Stufflt’s scripting language allows 

you to automate many of Stufflt’s operations. You can create a script in any 

text editor or word processor, provided you save the file in text format. You 

can also use the “Record Script” command to create a script. 

In another part of this User’s Guide, Appendix B, there is a listing of all 

scripting commands, including some not explained in the following tutorials. 

Note: This chapter and Appendix B refer to the scripting language that is 

built into Stufflt Deluxe. Other scripting applications, such as AppleScript 

and Frontier from UserLand, offer more flexibility and sophisticated 

scripting. Stufflt Deluxe comes with some sample scripts for AppleScript and 

Frontier in the Scripting Tools folder inside the StuffIt Deluxe folder. You can 

use these as they are, or use them as a guide for writing your own scripts. 

This example shows how to create a script that automates archiving certain 

files for backup purposes. 

Before we can proceed, you need to have the Script menu available in Stufflt’s 

menu bar. To do this, choose “Preferences” from the Edit menu, click the 

Script check box in the dialog box that appears, and then click OK to activate 

the menu. 
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1. In this example, we’ve organized our hard drive by 

application folders. In them, we place each application 

with all its related files. 

Kind 

Photoshop folder 

Adobe Photoshop™ application program 

folder 

folder 

folder 

folder 

folder 

folder 

folder 

folder 

folder 

folder 

folder 

January Photoshop Proj... O 
(| 3rd Party Software 

we 
O 
— 

Calibration files 

Program files 

Tutorials 

Retrospect 

System Folder 

Teachtext Folder 

Utilities 

Word ee ee ee oe 

Essential 

Essential 

2. Next, we create a project folder within our application 

folder. In our example we use a Photoshop folder called 

“January Photoshop Projects.” 

You can use any application you want. 

3. We’ve also created a folder within our StuffIt Deluxe 

Folder called “1994 Stuffit Archives.” 

folder 

Ww te Stufflt Deluxe Folder folder 

o Stufflt Deluxe™ application program 

cos 1994 Stuffit Archives folder 

(—] Miscellaneous folder 

folder 

folder 

As mentioned, we can create scripts from scratch with a word processor or 

text editor. An easier way is to use “Record Script...” (Command-R) and put 

Stuffit Deluxe into a “watch me” mode where it generates script commands 

for each and every action you do until you tell it to stop recording the script. 
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4. Choose “Record Script...” (Command-R) from the 

Script menu. 

Fxecute Script... 3E 

Record Script... [3h 

Edit Script Menu 

A dialog box appears asking you to name the script. 

& Stuffit Deluxe Folder ¥ 

O 1994 Stuffit Archives 

O Miscellaneous 

Stuffit Geluxe™ 

Save script as: 

Script 

5. Name the script “Photoshop Script” and click “Save.” 

StuffIt Deluxe saves the script to disk and goes into “Record” mode, 

indicated by the blinking tape recorder in the Apple menu. “Record” mode 

stays on until you choose “Stop Recording.” 

6. Choose “New” from the File menu. 

A dialog box appears asking you to name the new archive. 

©) Stuffit Deluxe Folder ¥ 

O 1994 Stuffit Archives 

O Miscellaneous 

Stuffit Geluxe™ 

Create new archive as: 

archive 
(] Create 1.5.1 Archive 

7. Name it “Photoshop Projects.sit” and click “New.” 

StuffIt Deluxe saves the new archive to disk. 

8. Choose “Stuff” from the Archive menu. 

The “Stuff” dialog box appears. 
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9. Go to the Photoshop folder, open it to select the “January 

Photoshop Projects” folder, and add it to the “Items to 

Stuff” list by selecting the folder and clicking “Add.” 

10. When the folder moves to the list on the right, click the 

“Stuff” button. 

©) Photoshop ¥ items to Stuff: 

O 3rd Party Software 

@ Adobe Photoshop™ 
© Calibration files 

() January Photoshop Proj... 

© Program files 

© Tutorials 

dd Match... 

«< Remoue 

[] Delete item when finished C] Encrypt with password 

Staff #s 

StuffIt Deluxe Stuffs the folder into the “Photoshop Projects.sit” archive. 

11. When Stuffit Deluxe is finished, close the archive and 

choose “Stop Recording” (Command-R) from the Script 

menu. 

PHHPELE CE SEEEERE LL. 

Stop Recording _..% 

Edit Script Menu 

Stufflt Deluxe automatically generates a script in Text format named 

“Photoshop Script.” To read the script, open it within a word processor or text 

editor. It should look like this: 

s Stnrirte Deiuxe Scriot —tv3} 

Write Status To 

New Archive "HD 3:StuffIt Deluxe Folder: Photoshop 

Projects.sit" replace 

Use "Photoshop Projects.sit" 

Stuff "HD 2:Photoshop:January Photoshop 

Projects:" compress 

Close "Photoshop Projects.sit" 



Editing a Script 

At this point, you can add the script to Stufflt’s Script menu by choosing the 

“Add Script...” command from the hierarchical “Edit Script Menu.” 

Note: You can add not only scripts written with StuffIt Deluxe’s scripting 

language, but those written in AppleScript and other OSA-compliant 

scripting languages. 

You can also assign this new menu item a Command key equivalent. At a 

stroke, your January Photoshop Projects folder would be automatically 

Stuffed into a “Photoshop Projects.sit” archive every time you executed 

the command. 

Before you add it to your menu, though, you might want to edit it. Think for 

a moment: 

e Do you want to add a new “January Photoshop Projects” folder to your 

“Photoshop Projects.sit” archive every time you execute the script, instead 

of replacing the earlier copy with a new one? By changing a single line in 

the script, you can create an “audit” trail of past versions of your files. 

e Do you want to add only those files which have been modified that week to 

the archive? Later in this chapter, we’ll show you how StuffIt Deluxe’s “Add 

Match” feature lets you select criteria such as “last week,” date 

modification ranges, or other criteria, to back up your files. 

e Do you want to archive just your January Photoshop Projects, or do you want 

to archive the January files for any application on your drive? 

e Do you want to save this archive to a floppy rather than your hard drive? 

We’re going to change the script to back up to a floppy instead of the hard 

drive, and add a “Quit” command to quit Stufflt Deluxe after Stuffing the 

folder. First, let’s examine the script. 

1. Create a floppy disk named “January Photoshop Floppy.” 

2. Open the newly created script in a word processor or text 

editor. 

(1)...; “Stuffit Deiuxe- Script (v3) 

(2) Write Status To 

(3) New Archive "HD 3:StuffIt Deluxe 

Folder:Photoshop Projects.sit" replace 

(4) Use "Photoshop Projects.sit" 

(5) Stuff "HD 2:Photoshop:January Photoshop 

Projects:" compress 

(6) Close "Photoshop Projects.sit" 
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Note: We placed line numbers in front of each script line to make them easy 

to refer to. A real script would not show these numbers. 

This “Photoshop Script” was automatically generated by Stuffit. It’s a typical 

script, with each command beginning a new line and with the argument and 

modifiers following the commands in quotes. 

Line (1) is a header for the script. The semicolon (;) before the line marks it 

as a comment, and the line is not executed. 

Line (2) writes a “status file” to disk once the script has been executed, giving 

it the name of the script plus a “.out” suffix. One status file gets written per 

script. If you add a name to the end of the “Write Status To” line, the “.out” 

file will also have that name. This status file is used to help you debug your 

scripts. If you don’t want a status file, remove line (2). 

Line (8) creates the archive. The long string between quotes is the pathname 

to the archive. We’ll change this line for backup to a floppy. 

3. Replace line (3) of the script with the following line: 

New Archive “January Photoshop Floppy: Photoshop 

Projects.sit” replace 

Now, when the script runs, it creates the archive on the “January Photoshop 

Floppy” disk instead of on the hard drive. 

Since we’re examining the script, let’s continue looking at each line in detail. 

First, be aware that Line (3) does one more thing: every time it creates the 

archive, it writes over any older version of the archive that it finds at the end 

of the drive path by means of the “replace” command at the end of the line. 

Note: If you change “New” to “Open” at the beginning of the line, and remove 

the “replace” command, StuffIt Deluxe opens the “Photoshop Projects.sit” 

archive every time the script runs and Stuffs a new version of the “January 

Photoshop Projects” folder into the archive. In this way, you can create an 

audit trail of your changing projects folder, but the archive could get very big. 

Line (4) isolates the archive to use. The “Use” command is used to make a 

specific archive active when you have multiple archives open. 

We'll leave the next two lines alone. Line (5) Stuffs the Photoshop folder and 

compresses it and line (6) closes the archive. 

4. Add another line after the Close command line, a “Quit” 

command that will quit Stuffit Deluxe after the script is 

run. 

5. Save the changes (making sure it’s still a Text file). 



Executing a Script 

Now the script reads as follows: 

Write Status To 

New Archive "January Photoshop Floppy: Photoshop 

Projects.sit" replace 

Use "Photoshop Projects.sit" 

Stuff "HD 2:Photoshop:January Photoshop 

Projects:" compress 

Close "Photoshop Projects.sit" 

Quit 

How can we be sure that the changes we made work? We'll use the “Execute 

Script...” command to check it. Once we see that it’s OK, we’ll add it to the 

Script menu and give it a command key equivalent so it can be executed with 

a single menu selection or keystroke. 

1. Choose “Execute Script...” (Command-E) from the Script 

menu. 

Record Script... 

Edit Script Menu 

Desktop 

2. Select “Photoshop Script” and click the “Execute” button 

or press “Return” or “Enter” on your keyboard. 

StuffIt Deluxe executes the “Photoshop Script.” It creates a new archive 

on your January Photoshop Floppy and names it “Photoshop Projects.sit.” 

It Stuffs your January Photoshop Projects folder into the archive, closes 

the archive when it’s done Stuffing, and quits StuffIt Deluxe. 
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Adding a Script to Now that we've tested it, let’s add it to the Scripts menu and give it a 

the Menu Command key. 

1. Choose “Add Script...” command from the Edit Script 

Menu pop-up menu. 

Execute Script... 3E 

Record Script... 3R 

Edit Script Menu > Add Script... 

Hesige UE Keys..- 

BEGREERRIGE SEERRES... 

A dialog box appears letting you select the script to add to the menu. 

<=) 1994 Stuffit Archives ¥ 

© Photoshop Script 

2. Select “Photoshop Script” and click the “Add” button or 

press Return. 

The “Photoshop Script” menu command appears at the bottom of the 

Script menu. 

Execute Script... dE 

Record Script... 3h 

Edit Script Menu 

Photoshop Script 

3. Give it a Command key by choosing “Assign Command 

Keys...” from the “Edit Script Menu” pop-up menu. 

Execute Script... #E 

Record Script... 3h 

RUE Add Script... | 
epericevbat sas tnech {need snlabaansssiseesescoy pur soreanhcliahiieihroate Assign SE Keys... NS 

Photoshop Script Remove Scripts... 
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A dialog box appears letting you select the script and assign a Command 

key to it. 

Click on a script and press the key to 

assign to it. 

Photoshop Script 36d ty 

4. Select the “Photoshop Script” and type the Command key 

sequence you want and click OK. 

If the Command key you chose has already been assigned, a dialog box 

appears telling you so. If this is the case, you should select another 

Command key. 

The Command key equivalent is added to the “Photoshop Script” menu 

item. 

Execute Script... 

Record Script... a6 A 

Edit Script Menu 

Photoshop Script #d 

Removing a Script _ There may be a time when you want to remove a script from the Stufflt menu. 

from the Menu Doing so is just as easy as adding a script to the same menu. 

1. Choose “Remove Scripts...” from the Edit Script Menu pop- 

up menu. 

Execute Script... 3#E 

Record Script... 36R 

Edit Script Menu ia Add Script... 
ssosabaseestachapesmetostonseaieibeantienhpeieies Meastintirsstecabedseen Assign 38 Keys... 

Photoshop Script #JRBifuti Scripts...[> 
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A dialog box appears, letting you select the script for removal. 

Select the scripts to remove: 

Photoshop Script 

Cancel 

2. Select the script(s) you want to remove and click the 

“Remove” button or type Return. 

To select more than one script for removal, hold down the “Shift” key as 

you select additional scripts. 

The script(s) are removed from the Script menu. 

Example: Scripting a Now that you know how to create a simple script for everyday backups, how 

: can you create a single, yearly archive for archiving the monthly archives? 

Yearly Ar chive Using Stufflt’s “Add Match” feature in conjunction with “Record Script...” 

you archive all your files across project folders into one yearly archive. 

1. Choose “Record Script...” (Command-R ) from the Script 

menu, and when the Script dialog appears, name the script 

“1994 Yearly Script.” 

2. Choose “New...” from the File menu to create a new 

archive and name it “1994 Yearly Archive.sit.” 

3. Choose “Stuff” from the Archive menu, or click Stuff in the 

Archive palette. 

The “Stuff” dialog box appears, letting you select the files and folders you’d 

like to add to your archive. 

4. Click on the “Desktop” button to choose among the hard 

disks to back up. 
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5. Select the hard drive you want to back up and then click the 

“Add Match...” button in the “Add Match” dialog box. 

The Add Match dialog box appears, letting you select what to add to the 

archive by a number of criteria. 

Add items in “HD 1” matching the following criteria - 

a <eee 
2 i — — 
(] Label 

CI Size 

C1 Date Created s/26/94 [wv] 

C1 Date Modified s/26/94 [w] 

Notice here that by selecting more criteria you narrow the number of files 

matching all your criteria. For purposes of this experiment, the only 

criteria we’re going to use is to select all files that have been modified 

“Last Year.” 

6. Select the left “Date Modified” pop-up menu that reads “is 

on or after” and change it to the “is between” option. 

¥ is on or after 

is on or before 

15 

1s not 

1s betyeen 

1s not between 

The “is between” command activates a third pop-up menu for the “Date 

Modified” options. 
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7. Select the “last year” command in the middle “Date 

Modified” pop-up menu. 

¥ today 

yesterday 

this week 

last week 

this month 

last month 

this year 

last year 

last archive change 

8. Choose “this year” in the right “Date Modified” 

pop-up menu. 

v today 

yesterday 

this week 

last week 

this month 

last month 

this year 

last year 

last archive change 

The “Date Modified” check box is automatically checked, indicating that 

any file modified between 1/1/94 and 1/1/95, will be included in the 

archive. 

El Date Modified[_is between wd 14 194 [w)and 1/1/95 [¥} 

9. Click OK and you'll return to the “Stuff” file dialog box. 
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Notice how “HD 1” has been added to the “Items to Stuff” list, with small 

lines in the icon, indicating that only some of the files in that volume will 

be Stuffed. 

| Desktop 7 items to Stuff: 

HD 1 HD 1 

® trash feskiop 

[ Add >> | 
Add Match... 

] Delete item when finished CL] Encrypt with password 

Stuff _ 3S 

10.Click the “Stuff” button. 

Stufflt Deluxe scans your drive for all files that have been modified last 

year and Stuffs them into the “1994 Yearly Archive” along with the 

folders they’re in. 

11. When Stuffit Deluxe is done adding the folders and files, 

click the close box on the archive. 

12. Choose “Stop Recording...” from the Script menu. 

The 1994 Annual Script looks like the following, minus the numbers which 

we've added for purposes of this example. 

(1) ; StuffIt Deluxe Script (v3) 

(2) Write Status To 

(3) New Archive "HD 3:StuffIt Deluxe Folder:1994 

Yearly Archive.sit" replace 

(4) Use "1994 Yearly Archive.sit" 
(5) Clear Match 

(6) Match Modified 1/1/1994 to 1/1/1995 
(7) Stuff "HD 1:" match compress 

(8) Close 

Line (5) clears the Match command (clearing any previous matches), and 

line (6) Modifies Match by telling StuffIt to only Stuff files that have been 

modified between 1/1/94 and 1/1/95. Line (7) actually Stuffs the files on hard 

drive “HD 1”, matching our criteria, compressing them as they’re Stuffed. 

Line (8) closes the archive. 
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13.Add “Quit” (without brackets) on a (9)th line, and 

Stuffit Deluxe quits after executing the command. 

Remember that this script can be easily modified by changing the dates in 

line (6) to any range you like. That way, if you only want to add the past 

month’s changes to the yearly archive, all you need to is to put the past 

month’s date range in that line and only those files modified within the past 

month are Stuffed into your yearly archive. 

Alternate Method M@ Scripts can be written that use criteria such as “today,” “yesterday,” “this 
week,” and “last week” as well as specific date ranges. Scripts using 

“today” or “yesterday” use the Macintosh’s internal clock to “stamp” the 

date criteria onto the operation. 

Where To Go The built-in scripting language is comprehensive and allows you to script 

almost every Stufflt Deluxe feature. The best way for you to begin scripting is 

From Here just as we have done in this chapter: use the “Record Script...” command and 

edit your new script further to suit your needs. All of the scripting language 

commands and their syntax is covered in detail in Appendix B: Scripting 

Reference. If you’d like to learn how to automate StuffIt Deluxe without the 

scripting language, read on. 

Automating from StuffIt Deluxe not only lets you automate the archiving process from within 

: Stuffit itselfi—you can automate the compression process without using 

Outside Stuffit Stufflt’s scripting language. 

Deluxe CE Software’s QuicKeys 2 (and later), Apple Computer’s MPW, or Claris’ 

HyperCard can be used with the externals we provide to Stuff or UnStuff files 

in those respective products. 

Using the powerful System 7 mechanism of Apple events, Stufflt Deluxe can 

be ‘remote controlled’ by other products that are able to send Apple events to 

Stuffit Deluxe. This is also known as Inter-Application Communications. 

Userland Frontier and AppleScript are other examples of applications that 

provide remote scripting of StuffIt Deluxe. 

Apple events Apple events are messages sent from one application to another. They’re sent 

to request a service (“Please perform this task”), to respond to a request 

(“I’ve done what you asked; here’s the result”) or to send news (“Here’s 

something you might want to know”). Apple events can also contain data, and 

therefore they are also used to move data from one application to another. 

Stuffit Deluxe supports a large number of Apple events, which give you the 

ability to control and automate many of the capabilities of the product. The 
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QuicKeys 2 

most common usage of this is via scripting systems such as AppleScript or 

UserLand Frontier, though some specific application, such as a 

communications software, may also call upon StuffIt to perform some tasks 

for it. 

In order to facilitate your use of StuffIt with scripting systems, StuffIt Deluxe 

includes an ‘aete’ resource which details the full complement of Apple events 

supported. 

In addition to being controlled, StuffIt Deluxe also uses the Finder itself to 

open and launch files when you use the Launch command. StuffIt Deluxe also 

uses Apple events in conjunction with anti-viral software to scan your newly 

UnStuffed files for possible infection. 

If you are a developer, and would like to get more specific information about 

the Apple events that Stufflt supports, contact Aladdin Systems at 408/761- 

6200 or on AppleLink at ALADDIN, or any of its other email addresses. See 

Appendix C for a complete list. 

QuicKeys 2.x or later is a popular macro program from CE Software that can 

record your actions and replay them by typing a keystroke. When you 

purchase QuicKeys 2.x or later, Aladdin’s Stuff and UnStuff extensions are 

automatically installed along with QuicKeys and are ready to be used. With 

QuicKeys and the StuffIt Extensions, you can establish as many Stuff/UnStuff 

macro variations as you want, from backup sets that can be invoked each time 

you startup your Macintosh, to single keystrokes that ask you what files 

to compress. 

This example assumes that QuicKeys 2.x or later is installed on your 

Macintosh. 

1. Begin creating a Stuff QuicKey by opening QuicKeys. 
r 

defile Edit ies Label Special 
About This Macintosh... 

CEToolbox 

QuicKeys 2 > QuicKeys 2... 

This can be done with the QuicKeys hierarchical menu or with a 

preconfigured keystroke (usually Command-Option-Return). 
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2. Choose “Stuff” from the Extensions sub-menu. 

ETD 

Tupediene [al] Alias... 
oe) Buttons... 

*& Click 
i Date/Time ® 
wExtensions 

& File... 
F FKEYs $ 
Fy Menu/DA... 

‘oe, Choosy™ 

[Display 

(* Grab Ease™ 
‘Fi Mousies >| (GLocation 
4% Sequence... Cc Message 
%& Specials >| aiMounty™ 

[Show all ] T Text... E*|Panels 
(Stew a] ae Real Time (+ Paste Ease™ 

Za @ Repeat GQNUICKEYS- Sense ee 
} Sound 
«|| SpeakerChanger 
G Stuff [*s 
FO) System 7 Specials 
@ Type Ease™ 
G UnSstuff 

‘“¥ Wait... 

The Stuff Extension dialog box appears, with the extension “Stuff” already 

named. You can change the name if you want. 

Stuff Extension G 

Name: |Bti Keystroke: 

Stuff QK2 Extension 2.0 by Raymond Lau. 

1990, Aladdin Systems, Inc. and Raymond Lau. All Rights Reserved. 

This extension requires the Stuffit Engine™ file that comes with 

Stuffit Deluxe™ to be properly installed. 

Default Archive: 

i] Prompt User |Select Archive... L] dermriie fxisting 

User will be prompted if no default source items are set. 

Default Source Items... 

Timer Options [] Include in QuicKeys menu 

3. Press Tab to move to the “Keystroke:” field. Type in the 

keystroke you'd like to assign to the “Stuff’ QuicKey. 

4. Select the options you’d like and click OK. 

The Stuff Extension lets you specify two general options: 

e The archive to Stuff into (Select Archive...) 

e The items to be Stuffed (Default Source Items...) 
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With the first option, you can have QuicKeys always prompt you for the 

archive name, or click on the “Select Archive” button to specify the name of 

a new archive that is to be used. The “Overwrite Existing” option makes the 

Stuff Extension replace an old archive with a new one, should it already exist 

on disk. 

The “Default Source Items...” button brings up a dialog box that is similar to 

the Stuff dialog box with the Stufflt Deluxe application. Here, you can set up 

a consistent set of files that you always want archived. If no items are 

specified, QuicKeys 2 asks you for the files each time it is invoked. 

The other options in the dialog box are standard QuicKeys options and are 

described in the QuicKeys User’s and Extensions Guides. 

You can also use QuicKeys to UnStuff files. 

1. To create an UnStuff QuicKey, open QuicKeys and choose 

“UnStuff”’ from the Extensions sub-menu. 

The UnStuff Extension dialog box appears, with the extension “UnStuff” 

already named. You can change the name if you want. 

Unstuff Extension 
SEB U OTS Ein smawepen <5 Pei age 

Name: (|UBRGa Keystroke: 

UnStuff QK2 Extension 2.0 by Raymond Lau. 

© 1990, Aladdin Systems, Inc. and Raymond Lau. All Rights Reserved. 

This extension requires the Stuffit Engine™ file that comes with 

Stuffit Deluke™ to be properly installed. 

Default Source Archive 

<<] Prompt User Select Archive... 

~] Auto Save When UnStuffing 

LJ Include in QuicKeys menu 

2. Press Tab to move to the “Keystroke:” field. Type in the 
keystroke you'd like to assign to the “UnStuff’ QuicKey. 

3. Select the options you'd like and click OK. 

The UnStuff Extension lets you specify whether a designated archive is to 

be UnStuffed (using the “Select Archive...” button) or whether you should 

be prompted each time for the archive to be UnStuffed on disk. You can 

also elect to automatically save your UnStuffed files to disk. 

The other options in the dialog box are standard QuicKeys 2 options and are 

described in the QuicKeys User’s and Extensions Guides. 
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Telecommunications 

Scripts 

MPW Tools 
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Three of the most popular telecommunication products are Aladdin Systems’ 

SITcomm, Software Ventures’ MicroPhone IJ, and FreeSoft’s White Knight. 

We supply scripts that assist you in working with MicroPhone II, and White 

Knight provides support from within the White Knight application. 

Note: If you use SITcomm, you know that it has built-in support for many of 

the functions of StuffIt Deluxe, including the ability to Stuff, UnStuff, and 

translate. SITcomm ships with several ready-made scripts. 

The Macintosh Programming Workshop (MPW) is a development 

environment from Apple Computer for writing software for the Macintosh. 

Like StuffIt Deluxe, it has an open architecture where new modules may be 

added at any time. Since many programmers use StuffIt Deluxe in their daily 

archiving, we now include MPW Tools that can be integrated into any MPW 

script. Users of MPW should move the two Stufflt MPW tools (Stuff and 

UnStuff) into their MPW Tools folder. If you do not use MPW, you should trash 

the “Stufflt MPW Tools” folder since you don’t need them. 

Both MPW tools are commando-compatible, so typing “Stuff...” or 

“UnStuff....” displays a commando dialog box. Within that dialog box, all 

parameters are fully explained and help is available there for further 

information. 



Part Two: 

True Finder 

Integration 





Introduction 

Chapter 7: 
Magic Menu Reference 
An essential part of the Stufflt Deluxe package is Magic Menu. Magic Menu 

appears in the Finder just after the Special menu. With point and click 

simplicity, select any icon in the Finder and select a command from the Magic 

Menu. 

Magic Menu has these main functions: 

eExpand multiple compressed-file formats using the “Expand” command. 

eCreate Stuffit archives (.sit and .sea files) using the Stuff and Make Self 

Extracting commands. 

eCompress files using SpaceSaver. 

eGet information about SpaceSaver-compressed files and folders. 

elf you are using QuickMail or Microsoft Mail, Magic Menu displays mail 

commands. 

Magic Menu is a control panel that’s installed when you install StuffIt Deluxe. 

Just open your Control Panels folder and double-click the Magic Menu icon. 

You can turn Magic Menu on or off from here. 

|Magic Menu™ 
: Copyright © 1990-1994 Aladdin 

-%& Aladdin 
2 &% Systems 

| 165 Westridge Drive ph. 408/761-6200 fF 
| Watsonville, CA 95076 fax 408/761-6206 | 

AOL/AppleLink ALADDIN 
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Expand 

When Magic Menu is on, it appears in the Finder, right next to the Special 

menu. 

@ File Edit View Label Special| {jp | = | 
Expand 3 U 

Stuff 36 § 
Make Self-Extracting 

Preferences... 

SpaceSaver Compress 

SpaceSaver Info... 

Mail... 

Stuff and Mail... 

Mail Preferences... 

About Magic Menu... 

Note: If you are running System 6 on a Macintosh not capable of displaying 

color, the word “Magic” appears in the Finder’s menu bar, instead of the 

Magic Menu icon shown in this User’s Guide. 

The “Expand” command (Command-U) lets you expand files in the Finder. 

This command works not only with SpaceSaver files, StuffIt archives (.sit), 

Compact Pro archives (.cpt) and AppleLink packages (.pkg), but also with 

files with the following extensions: .bin, .zip, .arc, .gz, .Z, .uu, and .hqx. 

The following example shows a “.zip” file translation. 

1. Select the file to expand. 

& 

MeELPr ILE .2cte 

2. Choose “Expand” from Magic Menu. 

Magic Menu expands the file and displays its progress with a dialog box: 

UnZipping 

Items Remaining: 6 

UnZipping ADUFEAT.DOC 

TRS 
© 1990-94 Aladdin Systems, Inc. & Raymond Lau. 
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Stuff 

Make Self-Extracting 

Preferences 

Expansion 

Note: Since the “zipped” file was originally created on a PC, some of the 

resulting “unZipped” files may not work on your Macintosh. 

See Chapter 3: Easy Stuffing and UnStuffing for more instructions on using 

the “Expand” command to expand Stufflt archives. See “The Translate Menu” 

in Chapter 5: Stufflt Deluxe Reference for an explanation of each of the 

suffixes listed in the previous paragraph. See “Preferences” later in this 

chapter for details on customizing the “Expand” command. 

The “Stuff”? command (Command-S) lets you Stuff files and folders without 

using the StuffIt Deluxe application. 

See Chapter 3: Easy Stuffing and UnStuffing for step-by-step instructions on 

using the “Stuff” command. See “Preferences” later in this chapter for details 

on customizing the “Stuff? command. 

The “Make Self-Extracting” command in Magic Menu makes a self-extracting 

archive out of any selected items in the Finder. 

See Chapter 3: Easy Stuffing and UnStuffing for step-by-step instructions on 

using the “Make Self-Extracting” command. See “Preferences” following for 

details on customizing the “Make Self-Extracting” command. 

When you installed the software, some basic Magic Menu preferences were 

preconfigured to make compression and expansion with Magic Menu 

effortless. You can change these preferences to better use the Magic Menu 

commands available to you. 

After choosing “Preferences...,” the Magic Menu Preferences dialog box 

appears. 

[i] Expand Stuffit SpaceSaver Files 

Stuffit SpaceSaver is an on-the-fly, transparent compression product. 

—] Expand Archives 
L] Delete after expanding 

This includes Stuffit (.sit}, Compact Pro (.cpt}, AppleLink (.pkq), 
ZIP (.zip), ARC C.arc), gzip €.gz), and Unix Compress (.2) files. 

—X] Expand Encoded Files 

[] Delete after expanding 

This includes BinHex (.hgx) and UWEncoded (.uu) files. 

—x] Continue to expand (if possible) 

Destination This will further expand the result of an expanded archive or encoded file. 

There are a few preferences that specifically address what happens when you 

expand any type of file from the Magic Menu. 
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Stufflt SpaceSaver Files 

Archives 

Encoded Files 

Delete Check Boxes 

Continue to Expand 

Joining 

Join Segmented Files 

The “StuffIt SpaceSaver files” check box enables Magic Menu to decompress 

files that have been compressed with StuffIt SpaceSaver. You may choose to 

turn this option off if you do not want Magic Menu’s “Expand” command to 

work on SpaceSaver-compressed files. This option is on by default. 

If you have the “Expand Archives” option checked, Magic Menu expands any 

StuffIt archives (and other formats such as .Zip and .Arc) when choosing 

“Expand” from the Magic Menu. You might want to turn this option off if you 

don’t want the “Expand” command to expand StuffIt archives. This option is 

on by default. 

The “Encoded Files” check box does the same as the “StuffIt archives” check 

box, but it expands additional foreign file formats instead, such as BinHex 

and UUEncoded files. The default for this check box is on. 

The Delete check boxes instruct Magic Menu to delete the original 

compressed item just after it’s expanded. This saves you the trouble of 

dragging the original item to the trash after it has been expanded. You are not 

reminded if you have this option on, so use it with caution. Both Delete check 

boxes are off by default. 

It is possible to download a file that has not only been Stuffed, but “binhexed” 

as well, such as foobar.sit.hqx. (Some files have more than two compression 

formats applied to it. This is fairly common on the Internet.) When this option 

is on, which is the default, Magic Menu continues to expand the file from each 

compression method that was applied to it, until you have the original, 

uncompressed file. Expansion is done in the reverse order of the extensions 

that appear after the file name. 

The Joining options in the Preferences dialog box lets you set options for 

segmented files. See Chapter 4 for details on segmented files. 

>] Join Segmented Files 

[] Delete segments after joining 

[4] Expand joined file (if possible) 

This joins files that were segmented with another Stuffit product. 

Watch Folder 

This option is on by default. If you select a segmented file, then choose 

“Expand” from the Magic Menu, this option automatically joins the segments. 
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Delete 

Expand Joined File 

Stuffing 

Delete Originals 

Stuff as Individual Archives 

Encrypt with Password 

This option is off by default. When on, it deletes each segment after it has 

been successfully joined. 

This option is on by default. When all segments have been successfully joined, 

this option expands the file to its original state. 

The Stuffing options in the Preferences dialog box lets you set the 

functionality for the Magic Menu “Stuff” command. All of these options are off 

by default. 

Stuff 

(_] Delete Originals 

[] Stuff as individual archives 

Ps C] Encrypt with password 
. 

Expansion 

Joining 

Make Self-Extracting 

_] Delete Originals 

CL] Stuff as individual archives 

LJ] Encrypt with password 

Destination oy 

Note: Each option described next means the same to a StuffIt archive (.sit) 

and a self-extracting archive (.sea), although you can set the options 

independently of each other. 

Using the “Delete originals” check box makes Magic Menu delete all original 

files after they’re placed into archives. Use this option with caution. 

If you click the “Stuff as individual archives” option, Magic Menu places each 

selected item into its own archive when Stuffing. Otherwise, whatever’s 

selected when you choose “Stuff” is combined into one archive. 

When this option is on, Magic Menu prompts you for a password and 

subsequently encrypts the items within the archive(s) you are creating. 
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Destination 

Expansion Destination 

Stuffing Destination 

SpaceSaver Commands 

SpaceSaver Compress 

The Destination options in the Preferences dialog box lets you set options for 

expanded files. 

@ Expansion Destination 

@ Same as original 

Stuffing Destination 

@ Same as original 

< 

You can have your expanded files placed in their original folder (which is the 

default), have Magic Menu prompt you for a destination, or select one that is 

always used for all expanded files. 

You can have your Stuffed files placed in their original folder (which is the 

default), have Magic Menu prompt you for a destination, or select one that is 

always used for all Stuffed files. 

Note: If you press the Option key as you choose a command from the Magic 

Menu, a dialog box appears letting you set some temporary preferences for 

that one time you use the command. If you press the Control key when you 

choose Expand or Stuff from the Magic Menu, the original item is deleted 

after it has been successfully expanded or Stuffed. 

Magic Menu has two SpaceSaver commands that appear when you have 

Stufflt SpaceSaver installed. 

Expand 36 U 

Stuff 36 § 

Make Self-Extracting 

Preferences... 

BeMisl RSs aes 
SpaceSaver Compress 

SpaceSaver Info... 
nA ee RR 

Mail... 

Stuff and Mail... 

Mail Preferences... 

About Magic Menu... 

The “SpaceSaver Compress” command lets you compress files and folders 

using StuffIt SpaceSaver. 
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SpaceSaver Info 

Mail Commands 

Mail... 

Magic Menu immediately compresses any selected items when you choose 

the “SpaceSaver Compress” command. Depending on the size of the file, you 

may or may not see the cursor change to the SpaceSaver status indicator to 

indicate SpaceSaver is busy. 

When SpaceSaver is finished, the file it compressed does not look any 

different. It does not have a new icon or any extension after its name. 

However, it now takes up less room on your hard drive. 

See the SpaceSaver manual for more details on the SpaceSaver Compress 

command. 

The “SpaceSaver Info” command displays details about a compressed item. 

When you choose “SpaceSaver Info,” the following dialog box appears which 

shows information about the compressed and original size of the selected file: 

ae Apple Extras 

Kind : Folder (36 Iterns ,-25 compressed) 

Expanded: 1,247,240 bytes (1,218K) 
Compressed: 646,255 bytes (631K) 

Saved: 600,985 bytes (49% saved) 

Where: PowerPC Mac: 

Created: Sun, Jun 19, 1994, 22:53 

Modified: Wed, Jul 27, 1994, 13:42 

Magic Menu gives you the ability to issue mail commands in the Finder using 

two electronic mail programs: Microsoft Mail and QuickMail. 

The “Mail...” command lets you mail a single file to another user without 

having to use the application or desk accessory that came with your E-mail 

system. If you are not logged onto a mail server, the “Mail...” command is not 

available. 
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Stuff and Mail... 

1. To mail a file to another user from the Finder, select 

a single file and then choose “Mail...” from Magic Menu. 

Pi 
Expand a6 U 

Stuff and Mail... % 
Mail Preferences... 

Magic Menu automatically encloses the file in a QuickMail or Microsoft 

Mail document and presents you with a list of users. 

2. Select the user(s) you want to send the file to. 

Consult your QuickMail or Microsoft Mail User’s Guide for how to do this. 

3. Type a message to be sent with the file enclosure and 

click “Send.” 

The file is enclosed and is sent to the user(s) you selected. 

The “Stuff and Mail...” command lets you Stuff one or more files and folders 

and mail them as an archive to another user in one operation. 

1. To Stuff and send items to another user, select the files 

from the Finder. 

2. Choose “Stuff and Mail...” from the Magic Menu. 

Ptr 
Expand a6 U 

Miail... FE bd 

stuff and Mall... % 
Miail Preferences... 

If you have selected one item, Magic Menu performs a Stuff on the 

selection and saves it to disk with “.sit” added to the end of its name. If you 

have selected multiple items, the archive is automatically named 

“Archive.sit.” 
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3. Name the archive you’re about to send and click “Save.” 

A progress dialog box appears as Magic Menu Stuffs the selections. 

When it’s finished Stuffing, your E-mail memo window appears so you can 

address the archive to the recipient(s) and add a comment. 

4. Select the user(s) you want to send the file to. 

Consult your QuickMail or Microsoft Mail User’s Guide for how to do this. 

5. Type a message to be sent with the archive enclosure and 

click “Send.” 

The archive is enclosed and the message is sent to the user(s) 

you selected. 

Mail Preferences... The “Mail Preferences...” command lets you set options for the “Mail...” and 

“Stuff and Mail...” commands as well as establishing which mail system to 

use. 

1. Choose “Mail Preferences...” from the Magic Menu. 

my 
Expand a6 U 

Miail... 

Stuff and Mail... 

: (] Delete originals after mailing | | () Use Microsoft Mail 
[_] Stuff multiple items and folders : C) Use QuickMail 

i Delete archive after mailing @) Ask for mail system 

[_] Ask for archive name D2 

Cc] Delete originals after mailing | 

i [_] Delete archive after mailing i Cancel 

[_] Ask for archive name 

2. Set the Mail preferences you want to use and click OK. 

Mail The “Mail” section of the “Mail Extension Preferences” dialog box lets you set 

options for selecting files in the Finder and mailing them via Magic Menu. 
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Delete Originals After Mailing 

Stuff Multiple Items 
and Folders 

Delete Archive After Mailing 

Ask for Archive Name 

Stuff and Mail 

Delete Originals After Mailing 

Delete Archive After Mailing 

Ask for Archive Name 

Mail System 

Use Microsoft Mail 

Use QuickMail 

Ask for Mail System 

Checking the “Delete originals after mailing” check box automatically 

deletes the original copy of the file after it is confirmed to be mailed. 

Checking the “Stuff multiple items and folders” check box lets you Stuff 

multiple items and folders at once. Once this option is selected, two other 

options become available to you. 

Checking the “Delete archive after mailing” check box automatically deletes 

the local copy of the archive after you’ve mailed it. 

Checking the “Ask for archive name” check box automatically brings up a 

standard Save dialog box letting you rename the archive to be mailed. When 

this option is not checked, multiple selected items are automatically Stuffed 

with the default name “Archive.sit” before they’re mailed. 

The “Stuff and Mail” section of the “Mail Extension Preferences” dialog box 

lets you set your options for selecting files in the Finder, and Stuffing and 

mailing them via Magic Menu. 

If the “Delete originals after mailing” check box is checked, Magic Menu 

automatically deletes the original copy of the file selected in the Finder after 

it is confirmed to be mailed. 

Checking the “Delete archive after mailing” check box automatically deletes 

the local copy of the archive after you’ve mailed it. 

Checking the “Ask for archive name” check box automatically brings up a 

dialog box to name the archive before it is Stuffed and sent. When this check 

box is not checked, Magic Menu uses the default “Archive.sit” name for the 

archive when Stuffing and sending. 

The “Mail System” portion of the preferences let you establish the default 

E-Mail software to use. If you are only using one mail system, Magic Menu 

uses the one you have installed. (This is not true if you are using AppleMail 

with PowerTalk. ) 

If the “Use Microsoft Mail” radio button is on, Magic Menu chooses Microsoft 

Mail as the default mail system to be used when sending files or archives 

using Magic Menu. 

Selecting the “Use QuickMail” radio button chooses CE Software’s QuickMail 

as the default mail system to be used when sending files or archives using 

Magic Menu. 

If both systems are available on your Macintosh, selecting the “Ask for mail 

system” radio button automatically prompts you for the E-mail system to use 

when sending files and archives using Magic Menu. 
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About Magic Menu ae “About Magic Menu...” displays a dialog box that provides version 

information and credits for Magic Menu. 

When you choose “About Magic Menu...”, a dialog box appears, showing the 

authors, your name, version number, and address and phone number of 

Aladdin Systems. 

Where To Go The next chapter describes the drag and drop applications included with 

StuffIt Deluxe. 
From Here 

Chapter 7: Magic Menu Reference 97 



98 Chapter 7: Magic Menu Reference 

eee 



Introduction 

Using DropStuif 

Chapter 8: 
Drag and Drop 
Applications 

StuffIt Deluxe comes with several applications that provide alternate means 

for Stuffing, compressing, and expanding files and folders. You can pick and 

choose among these tools, depending upon your style of work. Though these 

shortcuts don’t provide you with the same features you get with the Stuffit 

Deluxe application itself, they sometimes offer quicker ways of getting things 

done. These shortcuts, called “Drop Boxes,” are DropStuff, DropCompress, 

DropConvert, and Stufflt Expander. 

Drop Boxes are used with System 7 only. A Drop Box is a small application 

that is able to perform tasks by “dragging and dropping” items onto them. 

Since only System 7 supports “drag and drop” features, Drop Boxes cannot 

work for System 6 users. 

See Appendix A for more information on how drag and drop is implemented 

in different versions of Macintosh system software. 

A quick way to Stuff a file or folder is to drag it onto the DropStuff icon. 

DropStuff is very easy to use. You can use it within the Drag and Drop 

Applications folder, or you can use the alias of DropStuff that the Stuffit 

Deluxe installation program placed on your Desktop. 

e From the Finder, select the file(s) or folder(s) you want to 

Stuff and drag them on top of the DropStuff icon on the 

desktop. When the DropStuff icon is highlighted, release 

the mouse button. 
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Folder File 

Dropstutt™ 

DropStuff Stuffs the file(s) in the same folder (or on the Desktop) as the 

original, leaving a copy of the original UnStuffed file. 

DropStuff Preferences You can configure DropStuff using the Preferences command from its File 
menu. 

1. Double-click the DropStuff icon or alias. 

2. Choose Preferences from the File menu. 

The Preferences dialog box appears, with the Stuffing options appearing 

first by default. 

[] Delete originals after stuffing 

This deletes your original files after they have been Stuffed. 

] Stuff originals instead of aliases 

If you try to Stuff an alias, this Stuffs the original instead. 

] Stuff each item as an individual archive 
BinHexing Multiple items are each Stuffed into their own archive, rather than 

being Stuffed into one single archive containing all the items. 

L] Make self-extracting archive 
This creates a self-extracting archive which anyone can UnStuff 

without a Stuffit product. 

EI Encrypt archive with password 

‘You can protect archives with a password that you specify. 

Destination 

3. Click the options you want, and click OK. 

The only default setting is to Stuff original files, rather than the alias to 

each file. The other settings let you choose other options, each of which is 

explained in detail in Chapter 5: StuffIt Deluxe Reference. 

BinHexing Preferences These check boxes set the options for preparing files for the Internet. 

1. Choose Preferences from the File menu. 

The Preferences dialog box appears, with the Stuffing options appearing 

first by default. 

2. Click BinHexing. 
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Encode files... 

Delete archive... 

Include linefeeds... 

Remove “sit”... 

Destination Preferences 

(] Encode archive into BinHex format 

[] Delete archive after BinHexing 
This deletes the archive after it has been encoded into BinHex format. 

Cc Include linefeeds in BinHexed file 

This converts your BinHex file into a format suitable for posting 

to Unix systems. 

[] Remove “.sit” from file name 

Destination This removes the Stuffit “ sit” suffix from the BinHex file name. 

This encodes your Stuffit archive into BinHex (.hqx) format suitable 

for posting on the Internet. 

3. Click the options you want, and click OK. 

If this check box is marked, every file that you subsequently Stuff with 

DropStuff is automatically prepared for transmission over networks, such as 

the Internet, that only support characters which can be typed from the 

keyboard (ASCII format). A file Stuffed in this way has two extensions after 

the name: .sit and .hqx. 

This check box, when marked, deletes the archive after it has been prepared 

with BinHex formatting. 

This check box, when marked, includes linefeeds in the final BinHexed file. 

In some UNIX environments, a BinHexed file might not be usable unless 

linefeeds are included with the normal carriage returns. 

This check box, when marked, simply removes the “.sit” extension from the 

BinHexed file, so only the “.hqx” extension appears. 

These options set the destination for Stuffed files. This gives you a way of 

knowing exactly where all your Stuffed files are kept. 

1. Choose Preferences from the File menu. 

The Preferences dialog box appears, with the Stuffing options appearing 

first by default. 

2. Click Destination. 
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Destination 

@ Same as Original 

Choose the destination for newly Stuffed files. ‘You can Stuff to 

the same folder as the original, have DropStuff ask you each 
time, or have DropStuff always Stuff to a selected folder. 

3. Click the options you want, and click OK. 

The default destination is in the same folder as the original file. However, 

you can set the option to have DropStuff always ask you where to place a 

file, or you can set a permanent folder. 

Note: If you press the Option key when you drag and drop an item onto 

DropStuff, a dialog box appears letting you set some temporary preferences 

for that one time. If you press the Control key as you drag and drop an item 

onto DropStuff, the original item is deleted after it has been successfully 

Stuffed. 

Using DropCompress A quick way to SpaceSaver-compress a file or folder is to drag it onto the 

DropCompress icon. DropCompress is very easy to use. You can use it within 

the Drag and Drop Applications folder, or you can use the alias of 

DropCompress that the StuffIt Deluxe installation program placed on your 

Desktop. 

e From the Finder, select the file(s) you want to compress 

and drag it on top of the DropCompress icon on the 

desktop. When the DropCompress icon highlights, release 

the mouse button. 

102 Chapter 8: Drag and Drop Applications 



Converting with 
DropConvert 

System 7 Only 

System 6 or Batch Mode 

DropCompress compresses the file(s) in place. You can then choose the 

“SpaceSaver Info” command from the Magic Menu to see how much 

compression was achieved. 

= nas 
AD. .....c.<sccuctlidasennis ; 
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DropConvert is an application which aids in converting your older Stuffit 

archives, as well as other types of archives into the 3.x StuffIt format in order 

to squeeze even more space out of archives. 

Note: DropConvert works on the same types of file formats as Stufflt 

Expander, but the end result is an archive or a self-extracting archive. For 

example, if you drop a file such as Foobar. cpt .hgx onto DropConvert, you 

will end up with a 3.x Stufflt archive named Foobar. sit. 

If you are running System 7, you can drag individual archives or entire folders 

or disks onto the DropConvert icon. DropConvert launches and proceeds to 

expand the contents of the original archive. Once expanded, the original 

archive is deleted, and a new archive with the same name is created and the 

expanded contents are Stuffed into the new StuffIt archive. This happens for 

all items that are dragged onto DropConvert. 

If you are using System 6, or want to convert things manually, you’ll want to 

use the “batch” mode of DropConvert. 

1. From the Finder, double-click DropConvert. 

2. Choose “Convert” from the File menu. 
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The following dialog box appears. 

<— Bit-by-Bit v items to Convert: 

(Adobe Photoshop™ 2.5 Gi) MRssTigecan 
cal (“) Aldus Digital Darkroom}! 

(7 Apple Extras 
(7 Darkside Plus 
@ Disinfectant 
(7 FrameMaker 
£1 GIF Converter 

(1)! Love Boston Guide 

(7 Internet stuff Be 
(7 NCSAMosaicMac Ty 

Cancel &. Cariperi AE 

3. Select a file, folder, or disk and click “Add.” 

After clicking “Add” you'll still find yourself in the dialog box, allowing you 

to add other items to the DropConvert “batch list.” If you have more items 

to add to the list, repeat this step. 

If you accidentally added something you didn’t want to add, you can select 

the item(s) and click the “Remove” button to remove the item(s) from 

the list. 

4. Click “Convert” to exit from the dialog box. 

The progress of the conversion process appears. 

Once all the conversions have taken place, DropConvert is ready to 

perform more conversions, or you may use “Quit” in the File menu. 

Stuffit Exp ander Stuffit Expander gives you the ability to perform expansion of many formats 
(including many that appear in the Translate menu in StuffIt Deluxe) without 

having to run StuffIt Deluxe to do so. If you have a Power Macintosh, you can 

expand these formats at accelerated speed. 

1. Select the file to expand and drag its icon onto the Stuffit 

Expander icon. 
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Preferences 

Expansion Preferences 

The following illustration shows all the various file formats that StuffIt 

Expander can translate: 

hb 7. ororts = & ial, 
ocR 

Sh ool 

Archive.sit Archive.cpt  File.hqx File.bin i 

(Stuffit) (Compact Pro) (BinHex) (MacBinary) : 

| 
i Archive .zip Archive. are AppleLink .pkg ; 

i (ZIP archives (ARC archives (AppleLink packages) | 
from PCs) from PCs) 

cs Cs is 

i File .gz File.2 File .uu 

(GZIP files from (Unix Compress (UWencoded files: 
i Unix systems) Files) from Unix systems) : 

Stufflt Expander expands the selected file into its original state. 

Stufflt Expander is a freeware product, which means that you may give it 

away to anyone you please, as long as you don’t charge for it or distribute it 

with a commercial product. It is the only part of the Stuffit Deluxe package 

that you may freely copy and give away. 

The following sections explain how to configure StuffIt Expander using its 

Preferences command. 

1. Double-click the Stuffit Expander icon in the Finder. 

2. Choose Preferences from the Stuffit Expander File menu. 

The Preferences dialog box appears, with the Expansion options appearing 

first by default. 

f] Expand Stuffit SpaceSaver Files 

Stuffit SpaceSaver is an on-the-fly , transparent compression product. 

x] Expand Archives 

[] Delete after expanding 

This includes Stuffit (.sit), Compact Pro (.cpt), AppleLink (.pkq), 
ZIP (.zip), ARC C.are), gzip €.gz), and Unix Compress (.2) files. 

] Expand Encoded Files 

[] Delete after expanding 

This includes BinHex (.hqx) and UUEncoded (.uu) files. 

{] Continue to expand (if possible) 
This will further expand the result of an expanded archive or encoded file. 

2. Click the options you want. 

Each expansion option determines the types of files that Stufflt Expander 

expands automatically. You also have the option to delete the compressed 

file after it is expanded with files that have the following extensions: .sit, 
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Joining Preferences 

Destination Preferences 

.cpt, .pkg, .zip, .arc, .gz, .Z, .hqx, .bin, and .uu. All expansion options are on 

by default. All deletion options are off by default. 

It is possible to download a file that has not only been Stuffed, but 

“pinhexed” as well, such as foobar.sit.hqx. (Some files have more than two 

compression formats applied to it. This is fairly common on the Internet. ) 

When the “Continue to expand” option is on, which is the default, Stuffit 

Expander continues to expand the file until you have the original, 

uncompressed file. Expansion is done in the reverse order of the 

extensions that appear after the file name. 

Joining is a StuffIt Deluxe process that puts together StuffIt archives that 

have been segmented because the archive was too large to fit on the 

destination media as one archive. Files that have been archived into multiple 

segments have a number appearing after the extension to show which 

segment it is. For example, Foobar.sit, Foobar.sit.2, Foobar.sit.3, and so on. 

1. Choose Preferences from the StuffIt Expander File menu. 

The Preferences dialog box appears, with the Expansion options 

appearing first by default. 

2. Click Joining. 

>] Join Segmented Files 

] Delete segments after joining 

>] Expand joined file (if possible) 

This will join together files that were segmented with another 

Stuffit product. 

Destination 

Watch Folder | 

3. Click the options you want. 

The Join and Expand options are on by default. The Delete segments after 

joining option is off by default. 

These options set the destination for expanded files. This gives you a way of 

knowing exactly where all your expanded files are kept. 

1. Choose Preferences from the File menu. 

The Preferences dialog box appears, with the Expansion options 

appearing first by default. 
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2. Click Destination. 

Destination 

@) Same as original 

Choose the destination of newly expanded files. ‘You can elect to expand 

to the same folder as the original, have Stufflt Expander ask you each 

time, or have Stufflt Expander always expand to a selected folder. 

Watch Folder 

3. Click the options you want. 

The default destination is in the same folder as the original compressed 

file. However, you can set the option to have Stuffit Expander always ask 

you where to place a file, or you can set a permanent folder. 

Watch Folder StuffIt Expander can be configured to “watch” a folder at intervals you specify 

for files that need expanding. To set up a watch folder, do the following steps. 

1. Choose Preferences from the File menu. 

The Preferences dialog box appears. 

2. Click “Watch Folder.” 

is [_] Check for files to expand in 

Expansion 

then 

@ Wait minutes and check again 

© Quit 

“Watch Folder ” will scan the contents of the folder you have selected for 

compressed or encoded files. If any are found, they will be expanded. 

Stuffit Expander will then either wait and check again or quit. 

“watch Folder ” allows you to expand groups of files in the background 
while other files are being downloaded. 

3. Click the “Check for files to expand in...” check box. 
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A dialog box appears. 

Select the folder to watch: 

&) Macintosh HD ¥ < Macintosh HD 

{_|)Cool stuff 

f— Games Folder 

(7 Miscellaneous as 

(£7 Original MS mail HAE 
(7 Personal 

ff" screen shots 

Eiect 

("7 SpaceSaver Dox 
(7 SD Book Folder | 

4251K free on this disk. 

Select “Cool stuff” 

4. Choose the folder you want to use, and click the large 

button at the bottom of the dialog box. 

5. Click one of the radio buttons: 

Wait x minutes and check again: Type the number of minutes you want 

StuffIt Expander to wait between scans. 

Quit: If you want Stuffit Expander to quit after it scans the specified 

folder, click this button. 

Note: If you press the Option key when you drag and drop an item onto Stuffit 

Expander, a dialog box appears letting you set some temporary preferences 

for that one time. If you press the Control key as you drag and drop an item 

onto Stufflt Expander, the original item is deleted after it has been 

successfully expanded. 

Where To Go From The next chapter describes other useful extensions that come with Stufflt 

H Deluxe. These extensions increase the functionality of Stufflt Deluxe, and 

ere allow you the use of StuffIt technology in other applications. 
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Introduction 

Using the Viewers 

Chapter 9: 
Other Stuffit Tools 

Stufflt Deluxe comes with other tools that give you added functionality and 

flexibility. This chapter describes these tools, which include the viewers 

extensions, StuffIt XTND, and StuffIt XCMD. 

The Text and PICT Viewers let you display Text and PICT documents before 

you UnStuff them. Stufflt Deluxe indicates that a viewer is available for a 

particular document by activating the View button in the Archive Palette 

when the document is selected. Choosing “View” from the Archive menu, 

clicking the View button, or dragging the document onto it, opens the 

document for viewing. 

Stufflt XTND is a file conversion mechanism developed by Claris Corporation. 

The StufflT XTND allows other software developers to be able to determine 

the contents of a Stufflt archive from within their application. 

Stufflt XCMD is a set of external modules also developed by Claris 

Corporation for use with HyperCard. You can use the Stufflt XCMD with other 

applications that support its use so the applications have some of StuffIt 

Deluxe’s capabilities added to them. 

This section explains the two viewers that come with StuffIt Deluxe—Text 

and PICT—and how to use each one. 

1. Open the Sample archive.sit in the Tutorial Files folder 

inside the StuffIt Deluxe folder. 

If you’re using Stufflt Deluxe and have maintained its default Preference 

setting for “View ‘Read Me’ files on Open,” a progress dialog appears when 

you open the archive telling you that StuffIt is automatically preparing the 
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“Read Me” file for viewing. When the file is ready for viewing, it opens in 

the Text Viewer window. 

View of Read Me 

File Edit Find Font Size 

This archive, "Sample Archive.sit,” is used in several of the examples in the Stuffit Del uxel4? 
User's Guide. It contains a PICT file and the document you are reading now, “Read Me.” 

This is a@ good example of how you would use qa “Read Me" document within Stufflt Deluxe. When 
you opened the “Sample Archive. sit,” Stufflt Deluxe qutomatically opened this text file for 
you to view. In this example, we've used it to describe the contents of the archive. 

Notice the menu bar at the top of this window. It gives you the ability to print this 
document, or even to change the fonts. 

You can easily create your own “Read Me" files with any word processor or text editor. Just 
save the file as a text file with the phrase “Read Me” appearing at the beginning or end of 
the file name. Then add the “Read Me” file to the archive you want it to belong to. 

The Text Viewer window presents the Read Me file, displayed in a window 

with its own menu bar. You can copy text from it and paste it into a word 

processing document or change the font or font size while viewing it 

(though changes apply to the whole document, not just selected text). 

Since it’s a read-only window, you can’t make any changes to the 

document, but you can print it. If you UnStuff the file, you may modify it 

further in your word processor. 

Note: For “Read Me” files to automatically open, the phrase “Read Me” must 

appear at the beginning or end of the document name. A “Read Me” file must 

be in the top level of the archive. For more information on this preference, 

see Chapter 5: StuffIt Deluxe Reference. 

The PICT files in the archive can be previewed by the PICT Viewer in a 

similar way. 

2. Close the Text Viewer. 

3. Select the PICT file to view and either click the “View” icon 

in the Archive palette or drag the file onto it. 

A progress dialog box appears, telling you that the PICT file is being 

prepared for viewing. In a few seconds, the PICT Viewer displays the file 

on the screen. 
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== view of Lighthouse =z 

The PICT Viewer is similar to the Text Viewer, with its own menu bar. 

You can select portions of the image and copy it (using the menu bar 

within the PICT Viewer window) to the Clipboard and paste it elsewhere. 

You can also print the picture. 

Note: A PICT document can also be a “Read Me” if it meets the “Read Me” 

naming criteria. 

Text Viewer File menu The File menu contains the commands for saving and printing the contents 

of the Text Viewer window. 

About Text Viewer... 

About Text Viewer... The “About Text Viewer...” command displays a dialog box with the Text 

Viewer’s version and copyright information. 

Save As... The “Save As...” command (Command-S) allows you to save a copy of the file 

outside the archive. When you choose “Save As...,” a standard Save dialog box 

appears. You can select the location where you want to save the file and 

rename it if you like. 

Page Setup... The “Page Setup...” command lets you choose your printing options. When 

you choose “Page Setup...,” the standard Page Setup dialog box appears. 

Chapter 9: Other StuffIt Tools 111 



Print... 

Close 

Text Viewer Edit Menu 

Copy 

Select All 

Text Viewer Find Menu 

Find... 
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The “Print...” command (Command-P) allows you to print the contents of the 

viewer window. When you choose “Print...,” a print dialog box appears. The 

selected printer determines which print dialog box appears. 

The “Close” command (Command-W) closes the Text Viewer window. 

The Edit menu contains the standard editing commands. Since this is a read- 

only document, you can’t edit the text, so the “Undo,” “Cut,” and “Paste” 

commands are not available. You can select any or all of the text for copying. 

SP ESST ES: 

gah Ege 

Select All d6A 

The “Copy” command (Command-C) lets you copy information from the Text 

Viewer window and paste it into any text editor or word processor for editing. 

The “Select All” command (Command-A) lets you select all of the text in the 

Text Viewer window. 

The Find menu lets you search for a text string in the Text Viewer window. 

Find... a6 F 

Find Next #6 

The “Find...” command (Command-F) lets you enter some text to search for. 

When you choose “Find...,” a “Find what:” dialog box appears so you can 

enter a text string. 

Find what: 

rush 

[] Whole word ] Case sensitive 

] Wrap around 

Enter the word or words you are searching for in the text box. You can also 

make your search more specific by clicking one or all of the check boxes in 

the dialog box. 



Whole Word 

Case Sensitive 

Wrap Around 

Find Next 

Text Viewer Font Menu 

Text Viewer Size Menu 

Other... 

Tab Width... 

PICT Viewer File Menu 

Clicking the “Whole word” check box ensures that only whole instances of the 

word are found. For example, clicking “Whole Word” causes the viewer to 

locate “rush” and ignore “rushing,” if the search text were “rush.” 

Clicking the “Case Sensitive” check box makes the viewer discriminate 

between upper and lowercase as it searches. For example, clicking “Case 

Sensitive” causes the viewer to locate “rush” and ignore “Rush,” if your search 

text were “rush.” 

Clicking the “Wrap Around” check box ensures a complete search. This 

means that a search begun in the middle of a document wraps back to the 

beginning and continues through the document before it finishes scanning. 

The “Find Next” command (Command-G) causes the viewer to search for the 

next occurrence of the current search string. 

The Font menu lets you change the font that the text appears in for the 

document you're viewing. Selecting a different font from the menu changes 

the view of all of the text in the window. This change is not saved when you 

close the viewer and exit the file. 

The Size menu lets you change the size of the type for the entire window. 

Choosing this command brings up a dialog box to select a type size that is not 

available on the menu. 

To change the type size for viewing or printing, type in the size that you want 

and click OK. 

Choosing “Tab Width...” brings up a dialog box that changes the number of 

spaces per tab. 

Tab Width 

To change a tab width for viewing or printing, type in the number of spaces 

for the tab width you want and click OK. 

The File menu contains the commands for saving and printing the contents 

of the PICT Viewer window. 
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About PICT Viewer... 

About PICT Viewer... The “About PICT Viewer...” command displays a dialog box with the PICT 

Viewer’s version and copyright information. 

Save As... The “Save As...” command (Command-S) allows you to save a copy of the file 

outside the archive. When you choose “Save As...,” a Save dialog box appears. 

You can select the folder where you want to save the file and rename it. 

Page Setup... The “Page Setup...” command lets you choose your printing options. When 

you choose “Page Setup...,” the standard Page Setup dialog box appears. 

Print... The “Print...” command (Command-P) allows you to print the contents of the 

PICT Viewer window. When you choose “Print...” from the viewer’s File 

menu, a print dialog box appears. 

Close The “Close” command (Command-W) closes the PICT Viewer window. 

PICT Viewer Edit Menu The Edit Menu in the PICT Viewer window lets you select and copy the 

document to the Clipboard. Since this is a read-only document, you can’t edit 

the picture, so the “Undo,” “Cut,” and “Paste” commands are not available. 

You can select the picture for copying 

iS ESTETS: 

Select All #A 

Select All The “Select All” command (Command-A) creates a selection marquee around 

the outer borders of the document. 

Copy The “Copy” command (Command-C) places the image of a selection to the 

Clipboard. This image can then be pasted into the Scrapbook or into any 

graphics program that supports PICT. 
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Stuffit XTND Claris Corporation has devised file conversion mechanisms for its software 

called XTNDs. Today, using the XTND technology, users of Claris’s MacWrite 

Pro or other programs can simply choose “Open...” to access files created on 

IBM-PCs or by other programs. Using the StuffIt XTND, products compatible 

with it can quickly determine the contents of an archive. 

This section explains the functionality of Stufflt XTND. We use On Location 

2.x or greater, from On Technology, as an example application. Many other 

applications, such as ClarisWorks support the Stufflt XTND. 

Note: The Stufflt XTND only finds the names of files within archives and not 

the text within the Stuffed items. 

1. Open the “On Location” Desk Accessory from the Apple 

menu. 

The On Location Desk Accessory menu and window appears. 

2. Choose “Create Index...” from the On Location menu. 

On Location 

Create Index... s 

Index Utilities... 

iigigs File 

fiieis Preuinus File BZ 

ifi@ais N@Hi File 

Boer Fas 

Prigt fies 

Page Setup... 

Prim? He List 

A Create Index dialog box opens. 

3. Select the disk you have Stuffit archives on and click the 

“Custom...” button. 

Create Index 

Disk to Index: 

Hard Disk 

| 
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4. In the “Create Custom Index...” dialog box, click the 

“Specify File Kinds...” dialog box. 

We need to do this since StuffIt archives are not normally indexed with 

On Location. 

5. In the “Specify File Kinds” dialog box, scroll down the 

“Don’t Index...” list (on the right) until you see the three 

Stuffit listings. Double-click each one to add them to the 

“Index these files” list on the left. 

Specify File Kinds 

Don't index these files: 

¥ RIFF image file x StrataVision extension < 

¥ RTF file HH x StrataVision shape HE 
He x Strata¥ision texture 

x Studio 32 document 

x Studio 6 document 

¥ TeachText r/o document x 

¥ Text file % Stuffit Deluxe archive M 
/ THINK C text file x Stuffit file 

FEE x SUM partition 

ae x SUM signature 
x SUM volume params 

: x Super 3D animation 
¥ WingZ script Super 3D document 

Note: From now on, every index you create from scratch, on any disk, will 

index the file names within Stufflt archives. 

6. Click OK to close the dialog box. 

You'll find yourself back in the “Create Custom Index...” dialog box. 

7. Click “Create” to create a new index. 

If you have already indexed that disk in the past, a dialog box appears 

asking if you want to replace the existing index. You must create a new 

index from scratch in order to use the Stufflt XTND. 

Searching Archives Once an index is created on one or more disks, you'll want to locate the file 
names of items within StuffIt archives. This is easily done. 

1. Open the “On Location” Desk Accessory from the Apple 

menu, if it is not already open. 

2. Click the “Text in File” radio button and type any portion 

of the name of the file you want On Location to look for 

inside of StuffIt archives. 
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Stuffit XCMD 

In this example, we’re looking for a letter written to Paul Cannon, but 

we're not sure when it was written or what archive it’s in. 

On Location™ 

© Filename i ORIN 

Hard Disk Ay Zach 2 
@ Text in File Matches rootof w 

Paul Cannon 

Name Size Kind Last Modified Path is. | 

B] April 1992 Letters. sit 83K Stuffit Deluxe ar... 6/19/92 12:09PM Hard Disk :-Foh <P 

[1 Fie Fond ___ OL Ea 

On Location displays “April 1992 Letters.sit” in the window as an archive 

that contains a file whose name contains “Paul Cannon.” 

3. Double-click the file name shown in the On Location list. 

On Location opens a window containing a view of the archive contents. 

Now that you know which archive has the document you need, you can exit 

On Location and UnStuff the archive. 

HyperCard, from Apple Computer, has its own type of external modules called 

XCMDs. These externals are also supported by a few other applications such 

as SuperCard and MicroPhone II. We have included XCMDs with Stuffit 

Deluxe so that these applications (and others that support XCMDs) can have 

compression abilities added to them. 

We supply you with two separate XCMDs: Stuff and UnStuff. These XCMDs 

allow you to both create StuffIt Deluxe archives and UnStuff any Stuffit 

archive. 

We supply the HyperCard XCMDs inside a HyperCard stack called “Stuffit 

XCMDs.” It’s a fully-working stack that you can use to find out more about our 

XCMDs and test them as well. 

To place the Stuff and UnStuff XCMDs in your own stacks, you need to use a 

resource copier such as ResCopy or ResEdit. Once these XCMDs are in your 

own stack, they’re part of the HyperTalk language and can be accessed like 

any other command. If using HyperCard 2.0 and later, you can also use the 

“using "StuffIt XCMDs"”command in a stack to take advantage of 

these XCMDs without resource copying. 

The Stuff XCMD has the following syntax: 
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Stuff archiveName, fileList [delete] 

archiveName is a full pathname (including path and filename) for the new 

archive you want created. fileList is a container of carriage-return (<CR>) 

delimited list of files and folders to be archived. You can also optionally use 

the delete parameter to delete the original items after they are Stuffed into 

an archive. 

The UnStuff XCMD has the following syntax: 

UnStuff archiveName [destination] [delete] 

archiveName is a full pathname for the archive you want UnStuffed. If there 

are multiple items in the archive, the contents of the archive are placed into 

a new folder called “archiveName Folder.” You can optionally use the 

destination parameter to specify another pathname to place the UnStuffed 

items. The delete parameter may also be used to delete the archive after 

everything is UnStuffed from it. 

Microphone II In MicroPhone II, these commands let you Stuff and UnStuff files without 

leaving the program. The XCMDs are built into the “Stufflt Scripts” settings 

file, so all you need to do is open the settings from within the program to use 

the scripts. 

Note: The StuffIt Scripts require MicroPhone II, version 4.0 or later. 

1. To use the MicroPhone II scripts, launch MicroPhone II 

and choose “Open Settings...” 

fiose settings 

Save Settings 

Save Settings 44... 

fipen Naw Capiure File... 

opead to fapture Fie... 

furn fapture Ba 

turn Printer Ba 

Save Seieeiian 44... 

Rpopend Siar tion ip... 

Print Selec tion... 

Praye Satu... 

A standard Open dialog box appears, letting you open the “Stufflt Scripts” 

MicroPhone document. 

2. Select the “Stuffit Scripts” file and click “Open.” 
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When the Stuffit Scripts settings file opens, you’ll notice four icons on the 

icon bar below the “Stufflt Scripts” window. 

Stuffit Scripts 

e Versions. Clicking this button displays the current version of the XCMDs. 

e Stuff A Batch. Stuffing a batch is done by creating a listing of all the files 

you want to be Stuffed. MicroPhone will ask you to name the new 

archive. When you've told MicroPhone where it is, the Stuff XCMD takes 

over, Stuffing all the files in the batch. This is the batch dialog box. 

&) BBEdit 2.1.2 Folder ¥ 

D 2.1.2 Update Notes [& - & 2.1.2 Update Notes 
Add File > <& BBEdit <& BBEdit 

OC BBEdit Notes : 

My Batch 

Desktop 
(“Revert _) 

e UnStuff A File. You can UnStuff an archive by clicking the “UnStuff A 

File” button. A dialog box appears letting you rename the file if you want, 

and asking you where you wish to put it UnStuffed. 

e UnStuff A Folder. Clicking the “UnStuff A Folder” button lets you choose 

a folder that contains numerous archives that you want to UnStuff all at 

once. A dialog box appears with the default folder name, asking you for 

a new name and location for the folder to be created. When you give the 

folder a new name, all the original archives are UnStuffed and placed in 

the new folder. 
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White Knight 

Where To Go 
From Here 
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Note: To include StuffIt functionality in your own documents, use 

MicroPhone’s Script Manager to export the scripts you want to use. You 

should also move the XCMDs into your “MPToolBox” using ResEdit (or a 

similar tool). 

White Knight, from the FreeSoft Company, includes StuffIt Deluxe support 

right in the program so you can Stuff and UnStuff files without exiting White 

Knight. White Knight’s scripting language also lets you create scripts to do 

this as well. See the White Knight documentation for details. 

You can continue to explore the other features of Stufflt Deluxe or take a 

quick look at the Table of Contents for help in finding a topic you’re 

interested in. 
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Compression: Saving 
Space on Disk 

Archiving: The Basics of 
Combining Files and 
Folders 

Appendix A: Tech Talk 
This appendix gets a little more into what compression is and how Stufflt 

Deluxe does it. It is provided for those who like to “get under the hood.” 

What is compression? 

Compression is the process by which a file or a folder is made smaller without 

losing any of its information. Software that compresses files can use any set 

of methods, called algorithms, by which the sequences of characters that 

make up a file are analyzed and encoded in a more efficient manner, thereby 

saving space on disk. Compression algorithms vary widely from program to 

program and the usual trade-off among algorithms is between speed, amount 

of memory used, and degree of compression. If an algorithm compresses 

quickly or uses less memory, it cannot compress as well as one that spends 

additional time or uses more memory to improve its compression. 

Compression works by minimizing or eliminating redundancy and empty 

space. For example, the following 10 characters “AAAAAAABBB” could be 

stored in a file “as is” which would occupy 10 locations, or could be “encoded” 

as “7A3B” which would only occupy 4 locations resulting in a savings of 60%! 

Stufflt Deluxe and SpaceSaver use this very simple concept along with some 

complex compression algorithms to achieve excellent compression ratios at 

unbelievable speeds. 

StuffIt Deluxe and SpaceSaver strike the best balance between the fastest 

compression methods (which compress less) and those that save the most 

space (which take more time). StuffIt Deluxe compresses better, but takes 

more time to do so. SpaceSaver compresses quickly, but not as tightly, except 

in idle-time operation, when its goal is to achieve better compression ratios. 

What is an archive? 

An archive is a special document that can contain more than a single file or 

folder. Archiving is the process by which one or more files and folders are 

combined into a single document and often compressed during the process. 

Stufflt archives are those archives created by any member of the StuffIt 

family of products. 

There are three advantages to storing documents in an archive: 

e Archives usually contain compressed files, and thereby save space on disk 

and reduce the time it takes to transmit them over phone lines or networks. 
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Drag and Drop 
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e Files stored in an archive can be sent over networks and 

telecommunication lines as a single document making it easier for other 

people to retrieve all related material. 

e Associated files can be kept in one archive for easy retrieval and backup. 

With this software, you can create a special type of archive called a self- 

extracting archive.” A self-extracting archive is an archive that can be 

decompressed by anyone — even if the recipient doesn’t own SpaceSaver or 

another compression product. 

See Appendix A in the SpaceSaver manual for more information on the 

compression features of SpaceSaver. 

Being able to select an item with the mouse and drag it to another location is 

one of the easiest things to do on the Macintosh. The very first version of the 

System software let you drag an icon in the Finder and drop it onto a folder 

or disk icon to move or copy that item. System 7 provided a major increase in 

functionality when it allowed you to drag a document and drop it onto an 

application icon, which resulted in the document being opened with the 

application. 

The newest version of System 7 extends the capabilities of drag and drop to 

let you drag items between applications. 
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Appendix B: 
Scripting Reference 

Stufflt’s scripting language allows you to automate many of Stufflt’s 

operations. You can create a script in any text editor or word processor 

provided you save the file in text format. You can also use the “Record Script” 

command in StuffIt Deluxe to create a script automatically for you. 

Note: This appendix refers to the scripting language that is built into Stufflt 

Deluxe. Other scripting applications, such as AppleScript and Frontier from 

UserLand, offer more flexibility and sophisticated scripting. StuffIt Deluxe 

comes with some sample scripts for AppleScript and Frontier in the Scripting 

Tools folder inside the StuffIt Deluxe folder. You can use these as they are, or 

use them as a guide for writing your own scripts. 

e Each “Line” in a script must end with a carriage return. You insert a 

carriage return by typing the Return key. 

e Each command must appear as a separate line. 

e Each line cannot be longer than 255 characters. These 255 characters 

include the command, its parameters (including pathnames and 

filenames), and a carriage return. You will find other references to carriage 

returns in this section referred to as «cr>. 

e All references to disks, folders, or files must be within quotes. 

e A colon (: ) must be used to designate a disk or folder name. For example, 

“Big Man:” refers to a disk while “Big Man” refers to a file. When a disk name 

is followed by one or more folders and a colon is the last symbol in this group 

of characters, the entire group (including the colon) is called a 

“pathname.” 
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e A filename consists of a pathname followed by the name of the file and is 

used to refer to a file on a disk. An itemname, which is just the name of the 

file or folder, is used to refer to an entry within an archive. 

e When a command takes two filenames or pathnames (such as “rename 

file”), the first is considered the source and the second the destination 

or target. 

¢ Comment lines begin with a single dash (-), two dashes (--—), or a semi- 

colon (; ). They are ignored by Stufflt. StuffIt also ignores any blank lines. 

e Commands are not case sensitive. Letters within scripts may be upper or 

lowercase. This includes script commands and the names of disks, folders, 

and files. This chapter lists commands in all lowercase characters for 

reading convenience. 

Throughout this reference section, you'll notice certain symbols used to help 

you understand the syntax of a command. These symbols should not be used 

literally. Any word that is within < > specifies a required substitution where 

you would replace it with appropriate text. For example, in the case of 

“<command>”, the command “Stuff” may be used. Square brackets [ ] 

enclose optional elements which may be included if you need them to expand 

the meaning of the command. In the case of “new archive 

<filename> [replace] [1.5.1]”, the words “replace” and 

“1.5.1” are both optional. Each modifies the command “new archive” to do 

different things. Helper words, enclosed by « », aren’t required by Stuffit 

but help make the command more readable by you. The next section, “Helper 

Words” lists the words that can be used. Words on either side of the separator 

character | are used in an either/or situation. For example, 

“Apple|bat | car” calls for only one of the three words to be used. 

Scripts have a simple syntax in which the command is the first element in a 

line. It is followed by the argument (the archive or filename), and the two 

elements are separated by a space as in: 

<command name> <Space> <argument> <cr> 

Thus, a script for Stuffing a file would be: 

New Archive "Hard Disk:The King.sit" 

Stuff "Hard Disk:Large File" 

Close Archive "The King.sit" 

Any of Stufflt’s options can be added after the argument. 

<command name> <space> <argument> <space> 

<optieans > <er> 

To delete the original file in the previous example, add a “delete” option to 

the end of the line. 

Stuff "Hard Disk:Large File" delete 



Helper Words 

Wildeards 

These “helper words” may be used within certain script commands to 

enhance readability. They aren’t required for a script command to function 

but help make descriptions more readable for you and others who will read 

the script after you. Within a command description, suggested helper words 

are surrounded by « >». The “Record Script” command does not generate 

these helper words. 

ago existing security 

and finished segments 

as from than 

at in using 

compression into when 

done is with 

encryption secure 

Stufflt’s scripting language supports two wildcard characters: the question 

mark (?) and the asterisk (* ). The question mark matches any single 

character. The asterisk matches none, one, or more characters. 

If you need to use a question mark, an asterisk, or a quotation mark in a 

script, enter a backslash \ before the character. This causes Stufflt to treat 

the character literally. For instance, if you have used an asterisk or question 

mark in a filename, you would use “\ *” to match the “*” or “\ ?” to match 

“2”, Also, “\ \” matches “\” and “\”” matches a single quotation mark. 

When you are using wildcards to specify items in an archive, all matching is 

done at the root level of the archive. You can use wildcards to match both files 

and folders. 

When you are specifying files and folders on a volume, wildcards are allowed 

in the file or folder name portion of the command line. If the command 

matches a folder name, the folder is treated as one entity when it’s Stuffed. 

You can also use an asterisk as a substitute for the entire volume name. To 

include all of the files named “ReadMe” on all volumes at the root level only, 

your script should contain: 

* ;ReadMe 

Likewise, an asterisk can be used as a substitute for any filename. To include 

all files whose names end in “.pnt” in your graphics folder on the volume 

named Hard Disk, you would enter: 

Hard Disk:Graphics:*.pnt 

A question mark wildcard is used to match a single character in a volume, 

folder, or filename. Among other uses, this can be used to archive a series of 

files that ends with a different suffix. To include all files (use asterisk) that 
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have a single character (use question mark) after a period on the root of the 

volume named “HD” you would use: 

HDs 

As shown, wildcards can be used individually or in combination with other 

wildcard characters. 

Vari ables Stufflt’s scripting language supports five special variables, whose value is 

evaluated each time the script is run much like variables in a traditional 

programming language, that you can include in your scripts. Variables must 

be enclosed in { } to differentiate them from standard text and are most 

commonly used as part of another text string (such as a pathname). 

The five variables supported in Stufflt are: 

{Date}, today’s date, 

{Time}, the current time, 

{Startup}, the name of the startup (or boot) disk, 

{System}, the pathname to the system folder, and 

{Deluxe}, the pathname to the folder where StuffIt Deluxe is located. 

A common use of this would be “write status to 

"({Deluxe}status file™. 

Scripting Commands The following section describes the commands available for Stufflt Deluxe’s 

built-in scripting language. 

abort on-error The “Abort on Error” command is used to tell Stufflt what to do when a script 

encounters an error. Using this command will cause StuffIt to simply abort 

the entire script after an error is encountered. This will override the default 

setting which is to continue on errors. 

To cause Stufflt to abort a script when it finds an error, enter this line near 

the beginning of your script. 

abort on error 

clear match The “Clear Match” command is used to clear out any match criteria that may 

have been previously set. It is a good idea to use this before setting up any new 

match criteria in a script. 

To clear any existing match criteria, enter this line in your script: 

clear match 
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close archive 

[<filename> |] 

contanve oOn-error 

decode binhex 

<filename> [«to» 

<filename>| 

delete entry 
<itemname> 

The “Close Archive” command closes an open archive. Use this command 

whenever you want to close an archive. If you do not specify an archive, the 

current archive is closed. It is always a good idea to specify the archive to 

avoid any ambiguity. 

To close the archive “The King.sit” when you've finished Stuffing some files 

into it, enter the line, 

close archive "The King.sit" 

in your script. If “The King.sit” is the only archive open, you can omit its name. 

The “Continue on Error” command is used to tell StuffIt what to do when a 

script encounters an error. Using this command causes StuffIt to continue 

executing the rest of the script, even after an error is encountered. This is the 

default setting, but you can use it after the use of the “abort on error” 

command to revert to this setting. 

To reset StuffIt to continue a script when it finds an error, enter this line in 

your script: 

continue on error 

The “Decode BinHex” command decodes a BinHexed file. BinHex is a 

standard conversion algorithm used to convert Macintosh binary files to 

ASCII format. 

To decode a BinHex file, enter the line, 

decode binhex "Hard Disk:The King.hgqx" 

in your script. Stufflt decodes the BinHex file “The King.hqx”. If you specify a 

target pathname, the decoded file is placed in that folder with the name 

stored in the BinHex file. If you include a filename instead, then that name 

overrides the one stored in the original file. If the target name cannot be 

used, Stufflt does not decode the file and gives you an error message in the 

status file. 

The “Delete Entry” command deletes entries from an archive. It deletes all 

entries at the root level of the archive matching the specified itemname. Use 

this command to delete an entry from an archive that you no longer need or 

when you are going to replace it with a newer version. 

To delete an entry, enter the line, 

delete entry "My File" 

in your script. The entry is immediately deleted from the archive. 
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delete file 

<filename> 

destination 

<pathname> 

encode binhex 

<filename> [«to» 

<filename>] [«with» 

LFs] [replace] 

join <filename> 
[prompt] [replace] 
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The “Delete file” command deletes individual files from the specified disk. 

For safety reasons, no wildcard substitutions are allowed. To delete a file, 

enter the line, 

delete file "Hard Disk:My File" 

in your script. The file is immediately removed from the disk. 

The “Destination” command lets you set a new destination for files that 

Stufflt UnStuffs from an archive. Use this command when you want to save 

files to a different folder, hard disk, or diskette. 

Specify the destination by entering the pathname. For instance, you would 

enter the name of your hard disk in quotation marks if you wanted to save the 

UnStuffed files to the root level. If you want to save the files to a folder on your 

hard disk, you would enter the name of the hard disk followed by a colon, and 

then the name of the folder. This would appear as: 

"Hard Disk:New Files:" 

To set a new destination, enter the line, 

destination "Hard Disk:New Files:" 

in your script. 

The “Encode BinHex” command encodes a file in the BinHex format. If you 

are transmitting the file over a network (such as the Internet) that doesn’t 

support the Macintosh binary format, you must convert the file to the BinHex 

format first. 

If you do not specify the name of the encoded file, Stufflt assumes you want 

to name it “<source filename>.hqx” with the “source filename” being the 

original name of the file. If you want the BinHexed file to have a specific 

name, you can enter that name. 

To encode a file in BinHex format, enter the line, 

encode binhex "Hard Disk:The King.sit" 

in your script. To add linefeeds to the file as it is encoded and specify an 

alternate destination you might enter the line: 

encode binhex "Hard Disk:The King.sit" to "Floppy 

Disk: TheKing.hgx" with LFs 

in your script. 

The “Join” command lets you join files which have been segmented. The Join 

command does not normally require you to respond to the join process and 

automatically joins segments in a single folder. If you want to insert disks, or 

if the segment names do not end in sequence (“.1”, “.2”, “.3”, etc.) you must 

use the “Prompt” option. Using the “Prompt” option causes StuffIt to bring up 



launch <itemname> 

match <category> 
<comparison> <value> 

new archive 
<filename> [replace] 

Bote tek ee Eee 

a dialog box asking for more information. The “Replace” option causes StuffIt 

to overwrite an existing file with the same name as the file being joined if one 

exists. 

To join a file, enter the line, 

jOin “Hard bere me FIing. sit <1" 

in your script. 

The “Launch” command lets you launch a file contained in an archive. This is 

a shortcut to doing an “UnStuff” and then a “Transfer”, if the file you want to 

launch is contained in an archive. When running System 6, you can only 

launch applications, however with System 7 any file can be launched. 

To launch a file, enter the line, 

launch "The King" 

in your script. 

The “Match” command is used to specify a set of criteria to be applied to the 

next “Stuff match” operation. Each “Match” command is added to a list of 

criteria, so you can have multiple criteria applied, just like the “Add Match” 

dialog. For more info on “Add Match”, and the list of categories, comparisons, 

and values see Chapter 5: Stufflt Deluxe Reference. 

To match all files labeled as “project,” enter the line: 

match label is "Project" 

in your script. 

To match all files ending in .c modified this week, enter the lines, 

match name ends with ".c" 

match modified this week 

in your script. 

The “New Archive” command allows you to create a new archive and open it 

for use. 

To create a new archive, enter the line, 

new archive "Hard Disk:The King.sit" replace 

in your script. The “Replace” option causes StuffIt to replace any existing file 

with the same name. If you do not specify that Stufflt should replace an 

archive with the same name, StuffIt displays a dialog box asking if the archive 

is to be replaced. If you do not respond to this dialog (within 20 seconds), it 

does not create a new archive and does not run the remainder of the script. 

The “1.5.1” option lets you create a Stuffit 1.5.1 archive, which is an older and 

less efficient format. You would not normally want to create a 1.5.1 archive. 

If you do not specify “1.5.1” in the script, StuffIt creates a standard archive. 
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To create a Stuffit 1.5.1 archive and replace any existing file with that name, 

enter the line, 

new archive "Hard Disk:Old Archive.sit" as 1.5.1 

and replace 

in your script. 

new folder <pathname> The “New Folder” command allows a new directory to be created on any disk. 
The pathname must designate the location and name of the new folder to be 

created. Once a new folder has been created, it can be used in subsequent 

script commands. 

To create a folder at the root level of the disk “Hard Disk” enter the line, 

new folder "Hard Disk:My Folder" 

in your script. 

no status The “No Status” command stops any output of diagnostic information 

following a “Write Status To” command. 

To stop outputting diagnostic information, enter the line, 

no status 

in your script. 

open archive The “Open Archive” command allows you to specify an archive for StuffIt to 

<filename> open. Use this command if you want to add files to an existing archive. 

To open an archive, enter the line, 

open archive "Hard Disk:The King.sit" 

in your script. 

quit The “Quit” command exits Stuffit. It has the same effect as selecting “Quit” 

from the File menu. 

To quit Stuffit, you would enter the line, 

quit 

at the end of your script. 

Even though your script may end with the “Transfer” command, to exit Stuffit 

and run another program you may want to put a “Quit” command at the end 

of any scripts that run unattended. This would ensure that even if the 

Transfer command fails, Stuffit still quits. 
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rename entry 

<itemname> «to» 
<itemname> 

rename file 

<filename> «to» 

<filename> 

save as <filename> 

[xas» self- 

extracting] 

[replace] 

segment <filename> 
<Size|max> [prompt] 
[replace] 

The “Rename Entry” command allows you to rename items within an archive. 

Use this command if you want to rename an entry before a file with the same 

name is added to the archive. 

To rename an archive entry, use the line, 

rename entry "Large King" to "Large King Backup" 

in your script. 

The “Rename File” command allows you to rename a file on the hard disk. Use 

this command if you want to rename a file to avoid a naming conflict. 

To rename a file, enter the line, 

rename "Hard Disk:Archive.sit" to "Hard Disk:The 

Rig ..sit" 

in your script. 

The “Save As” command allows you to save an archive under a different name, 

and optionally as a self-extracting archive. Using the “Replace” option, you 

can also have StuffIt replace an existing file which might be in the same 

location. 

To save an archive as a self-extracting archive, enter the line, 

save as "Hard Disk:Archive.sit" as sel£- 

extracting 

in your script. 

The “Segment” command allows you to split a file into multiple segments. 

Without the “Prompt” option, Stufflt creates the segments with sequential 

suffixes (“.1”, “.2”, “.3”, etc.) and saves them to the same folder as filename. 

If you want to rename segments or place the segments on disks as the script 

is running, you must specify the “Prompt” option. You can also specify the 

“Replace” option if you want Stufflt to overwrite any existing files with the 

same names. 

To segment a file, enter the line, 

segment "Hard Disk:The King.sit" 775K 

in your script. This instructs StuffIt to split the file “The King.sit” into 775K 

segments. The “K” is optional when specifying the segment size. You can also 

use “max” to specify the maximum size. When segmenting a file for floppy 

disks, remember to allow room for the disk’s directory. In other words, you 

may not be able to fit a segment larger than 775K on a double-sided (or 800K) 

disk. The directory on the disk requires several kilobytes of free disk space. 
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stuff The “Stuff” command adds a file or folder to the currently selected archive. 

<pathname | filename> Use this command whenever you want to add files or folders to an open 

[none |compress ] archive. When adding the files or folders, you may also specify if they are to 

fencryptl: {délete] be compressed or encrypted. You must have an open archive for the “Stuff” 
[match] command to work. 

To Stuff a file or folder in the current archive, enter the line, 

stuff "Hard Disk:Large File" delete 

in your script. In this case, the file “Large File” is compressed into the current 

archive and the original file is deleted after the file is compressed. If the file 

is not successfully Stuffed, it is not deleted. 

Rather than simply specifying a single file, or an entire folder, you can use the 

“Match” option to have the current set of match criteria applied. It is just like 

doing it from the “Add Match” dialog box. For example, if you had some match 

criteria set, you might enter the line, 

stuff "Hard Disk:My Folder:" match 

in your script. 

stuff <path The “Stuff in Place” command creates a new archive (called 
name|filename> «in» <pathnamelfilename>.sit) and Stuffs the specified files or folders into it. 

place "| “as#7, 5.1] When Stuffing the files or folders, you may also specify if they are to be 
[none|compress] compressed or encrypted, or if the archive to be created is an 1.5.1 archive. If 

[encrypt] [delete] you are just going to be creating single file/folder archives, this is much faster 
than doing a “New Archive,” “Stuff” and “Close Archive” for each. 

To Stuff a file or folder in the current archive, enter the line, 

stuff in place "Hard Disk:Large File" delete 

in your script. In this case, the file “Large File” is compressed into its own 

archive called “Large File.sit” and the original file is deleted after the file is 

compressed. If the file is not successfully Stuffed, it is not deleted. 

transfer The “Transfer” command quits StuffIt and transfers to the specified program. 

<application> Use this command if you want to return to a program after running a script. 

For example, you might want to return to your word processor after executing 

a script to archive the day’s work. 

If Stufflt cannot find the program, the script continues its execution. The 

“Quit” command should follow the “Transfer” command if the script is 

executed unattended. 

To run a program, enter the line, 

transfer "Hard Disk:Applications:TeachText" 

in your script. 
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translate 

<translatorName> 

BEGIN 

<Encode |Decode> 

<filename> <«to» 

filename |pathname> 
END 

unstuff <itemname> 

[replace] 

unstufft 
<pathname|filename> 
«<in> place [replace] 
[delete] 

The “Translate” command is used to control the plug-in translators via 

scripting. With it you can have any translator encode files into or decode files 

from foreign formats. Unlike the other scripting commands, the “Translate” 

command allows you to specify a group of commands to the translator by 

bracketing the group with BEGIN/END. Between the BEGIN/END, you may 

specify an number of encoding or decoding commands, along with any 

translator specific commands that may be available. For example, many of 

the translators support the “LF” command for specifying the inclusion or 

translation of linefeeds. 

To expand all the files from a Compact Pro archives, enter the lines, 

translate Compact Pro 

begin 

decode "HD:Downloads:*.cpt" 

end 

in your script. 

The “UnStuff’ command UnStuffs or extracts the specified entries from the 

current archive and saves them to disk. It extracts all entries matching the 

<itemname>. Use this command when you want to UnStuff files or folders 

from an archive. You must have an open archive for the “UnStuff’ command 

to work. 

To UnStuff an entry from the current archive, enter the line, 

unstuff "Large File" replace 

in your script. 

The files are saved in the last location set with the Destination command or 

to the same folder or level as the archive if no location has been set. You can 

save them to a different location using the Destination command. For 

instance, you could save them to the Graphics folder by entering the lines, 

destination "Hard Disk:Graphics:" 

unstuff "Large File" replace 

in your script. 

The “UnStuffin Place” command UnStuffs the entire contents of the specified 

archive. Use this command when you want to UnStuff an entire archive rather 

than individual entries. It is much more efficient than opening up the archive, 

UnStuffing all entries, and then closing the archive. 

UnStuff in Place also supports wildcards. 

To UnStuff an entire archive and delete the original, enter the line, 

unstuff in place "Hard Disk:Archive.sit" delete 

in your script. 
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use <filename> 

write status-to 

<filename> 
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The files are saved into a new folder named, in this case, Archive Folder in 

the same folder or level as the archive. 

The “Use” command allows you to direct commands to another open archive. 

It selects an open archive and makes it the “current archive.” Use this 

command when you want to perform an operation on a different archive. This 

allows you to perform operations on several archives from one script. 

All open archives should have unique names to avoid ambiguity when use the 

“Use” command. 

To use another archive called The King.sit, enter the line 

use "The King.sit" 

in your script. 

The “Write Status” command creates a file containing the diagnostic output 

for a script. If this command is not executed, a status file is not created. Use 

this command when you are trying to diagnose script problems. 

To create a status file, enter the line, 

write status to "Hard Disk:Archive Diagnostics" 

in your script. 

If you do not specify a filename, Stufflt creates a status file with the same 

name as the script file and an “.out” extension. A new output file replaces any 

existing file with the same name. 



General Questions 

Appendix C: Common 
Questions (and Answers!) 

Q: How do Stufflt and SpaceSaver affect my System file or my System 

Folder? 

A: Neither StuffIt nor SpaceSaver ever modifies or affects your System file. 

This is one example of how Stufflt and SpaceSaver are extremely safe, 

perform completely reversible operations, and do not take control of your 

files from you. Some Stufflt and SpaceSaver files and folders are placed 

into your System Folder so that other applications and utilities can find 

them easily. This is a standard Macintosh practice. Stufflt and 

SpaceSaver files can be found in the Extensions and Control Panels 

folders of your System Folder, and within the Aladdin folder found in the 

Extensions folder. See Chapter 2: Installation, for further information. 

How do I send a compressed file to a friend who doesn’t have any 

Stufflt product? 

: You can send your friend a self-extracting archive using any of the 

following methods. Using SpaceSaver, you can attach the “.sea” keyword 

to the file in the Finder. Using Magic Menu, you can select the file, and 

then choose “Make Self-Extracting.” Using StuffIt Deluxe, you can check 

the “Self-Extracting” check box found in the lower left hand corner of the 

archive’s window. You can also send your friend StuffIt Expander. 

I installed the software and now my computer doesn’t start up. 

What happened? 

: The software may be encountering problems with other Startup 

documents, Control Panel documents or System Extensions. System 7 

users can hold down the shift key when the Macintosh starts to disable 

SpaceSaver and Magic Menu. Try removing your Startup documents, 

Control Panel documents, and System Extensions temporarily, and re- 
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Stuffit Deluxe 
Questions 

install them in your System Folder one at a time until you’ve found the 

incompatible file. 

May I give my co-workers a copy of this software? 

No. This package is a commercial product and each copy can only run on 

a Single computer. It is priced inexpensively enough so that anyone can 

afford a copy for their Macintosh. Aladdin Systems offers volume 

discounts and site licenses that are very reasonable for business users. 

Call us at 408/761-6200 for details. 

You may give StuffIt Expander to your co-workers and friends so they can 

access SpaceSaver files and StuffIt archives you send to them. This is the 

only part of the package you can freely distribute as long as it is not for 

commercial use or profit. 

I’ve read the User’s Guide and I’m still having problems. What do I do? 

Call our Technical Support Hotline at 408/761-6200 between the hours of 

9 am and 5 pm Pacific time (9 am to 3 pm on Fridays). When calling our 

Technical Support Group, remember to: 

e Know your hardware and software configuration (including the type of 

Macintosh, the amount of memory, and the startup documents, 

Control Panel documents, and system extensions installed). 

e Know the version numbers of StuffIt, SpaceSaver, and the System 

Software you are using. 

e Know the registration number of Stuffit. 

e Have a detailed description of what happened. 

e When possible, be seated at the Macintosh with the software running. 

I want to distribute my software product in a compressed, self-extracting 

form to save on disk costs. Can I do this with my product? 

: Aladdin Systems licenses various types of self-extracting archives and 

installers. While a self-extracting archive is the simplest form of an 

installer, we have installation technologies that can automate a 

multiple disk installation process and more. Contact Aladdin Systems 

for more information at 408/761-6200. 

Why are the buttons in the Archive Palette disabled when I first launch 

Stufflt Deluxe? I don’t know what to do first. 

: The buttons in the Archive Palette represent common operations 

performed on the current archive. When Stuffit is first launched, there is 

no current archive. Begin by choosing “New Archive...” or “Open 

Archive...” from the File menu. See the Chapter 5: StuffIt Deluxe 

Reference for initial use of the Archive Palette. 
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: I Stuffed multiple files into an archive and the archive is too large for a 

floppy disk. What do I do? 

A: Segment the archive into disk-sized pieces. See Chapter 4: Basic Stufflt 

Deluxe for more information. 

: After Stuffing my files and folders into an archive, are the originals still 

on my disk? 

A: Yes, unless you specifically instructed StuffIt to “Delete originals” or 

“Delete item when finished.” For your protection, these options need to 

be specifically set by you. If you haven’t set these options, the original 

items still reside on your disk. 

Why do I have less space on my disk after using StuffIt to Stuff some files? 

You still have the original files on your disk and the archive which 

contains compressed copies of those files. To save space on your disk, you 

need to delete the original files by putting them in the trash and 

emptying it. 

I received a Stufflt archive from a friend. What is a quick and easy way to 

access the files or folders contained with the archive? 

A: There is more than one quick and easy way to UnStuff archives 

depending on which parts of the Stufflt package you have installed. Each 

of the following tools UnStuffs the items from an archive and places them 

into a single folder. If only one item exists in the archive, that item is 

placed individually on your disk rather than being placed into a newly 

created folder. 

e If you have Magic Menu installed, select the archive in the Finder and 

choose “Expand” from the Magic Menu. 

e If you have Stufflt Expander and are running System 7, drag the 

selected items in the Finder onto the Stufflt Expander icon. 

e In the Stufflt Deluxe application, choose “Open Archive...” from the 

File menu, select the archive you want to UnStuff, and click “UnStuff.” 

e If you have SpaceSaver installed, remove the “.sit” extension from the 

end of the archive’s name. (Use this method with caution because it 

automatically deletes the original archive after it is expanded. ) 

What’s the difference between Stufflt Deluxe and DropStuff? 

DropStuff is a shareware product and is available from online services, 

user groups, and from Aladdin Systems. DropStuff provides entry level 

compression, a small on-disk User’s Guide, and covers basic concepts to 

give you a taste of the capability of StuffIt Deluxe. DropStuff is also a 

System 7-only application. DropStuff is a subset of Stufflt Deluxe, and 

does not incorporate many of the time-saving and expert features found 

in Stufflt Deluxe. Stufflt Deluxe has more convenient ways to create and 
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manipulate archives than DropStuff, includes a printed manual, Magic 

Menu, StuffIt SpaceSaver, and is the most complete compression 

solution available for your Macintosh. 

Q: I’ve been using Stuffit 1.5.1, or StuffIt Classic. What’s the difference 

between what I have and the latest versions? 

A: StuffIt 1.5.1. is the shareware predecessor of StuffIt Classic, which is the 

shareware predecessor of DropStuff. Those previous versions should be 

replaced with either the newer, faster, easier-to-use DropStuff or Stuffit 

Deluxe. 

Q: I downloaded a StuffIt archive from my favorite bulletin board system 

(BBS) and StuffIt won’t recognize it. What’s wrong? 

: Sometimes during the file transfer from a BBS to your Macintosh, a file 

gets modified in a way that makes StuffIt Deluxe not able to recognize it. 

Before you download a file, make sure you have the “MacBinary” 

downloading option set in your communications application. If you have 

already downloaded an archive with MacBinary disabled, you can use the 

included MacBinary Translator to convert the file into a usable StuffIt 

archive. See Chapter 5: StuffIt Deluxe Reference for details on decoding 

a MacBinary file. 

Q: I dropped my hard disk and some of the files on it were damaged. How 

does my disk’s bad media affect Stufflt archives, and how will Stuffit 

Deluxe deal with these archives? 

A: Tothe Macintosh, a StuffIt archive appears no differently than any other 

type of file such as a word processing file. While some applications don’t 

allow you to open files which have been even partially damaged, Stufflt 

Deluxe makes an extra effort to open archives. Stufflt’s built-in error 

checking may determine that an archive has been damaged and warn you 

accordingly. These archives will open as read-only, which means you may 

be able to UnStuff files but will not be able to modify the archive in any 

way. This method allows you as much access to your files as possible, 

giving you as much feedback as it can, without further endangering data 

in the archive. 

Q: I received a Zip file from a friend who has an IBM-PC (or compatible). 

Can I do anything with it? 

: Yes. Stufflt Deluxe includes an unZip Translator that can be accessed 

from the Translate menu. The unZip Translator gives you access to the 

files contained in the Zip file. You can also use the “Expand” command 

from the Magic Menu, or you can drag and drop the Zip file onto Stuffit 

Expander (if you are using System 7) to unZip the file. 
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If I choose “Open Archive...” to open a Compact Pro archive, Stufflt tells 

me the archive is damaged. What can I do? 

A: You can expand the Compact Pro archive by choosing “CPT Extract...” 

from the Translate menu. You may also convert the Compact Pro archive 

into a StuffIt archive to save additional disk space by using the 

DropConvert application. See Chapter 8: Drag and Drop for use of that 

utility. 

I can’t remember the password I used to encrypt some files in an archive. 

Can you help me? 

: No. Stuffit uses very secure encryption algorithms. It would be self- 

defeating to have a method to access the files without the password. 

Why does my friend have a Script menu and I don’t? 

You don’t have the Script menu enabled. Choose “Preferences” from the 

Edit menu to display the Preferences dialog box. At the bottom of the 

dialog box, you'll see some check boxes which enable and disable menus. 

Make sure that the Script menu check box is checked. 

: When I click on the “Self-Extracting” check box, StuffIt tells me I can’t 

turn the file into a self-extracting archive. Why not? 

A: There are several reasons why you can’t do this. One is that the archive 

is “read-only” which means that no modifications can be made to it. Try 

unlocking the file from the Finder’s Get Info window, or unlock the disk 

it resides on, or move the archive to an unlocked disk. Another reason 

could be that the archive has items which were compressed or encrypted 

with a previous version of Stuffit. In this case, you’ll need to UnStuff the 

contents from the older archive, create a new archive with the newer 

version of Stuffit, Stuff the items into the new archive, and then click the 

“Self-Extracting” check box. 

I UnStuffed one file from an archive and then modified the file. How do I 

update the archive? 

: The archive still contains a copy of the original unmodified file. You 

should Stuff the modified file into the archive also. Then, at your 

discretion, you can delete the original file from the archive. Unlike the 

Finder, StuffIt archives allow multiple files with the same name in the 

same folder. This means you can keep a history of revisions in an archive. 
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Q): How can I reach Aladdin Systems? 

A: There are several ways to reach us: 

Phone: 408/761-6200 

Fax: 408/761-6206 

Mail address: Aladdin Systems, Inc. 

165 Westridge Drive 

Watsonville, CA. 95076 

Email: AppleLink, America Online: ALADDIN 

GEnie, eworld: AladdinSys 

CompuServe: 75300, 1666 

Internet: aladdin@well.sf.ca.us 
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